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Preface

This document summarizes differences between Oracle Developer Suite 10g (9.0.4) and 
its documented functionality.

For recent updates to the release notes and other documentation, please visit Oracle 
Technology Network at http://otn.oracle.com

Intended Audience
This installation guide is intended for developers, database administrators, and others 
responsible for installing Oracle products. You should be familiar with client/server 
architecture/relationships and database concepts.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Standards will continue to evolve over 
time, and Oracle is actively engaged with other market-leading technology vendors to 
address technical obstacles so that our documentation can be accessible to all of our 
customers. For additional information, visit the Oracle Accessibility Program Web site 
at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation JAWS, a Windows screen reader, 
may not always correctly read the code examples in this document. The conventions 
for writing code require that closing braces should appear on an otherwise empty line; 
however, JAWS may not always read a line of text that consists solely of a bracket or 
brace.

Accessibility of Links to External Web Sites in Documentation This documentation 
may contain links to Web sites of other companies or organizations that Oracle does 
not own or control. Oracle neither evaluates nor makes any representations regarding 
the accessibility of these Web sites. 
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Organization
This document contains the following:

Part I, "Product Release Notes"

This part of the release notes contains information for the entire Oracle Developer 
Suite product.

The Part I chapters are:

■ Chapter 2, "Product Naming"

■ Chapter 3, "Certification Information"

■ Chapter 4, "Known Issues"

Part II, "Component Release Notes"

This part of the release notes contains information for individual Oracle Developer 
Suite components.

The Part II chapters are:

■ Chapter 5, "Oracle9i JDeveloper"

■ Chapter 6, "Oracle Business Intelligence Beans"

■ Chapter 7, "Oracle Discoverer Administrator"

■ Chapter 8, "Oracle Discoverer Desktop"

■ Chapter 9, "Oracle Forms Developer"

■ Chapter 10, "Oracle Reports"

■ Chapter 11, "Oracle Designer"

■ Chapter 12, "Oracle Software Configuration Manager"

Part III, "Other Release Notes"

This part of the release notes contains information for server components that are 
installed with Oracle Developer Suite.

The Part III chapters are:

■ Chapter 13, "Oracle Application Server Containers for J2EE (OC4J)"

Related Documents
For more information, see these Oracle resources:

■ Oracle Developer Suite Documentation Library

■ Oracle Developer Suite Platform Specific Documentation on Oracle Developer 
Suite Disk 1 CD-ROM or Oracle Developer Suite and Documentation DVD

Printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/.

To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN). You must register online 
before using OTN; registration is free and can be done at 

http://otn.oracle.com/membership.
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If you already have a user name and password for OTN, then you can go directly to 
the documentation section of the OTN Web site at

http://otn.oracle.com/documentation.

Conventions
The following conventions are also used in this manual:

Product Accessibility
To make the best use of the product’s accessibility features, Oracle Corporation 
recommends the following software configuration:

■ Microsoft Windows NT 4.0 (with Service Pack 6) or Windows 2000

■ Sun Java Access Bridge 1.0.3

■ JAWS

■ Microsoft Internet Explorer 5.5

■ JDK 1.4.1

Convention Meaning

boldface text Boldface type in text indicates a key or button that you press or 
click; it could also indicate labels and options that appear on 
installation dialogs.

Italics Italic typeface indicates book titles or emphasis.

code (lowercase 
monospace or 
fixed-width font)

Lowercase monospace typeface indicates executables, file 
names, directory names, and sample user-supplied elements. 
Such elements include computer and database names, net 
service names, and connect identifiers, as well as user-supplied 
database objects and structures, column names, packages and 
classes, user names and roles, program units, and parameter 
values.

Note: Some programmatic elements use a mixture of 
UPPERCASE and lowercase. Enter these elements as shown.

boldface code Boldface monospace typeface indicates text that you enter in 
response to a command line prompt.

italicized code Italicized code indicates placeholder text that you need to 
replace with an appropriate value. 

CODE (UPPERCASE 
monospace or 
fixed-width font)

Uppercase monospace typeface indicates elements supplied by 
the system. Such elements include parameters, privileges, 
datatypes, RMAN keywords, SQL keywords, SQL*Plus or 
utility commands, packages and methods, as well as 
system-supplied column names, database objects and 
structures, usernames, and roles.

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted.

[ ] Brackets enclose optional clauses from which you can choose 
one or none.
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Additional accessibility information for Oracle products can be found at

 http://www.oracle.com/accessibility/

For the latest configuration information or information on addressing accessibility and 
assistive technology issues, see the Oracle Accessibility FAQ at

 http://www.oracle.com/accessibility/faq.html



Part I
Product Release Notes

Part 1 of the release notes contains information for the entire Oracle Developer Suite 
product

Part 1 contains the following chapters:

■ Chapter 1, "What’s New in the Oracle Developer Suite 10g Release Notes?"

■ Chapter 2, "Product Naming"

■ Chapter 3, "Certification Information"

■ Chapter 4, "Known Issues"
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1
What’s New in the Oracle Developer Suite

10g Release Notes?

This chapter provides a listing of new topics introduced with this version of the Oracle 
Developer Suite 10g Release Notes. The new topics are in the following chapters:

■ Chapter 4 "Known Issues"

■ Chapter 7 "Oracle Discoverer Administrator"

■ Chapter 10 "Oracle Reports"

1.1 Chapter 4 "Known Issues"
■ Section 4.5.1, "Linux Issues"

■ Section 4.8.1, "Oracle Developer Suite 10g Installation Guide"

Note that the second paragraph of the original section, which described revisions 
to Table 2-8 of the Installation Guide, has been removed. This information is 
superseded by Section 4.8.3, "Linux Operating Environment Software 
Requirements".

■ Section 4.8.2, "Oracle Developer Suite 10g Quick Installation Guide"

Note that the first paragraph of the original section, which described revisions to 
Table 8 of the Quick Installation Guide, has been removed. This information is 
superseded by Section 4.8.3, "Linux Operating Environment Software 
Requirements".

■ Section 4.8.3, "Linux Operating Environment Software Requirements"

1.2 Chapter 7 "Oracle Discoverer Administrator"
■ Section 7.6.5, "<ORACLE_HOME>\discoverer\util should read <ORACLE_

HOME>\discoverer\sql"

1.3 Chapter 10 "Oracle Reports"
■ Section 10.1.1, "Running a Simple Matrix Report to the Web"

■ Section 10.1.2, "Opening / Running an encoded JSP report"

■ Section 10.1.3, "Dynamically Embedding a Character Set in a JSP file"

■ Section 10.1.4, "Running a Multibyte report containing an embedded Oracle 
Object"
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■ Section 10.1.5, "Viewing Oracle Enterprise Manager screens in non European 
languages"

■ Section 10.1.6, "Specifying the encoding of an XML PDS Report"

■ Section 10.2.2.1.1, "Running a Report to DelimitedData on OracleAS Portal"

■ Section 10.2.2.1.2, "Providing the location to a character set-specific Tk2Motif.rgb 
file"

■ Section 10.2.2.2.1, "Reports Builder stops responding on Solaris 2.9"

■ Section 10.2.2.4.1, "Running Oracle Reports in a Japanese Environment on HP-UX"

■ Section 10.5.1, "REPORTS_CLASSPATH variable in Linux, Solaris, and HP-UX"

■ Section 10.5.2, "Oracle Reports Documentation Page on Oracle Technology 
Network"

■ Section 10.5.3, "Revised Section 13.3.3.2 of Oracle Application Server Reports 
Services Publishing Reports to the Web"

■ Section 10.5.4, "Possible Outdated Screenshots in Oracle Reports Server Reports 
Services Publishing Reports to the Web"
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2
Product Naming

Previous versions of Oracle Developer Suite 10g (9.0.4) were released under the 
following product names:

■ Oracle Internet Developer Suite

■ Oracle9i Developer Suite (Oracle9iDS) Release 2 (9.0.2)

2.1 Windows Components
For Windows, the components of Oracle Developer Suite 10g (9.0.4) are:

2.2 Linux, Solaris, and HP-UX Components
For Linux, Solaris, and HP-UX, the components of Oracle Developer Suite 10g (9.0.4) 
are:

Table 2–1 Windows Component Names

Oracle Developer Suite 10g 
Component Release 2 (9.0.2) name

Oracle Internet Developer 
Suite name

Oracle9i JDeveloper (9.0.4) Oracle9i JDeveloper (9.0.2) Oracle JDeveloper

Oracle Forms Developer Oracle9i Forms Developer

Oracle Reports Developer Oracle9i Reports Developer

Oracle Discoverer 
Administrator1

1 Oracle Discoverer Administrator includes Oracle Discoverer Desktop.

Oracle9i Discoverer 
Administrator

Oracle Discoverer 
Administration Edition

Oracle Designer

Oracle Software Configuration 
Manager

Table 2–2 Linux, Solaris, and HP-UX Component Names

Oracle Developer Suite 10g 
Component Release 2 (9.0.2) name

Oracle Internet Developer 
Suite name

Oracle9i JDeveloper (9.0.4) Oracle9i JDeveloper (9.0.2) Oracle JDeveloper

Oracle Forms Developer Oracle9i Forms Developer

Oracle Reports Developer Oracle9i Reports Developer
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3
Certification Information

This chapter lists certification information for Oracle Developer Suite.

3.1 Certification Information
Certification information is now maintained online. The most up-to-date certification 
information for Oracle Developer Suite is always available at OracleMetalink 
(http://metalink.oracle.com).
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4
Known Issues

This chapter discusses issues and workarounds that apply to the entire Oracle 
Developer Suite product. For component-specific issues and workarounds, please refer 
to the chapters in Part II, "Component Release Notes".

This chapter is divided into the following sections:

■ Section 4.1, "Preinstallation Issues"

■ Section 4.2, "Installation Issues"

■ Section 4.3, "Postinstallation Issues"

■ Section 4.4, "Deinstallation Issues"

■ Section 4.5, "Platform-specific Issues"

■ Section 4.6, "Configuration Issues"

■ Section 4.7, "Administration Issues"

■ Section 4.8, "Documentation Errata"

4.1 Preinstallation Issues

4.1.1 Oracle Business Intelligence Beans
Oracle Business Intelligence Beans (hereinafter referred to as "BI Beans") requires 
Oracle9i Enterprise Edition Release 2 (9.2.0.3 or later) with the OLAP Option. For 
specific patch set numbers, see the matrix of supported patch sets in the BI Beans 
product area on Oracle Technology Network 
(http://otn.oracle.com/docs/products/bib/content.html).

The OLAP Option requires configuration, as follows:

■ Basic configuration is described in the Oracle9i OLAP User's Guide. This book is 
available on OracleMetaLink (http://metalink.oracle.com). On the top-level 
page on OracleMetaLink, click Top Tech Docs, then scroll to the Business 
Intelligence (BI) & Warehousing heading and click Oracle OLAP. Next, click 
Documentation, then Oracle OLAP, then the book title.

■ For good performance and to ensure that BI Beans works as expected, you must 
follow the guidelines in Oracle9i OLAP Best Practices for Tabular Cube Aggregation 
and Query Operations. This document is available as patch set 2529822 on 
OracleMetaLink (http://metalink.oracle.com).
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4.1.2 Oracle9i Warehouse Builder
Oracle9i Warehouse Builder Release 9.2 is included in the Oracle Developer Suite 10g 
CD Pack as a separate CD-ROM disk with a separate installation program. All of the 
documentation for Oracle9i Warehouse Builder is included on its CD-ROM.

4.2 Installation Issues
There are no known suite-level installation issues.

4.3 Postinstallation Issues

4.3.1 Java Versions
The documentation for an individual component of Oracle Developer Suite may list a 
specific version of the JDK, JRE, J2SE, J2EE or other Java feature that is certified for 
that component. Nevertheless, the Java version that is supplied with Oracle Developer 
Suite 10g 9.0.4 is also fully certified for all components. 

For example, the Java in Oracle Developer Suite 10g 9.0.4 for Linux is 1.4.2.x, while the 
Oracle Business Intelligence Beans (BI Beans) documentation says that BI Beans is only 
certified with 1.4.1. However, BI Beans is also certified with the Java SDK 1.4.2 that is 
installed with Oracle Developer Suite 10g for Linux.

4.4 Deinstallation Issues
There are no known suite-level deinstallation issues.

4.5 Platform-specific Issues

4.5.1 Linux Issues

4.5.1.1 Revised Linux Operating Environment Software Requirements
The following documented Linux operating environment software requirements have 
been revised:

■ Section 2.3.4 "Linux Operating Environment" of the Oracle Developer Suite 
Installation Guide 10g (9.0.4) for Windows, Linux, Solaris, and HP-UX. The revisions 
are listed in Section 4.8.3, "Linux Operating Environment Software Requirements".

■ Table 8 "Linux x86 Operating Environment Software Requirements" of the Oracle 
Developer Suite 10g Quick Installation Guide 10g (9.0.4) for Windows, Linux, Solaris, 
and HP-UX. The revisions are listed in Section 4.8.3, "Linux Operating 
Environment Software Requirements".

4.5.1.2 Setting the PATH environment variable in Linux
After you finish installing on a Linux computer, update the PATH variable of any shell 
that will be relinking Developer Suite executables via Makefiles, by inserting 
/usr/bin as the first entry of the variable.
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4.6 Configuration Issues
There are no known suite-level configuration issues.

4.7 Administration Issues
There are no known suite-level administration issues.

4.8 Documentation Errata

4.8.1 Oracle Developer Suite 10g Installation Guide
In Table A-1, footnote 2 states that "Oracle9i Warehouse Builder Release 2 (9.0.4) is now 
available separately from Oracle Developer Suite." Oracle Developer Suite 10g now 
includes Oracle9i Warehouse Builder Release 9.2. as a separate CD-ROM. For more 
information, see Section 4.1.2, "Oracle9i Warehouse Builder".

In section 2.9.4.2.2, "Mounting CD-ROMs and DVDs to HP-UX", make the following 
changes:

■ In step 2, change "ioscan" to "/etc/ioscan" so that the line reads

# /etc/ioscan -fun -C disk

■ In the Note within step 3, replace "an empty /mnt/cdrom directory" with "an 
empty /SD_CDROM directory".

■ In step 5, replace "mount the CD-ROM" with "mount the CD-ROM or DVD".

4.8.2 Oracle Developer Suite 10g Quick Installation Guide
In Table 9 "Information Needed During Installation", make the following change:

■ For the item "Java SDK Directory", change the value of "Install Type" from "All" to 
"All (HP-UX only)."

4.8.3 Linux Operating Environment Software Requirements

Note: This section replaces the following sections:

Section 2.3.4 "Linux Operating Environment" of the Oracle Developer 
Suite 10g Installation Guide 10g (9.0.4) for Windows, Linux, Solaris, and 
HP-UX.

Table 8 "Linux x86 Operating Environment Software Requirements" 
of the Oracle Developer Suite 10g Quick Installation Guide 10g (9.0.4) 
for Windows, Linux, Solaris, and HP-UX.

Please refer to Section 4.5.1.1, "Revised Linux Operating 
Environment Software Requirements" for more information.
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This section describes the Linux operating environment software requirements for the 
following supported Linux distributions:

■ Section 4.8.3.1, "Red Hat Linux 2.1 Requirements"

■ Section 4.8.3.2, "Red Hat Linux 3.0 Requirements"

■ Section 4.8.3.3, "UnitedLinux 1.0 Requirements"

You can install Oracle Developer Suite 10g on a Linux computer that is not on a 
network, and you can install Oracle Developer Suite 10g on a Linux computer that is 
configured to use DHCP. If you want to install Oracle Developer Suite 10g on a 
computer that is not on a network, you must configure the computer to use either a 
static IP address or a loopback IP address. Configure the computer to resolve its 
hostname to either a static IP address or a loopback IP address.

4.8.3.1 Red Hat Linux 2.1 Requirements
Table 4–1, " Red Hat 2.1 Operating Environment Software Requirements" lists the 
operating environment software requirements for Red Hat 2.1. The procedure that 
follows the table describes how to ensure your computer meets these requirements.

Note: Oracle does not support customized kernels or modules not 
supported by the Linux vendor.

Note: Check OracleMetaLink (http://metalink.oracle.com) 
for the most current list of supported operating environment 
software. 

Table 4–1 Red Hat 2.1 Operating Environment Software Requirements

Item Requirement

Operating System Red Hat Enterprise Linux AS/ES 2.1

(for more information, see http://www.redhat.com)

Patches Errata 25 kernel or a higher errata patch approved by Red Hat

For example, you should have one of the following, depending 
on the type of Red Hat installation you have:

■ kernel-2.4.9-e.25

■ kernel-smp-2.4.9-e.25

■ kernel-enterprise-2.4.9-e.25

The minimum supported version of the glibc package is 
glibc-2.2.4-32

Packages

(check that the specified 
version or higher is 
installed.)

■ gcc-2.96-108.1

■ pdksh-5.2.14-13

■ openmotif-2.1.30

■ compat-glibc-6.2-2.1.3.2

■ libstdc++-2.96-108.1
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To ensure that your computer meets these requirements:

1. Log in as root.

2. Determine which distribution and version of Linux is installed, by entering the 
following command:

# cat /etc/issue

This will list out the version. For example, the response

Red Hat Linux Advanced Server release 2.1AS/\m (Pensacola)

indicates that you have Red Hat Linux AS version 2.1.

3. Determine which version of the Red Hat Linux kernel is installed, by entering the 
following command:

# uname -r

This lists the kernel version. For example, the response

kernel-smp-2.4.9-e.25

shows that you have kernel 2.4.9 with errata 25. If you need to upgrade your 
kernel, refer to your operating system documentation for instructions.

4. Check that the required software packages are installed. To do this, enter the 
command:

# rpm -q package_name

for each package listed in the "Packages" entry in Table 4–1, " Red Hat 2.1 
Operating Environment Software Requirements".

If a package is missing, download it and install it using the following command:

# rpm -i package_name

Note: For more information on Red Hat patches, see 
http://www.redhat.com.
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4.8.3.2 Red Hat Linux 3.0 Requirements
Table 4–2, " Red Hat 3.0 Operating Environment Software Requirements" lists the 
operating environment software requirements for Red Hat 3.0. The procedure that 
follows the table describes how to ensure your computer meets these requirements.

To ensure that your computer meets these requirements:

1. Log in as root.

2. Determine which distribution and version of Linux is installed, by entering the 
following command:

# cat /etc/issue

This will list out the version. For example, the response

Red Hat Enterprise Linux AS 3 (Taroon)

indicates that you have Red Hat Linux AS version 3.0.

Note: Check OracleMetaLink (http://metalink.oracle.com) 
for the most current list of supported operating environment 
software. 

Table 4–2 Red Hat 3.0 Operating Environment Software Requirements

Item Requirement

Operating System Red Hat Enterprise Linux AS/ES 3.0

(for more information, see http://www.redhat.com)

Patches The minimum supported kernel and glibc versions are:

■ 2.4.21-4-EL

■ glibc-2.3.2-95.3

Packages

(check that the specified 
version or higher is 
installed.)

■ gcc-3.2.3-20

■ setarch-1.3-1

■ pdksh-5.2.14

■ openmotif21-2.1.30-8

■ gnome-libs-1.4.1.2.90-34.1

■ compat-glibc-7.x-2.2.4.32.5

■ compat-gcc-7.3-2.96.122

■ compat-libstdc++-7.3-2.96.122

■ compat-libstdc++-devel-7.3-2.96.122

■ compat-gcc-c++-7.3-2.96.122

Note: For Red Hat Linux 3.0, the equivalent version of openmotif 
2.1.30-8 is openmotif21-2.1.30-8. Install the openmotif21-2.1.30-8 
package from disk number 3 of the Red Hat Linux 3.0 distribution 
by entering:

$ rpm -ivh openmotif21-2.1.30-8
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3. Check that the required software packages are installed. To do this, enter the 
command:

# rpm -q package_name

for each package listed in the "Packages" entry in Table 4–2, " Red Hat 3.0 
Operating Environment Software Requirements".

If a package is missing, download it and install it using the following command:

# rpm -i package_name

4. Check for required symbolic links:

a. Change to the directory /usr/bin:

# cd /usr/bin

b. List these symbolic links:

# ls -l gcc g++

The response should be:

gcc -> gcc296

g++ -> g++296

5. If the symbolic links do not exist, back up the existing files and then create the 
links:

a. Back up the existing files:

# mv /usr/bin/gcc /usr/bin/gcc.backup 

# mv /usr/bin/g++ /usr/bin/g++.backup

b. Create the symbolic links:

# ln -s /usr/bin/gcc296 /usr/bin/gcc 

# ln -s /usr/bin/g++296 /usr/bin/g++

6. If you are using the hugemem kernel, set the architecture by running the following 
command:

# setarch i386

7. Apply Oracle patch no. 3006854. You can download this patch from 
OracleMetaLink (http://metalink.oracle.com). This patch creates the file 
/etc/libcwait.so and appends the following line to the file 
/etc/ld.so.preload:

/etc/libcwait.so

Note: After you have finished installing Oracle Developer Suite 
10g, you can restore the original files. The installer requires the 
symbolic links during the relink phase of installation.
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4.8.3.3 UnitedLinux 1.0 Requirements
Table Table 4–3, " UnitedLinux 1.0 Operating Environment Software Requirements" 
lists the operating environment software requirements for UnitedLinux 1.0. The 
procedure that follows the table describes how to ensure your computer meets these 
requirements.

To ensure that your computer meets these requirements:

1. Log in as root.

2. Determine which distribution and version of Linux is installed, by entering the 
following command:

# cat /etc/issue

This will list out the version. For example, the response

Welcome to UnitedLinux 1.0 (i586) - Kernel \r (\l)

indicates that you have UnitedLinux version 1.0.

3. Determine the service pack version by entering the following command:

# rpm -qf /boot/vmlinuz

If the kernel version contains the string "2.4.19", SP2a is installed. If the kernel 
version contains the string "2.4.21", SP3 is installed.

Note: Check OracleMetaLink (http://metalink.oracle.com) 
for the most current list of supported operating environment 
software. 

Table 4–3 UnitedLinux 1.0 Operating Environment Software Requirements

Item Requirement

Operating System UnitedLinux 1.0

(For more information, see http://www.unitedlinux.com)

Patches SP2a and SP3 are certified for Oracle Developer Suite 10g.

For UnitedLinux 1.0 SP2a, the minimum supported kernel and 
glibc versions are:

■ 2.4.19

■ glibc-2.2.5-179

For UnitedLinux 1.0 SP3, the minimum supported kernel and 
glibc versions are:

■ 2.4.21

■ glibc-2.2.5-213

Packages

(check that the specified 
version or higher is 
installed.)

■ gcc_old-2.95.3

■ pdksh-5.2.14

■ openmotif-2.1.30MLI4

■ libstdc++-3.2.2-38
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4. Check that the required software packages are installed. To do this, enter the 
command:

# rpm -q package_name

for each package listed in the "Packages" entry in Table 4–3, " UnitedLinux 1.0 
Operating Environment Software Requirements".

If a package is missing, download it and install it using the following command:

# rpm -i package_name

5. Create the following symbolic link for the Perl program if it does not already exist:

# ln -sf /usr/bin/perl /usr/local/bin/perl

6. Create the following symbolic link for the fuser program if it does not already 
exist:

# ln -sf /bin/fuser /sbin/fuser

7. Set up the compiler environment:

a. Install the package gcc_old-2.95.3. This installs GCC compiler version 
GCC 2.95.3 in the directory /opt/gcc295.

b. Display the symbolic links for gcc and cc by entering the following 
commands:

# cd /usr/bin
# ls -l gcc cc
gcc -> /opt/gcc295/bin/gcc
cc -> /opt/gcc295/bin/gcc

c. If these symbolic links do not exist, back up the existing files and then add the 
symbolic links:

# mv /usr/bin/gcc /usr/bin/gcc.backup
# mv /usr/bin/cc /usr/bin/cc.backup
# ln -s /opt/gcc295/bin/gcc /usr/bin/gcc
# ln -s /opt/gcc295/bin/gcc /usr/bin/cc

You must create these links so that Oracle Developer Suite 10g can relink 
during installation. Once your installation is complete, you can remove the 
links and restore the original files.

d. Create the following symbolic link if it does not already exist:

# ln -s /opt/gcc295/lib/gcc-lib/i486-suse-linux/2.95.3/libgcc.a \
/lib/libgcc.a

Note: The actual path to libgcc.a that is listed in this command 
may be different for your UnitedLinux installation. You may need 
to replace the string "suse" with another value.
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8. If the package orarun was installed, complete the following steps as user oracle 
to reset your environment:

a. Enter the following commands:

prompt> cd /etc/profile.d
prompt> mv oracle.csh oracle.csh.bak
prompt> mv oracle.sh oracle.sh.bak
prompt> mv alljava.sh alljava.sh.bak
prompt> mv alljava.csh alljava.csh.bak

b. Using a text editor, edit the file $HOME/.profile and comment out the 
following line:

. ./.oracle

c. Log out of the oracle user account.

d. Log in as user oracle. The changes now take effect.

9. If any Java packages are installed on the computer, unset Java environment 
variables such as $JAVA_HOME.

10. If you use Network Information Service (NIS):

a. Ensure that the file /etc/yp.conf contains the following line:

hostname.domainname broadcast

b. Ensure that the file /etc/nsswitch.conf contains the following line:

hosts: files nis dns

Note: Oracle recommends that you do not install any of the Java 
packages supplied with your UnitedLinux distribution.



Part II
Component Release Notes

Part II of the release notes contains one chapter of component-specific information for 
each component of Oracle Developer Suite.

Part II contains the following chapters:

■ Chapter 5, "Oracle9i JDeveloper"

■ Chapter 6, "Oracle Business Intelligence Beans"

■ Chapter 7, "Oracle Discoverer Administrator"

■ Chapter 8, "Oracle Discoverer Desktop"

■ Chapter 9, "Oracle Forms Developer"

■ Chapter 10, "Oracle Reports"

■ Chapter 11, "Oracle Designer"

■ Chapter 12, "Oracle Software Configuration Manager"

Note: The documentation for an individual component of Oracle 
Developer Suite may list a specific version of the JDK, JRE, J2SE, 
J2EE or other Java feature that is certified for that component. 
Nevertheless, the Java version that is supplied with Oracle 
Developer Suite 10g 9.0.4 is also fully certified for all components. 

For example, the Java in Oracle Developer Suite 10g 9.0.4 for Linux 
is 1.4.2.x, while the Oracle Business Intelligence Beans (BI Beans) 
documentation says that BI Beans is only certified with 1.4.1. 
However, BI Beans is also certified with the Java SDK 1.4.2 that is 
installed with Oracle Developer Suite 10g for Linux.
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5
Oracle9i JDeveloper

This chapter discusses the following Oracle9i JDeveloper topics:

■ Section 5.1, "General Issues and Workarounds"

■ Section 5.2, "Platform-specific Issues and Workarounds"

■ Section 5.2.1, "Windows Platform Issues and Workarounds"

■ Section 5.2.2, "Linux, Solaris, and HP-UX Platform Issues and Workarounds"

■ Section 5.3, "Configuration Issues and Workarounds"

■ Section 5.4, "Administration Issues and Workarounds"

■ Section 5.5, "Documentation Errata"

5.1 General Issues and Workarounds

5.1.1 Introduction
Oracle9i JDeveloper (JDeveloper) is a J2EE development environment with end-to-end 
support for developing, debugging, and deploying e-business applications and web 
services.

To maximize developer productivity, JDeveloper provides a comprehensive set of 
integrated tools to support the complete development lifecycle, from source control, 
modeling, and coding through debugging, testing, profiling, and deploying. 
JDeveloper simplifies J2EE development by providing wizards, editors, visual design 
tools, and deployment tools to create high-quality, standard J2EE components 
including applets, JavaBeans, JavaServer Pages (JSP), servlets, and Enterprise 
JavaBeans (EJB). JDeveloper also provides a public Extension SDK to extend and 
customize the development environment and to seamlessly integrate with external 
products.

For more information about this release, please visit the JDeveloper page on the Oracle 
Technology Network at http://otn.oracle.com/products/jdev. You will also 
find there the Oracle9i JDeveloper Version 9.0.4 Release Notes Addendum 
(http://otn.oracle.com/products/jdev/htdocs/9.0.4.0/readme_
9.0.4_addendum.htm) which contains additional information not available at the 
time of this document's publication
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To simplify the development of scalable, high-performance J2EE applications, 
JDeveloper offers an open and extensible J2EE framework called Business 
Components for Java (BC4J). BC4J implements Sun's J2EE design patterns and allows 
developers to quickly build sophisticated J2EE applications.

5.1.1.1 Support for Oracle9i Release 2 (9.2)
Oracle9i JDeveloper version 9.0.4 is distributed with drivers for Oracle9i Release 1. 
These drivers are compatible with the following database versions:

■ Oracle9i Release 2 (9.2)

■ Oracle9i Release 1 (9.0.1)

■ Oracle8i (8.1.7)

Drivers for Oracle9i Release 2 can be installed in JDeveloper version 9.0.4, but are not 
supported.

5.1.2 Deploying to OC4J

5.1.2.1 OC4J Version Shipped with Oracle JDeveloper 9.0.4
By default, Oracle9i JDeveloper Version 9.0.4 lets you fully test your J2EE applications 
in JDeveloper using the embedded OC4J server before deploying to a target 
application server. The OC4J 9.0.4 embedded server resides in the following location in 
JDeveloper:

■ Windows single-user: oracle_home\jdev\system####\oc4j-config

■ Linux, Solaris, and HP-UX, and multi-user: oracle_home/
jdev_user_dir/jdev/system####/oc4j-config

JDeveloper also ships a copy of OC4J 9.0.4, which you can run in standalone mode. 
The files for the OC4J 9.0.4 standalone server are located in

oracle_home/j2ee/home

Related files can be found in

oracle_home/j2ee/home/config

If you deploy your applications to standalone OC4J, make sure that you use the 
remote admin.jar file that was shipped with the remote OC4J. If you are using an 
admin.jar that doesn't match the version of OC4J to which you are deploying, 
deployment may fail. You can configure deployment to use the correct admin.jar for 
the OC4J standalone instance when you set up your connection using the JDeveloper 
Application Server Connection Wizard.

To view the version of OC4J that you are using, enter the following from your OC4J 
installation directory:

java -jar oc4j.jar -version
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5.1.2.2 OC4J Memory Requirements
By default, OC4J preloads a large number of classes to improve performance. Because 
of this, you may get a java.lang.OutOfMemoryError when you attempt to deploy 
to OC4J.

If you get a java.lang.OutOfMemoryError, you have two options:

■ If your computer lacks sufficient free memory to run OC4J with a larger maximum 
heap size, shut down the Java process that runs OC4J and restart it with the 
-Doracle.j2ee.dont.use.memory.archive=true flag to turn off class 
preloading, for example:

Java -Doracle.j2ee.dont.use.memory.archive=true
-jar oc4j.jar 

■ If your computer has at least 512 MB of free memory, OC4J will run more quickly 
if you leave preloading enabled, but startup time will increase considerably. Shut 
down the Java process that runs OC4J, and restart it with a larger maximum heap 
size using the -mx flag, for example:

Java -mx512M -jar oc4j.jar

5.1.3 Deploying to Other Application Servers

5.1.3.1 Problems Running UIX Web Applications (including the BC4J JSP Admin 
Page) Deployed to Non-Oracle Application Servers (2577293)

You may get the following error when running a UIX web application deployed to a 
non-Oracle application server, or clicking the BC4J Admin link on a BC4J JSP 
application deployed to a non-Oracle application server:

[INFO] RequestProcessor - -Processing a 'GET' for Path...
Root cause of ServletException
java.lang.NullPointerException...

To avoid this error, you must make changes to the uix-config.xml file.

If you are running a BC4J JSP application with an Admin page, make the change on 
the server:

1. Find and unzip the bc4j.ear file on the server.

2. Unzip the webapp.war file that is extracted.

3. Open the extracted file WEB-INF/uix-config.html in a text editor.

4. Uncomment the <default-configuration> element.

5. Set the value of the <full-uri> element to the URL of your application server, 
including the port number.

6. Set the value of the <full-path> element to the full local path to the parent 
directory of the cabo directory on your application server.

Note: Be sure to use the parent directory, not the cabo directory itself.

7. Repackage the webapp.war file.

8. Repackage the bc4j.ear file.

9. Redeploy the modified bc4j.ear file.
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If you are running a full BC4J UIX application, make the changes inside JDeveloper:

1. In the System Navigator, find the file uix-config.html and open it in the Code 
Editor.

2. Uncomment the <default-configuration> element.

3. Set the value of the <full-uri> element to the URL of your application server, 
including the port number.

4. Set the value of the <full-path> element to the full local path to the parent 
directory of the cabo directory on your application server.

Note: Be sure to use the parent directory, not the cabo directory itself.

5. Save the file and redeploy the application to the non-Oracle application server.

5.1.3.2 Deploying Web Applications to Apache Tomcat 4.1
If you are deploying to Apache Tomcat 4.1, you will have to copy the BC4J runtime 
libraries into tomcat_install/common/lib, not tomcat_install/lib. See the 
help topic "Deploying Web Applications to Apache Tomcat" for more information.

5.1.3.3 Problems in JSP Applications Deployed to Tomcat (2615358)
Due to a Tomcat bug, you may get the following error message when running a JSP 
application deployed to tomcat:

Only one of the two parameters ... or ... should be defined.

This is caused by an error in Tomcat's tag pooling mechanism. Because Tomcat does 
not release tags after pooling, subsequent uses of the same tag with incompatible 
attributes defined will cause this error.

To avoid the error, you must disable tag pooling in Tomcat:

1. Open the file tomcat_home/conf/web.xml in a text editor.

2. Find the following element:

<init-param>
  <param-name>enablePooling</param-name>
  <param-value>true</param-value>
</init-param>

3. Change the value of <param-value> to false.

5.1.3.4 XSQL Page Processor Cannot Read Pages from Unexpanded Servlet 2.2 
WAR File (1552039)
You cannot run XSQL pages in WebLogic 6.1/7.0, JBoss 3.0.4, or Tomcat 4.1.12.

5.1.3.5 Type Incompatibilities when Deploying to WebLogic
Some applications deployed to WebLogic may have type incompatibilities if you use 
the BEA supplied Oracle classes. To ensure that you don't have these problems, replace 
the supplied classes12.zip and classes12.jar file in your server's lib 
directory with classes12.jar in the oracle_home/jdbc/lib directory.
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5.1.3.6 WebLogic6.1 Fails to Understand Windows-1252 Encoding in XML Files
WebLogic6.1 fails to understand 'Windows-1252' encoding in the xml files. This is a 
bug in the xmlparser in WebLogic6.1. To deploy applications in JDeveloper to 
WebLogic6.1 change encoding to an IANA encoding that WebLogic6.1 recognizes. It is 
recommended to use UTF-8 encoding. Japanese users need to use Shift_JIS:

For example, to use UTF-8 encoding, do the following:

1. In JDeveloper, choose the menu item Tools > Preferences.

2. In the Environment panel change the Encoding field to UTF-8.

3. Click OK.

Now create a new project and your application.

5.1.3.7 CORBA Requires JDK 1.3 at Runtime (2685103)
Although you can develop a CORBA application for Visibroker using the JDeveloper 
9.0.4 default JDK 1.4, in order to deploy or run the application, you must make sure 
these changes are made:

■ Run the Visibroker server using JDK 1.3.

■ Before deployment, configure the project to use JDK 1.3, and add these items to the 
Java command line, which you can do in Project > Default Settings:

-Dorg.omg.CORBA.ORBClass=com.inprise.vbroker.orb.ORB
-Dorg.omg.CORBA.ORBSingletonClass=com.inprise.vbroker.orb.ORBSingleton
-Djavax.rmi.CORBA.StubClass=com.inprise.vbroker.rmi.CORBA.StubImpl
-Djavax.rmi.CORBA.UtilClass=com.inprise.vbroker.rmi.CORBA.UtilImpl
-Djavax.rmi.CORBA.PortableRemoteObjectClass=com.inprise.vbroker.rmi.CORBA.
PortableRemoteObjectImpl

These options are only required for client JSP projects. We recommend specifying the 
settings in your default settings for ease of use.

5.1.4 Miscellaneous Deployment Issues

5.1.4.1 ejb-ref in web.xml not Updated if the Bean Type is Changed from Remote to 
Local (2589997)
Creating a JSP application for a BC4J session facade results is an ejb-ref entry in the 
web.xml of the that project. If you change the interface type of that facade, from local 
to remote or vice versa, then you must update the ejb-ref entry in web.xml. For 
example if you change the bean type from remote to local then you must replace the 
<ejb-ref> section in web.xml with the appropriate <ejb-local-ref> tags.

5.1.5 BC4J Issues

5.1.5.1 Available Tables not Visible Under Java Type Map and SQL92 SQL Flavor 
(2693168)
In the BC4J Package Wizard, if you are using the Java Type Map and the SQL92 SQL 
flavor, you may not initially see any tables in the Available Tables list. To fix this 
problem, uncheck and then recheck the Tables checkbox.
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5.1.5.2 902 Projects with VO or Attribute Names Containing $ do not Migrate 
(2701773)
If your BC4J project has component names or attribute names containing a "$" 
character, you need to rename the attributes or components and remove the "$" before 
migrating your project to a later release of JDeveloper. BC4J names cannot contain "$" 
in JDeveloper 9.0.3 and later.

5.1.5.3 JDeveloper 9.0.4 *.jpr File Format Not Backward Compatible with 9.0.3 
(2682921)
If you have JDeveloper projects created with a previous release, after opening these 
projects in JDeveloper 9.0.4 and saving the .jpr file in the 9.0.4 format, you no longer 
can re-open the same .jpr file in JDeveloper 9.0.3. Specifically in the case of 9.0.3 
projects containing BC4J components, after saving their JPR file in the JDeveloper 9.0.4 
format, any attempt to reopen them in 9.0.3 will no longer load/build the project 
correctly. If you are using JDeveloper 9.0.4 to test the release on an existing project, 
please make a backup copy of your JDeveloper 9.0.3 .jpr files in case you want to go 
back to using JDeveloper 9.0.3.

5.1.5.4 Migrated Project: Export Interface is Removed but Still Implemented in 
IMPL Class (2676186)
This issue only applies if you have a 9.0.2 BC4J project containing an empty export 
interface and you want to migrate the project to a later release of JDeveloper. You 
would have an empty export interface if you exported client methods in an application 
module or view object, and then removed all methods from the export list. If you 
migrate this type of project to a later release of JDeveloper the empty export interface 
is removed but the class that implements it is not removed, causing compilation errors.

The workaround is to delete the "implements" clause (for example, "implements 
EmpView") from the class declaration in your class file. You can do this before or after 
migrating the project, although it is probably easier to do it after because the 
compilation errors will tell you what needs to be fixed.

5.1.5.5 Bean Name in <EJB-LOCAL-REF> not Updated when Underlying Entity is 
Renamed (2587916)
You should not rename entity beans that have BC4J entity facades depending on them. 
Doing so will cause a NullPointerException because the deployment profile is 
not updated properly.

5.1.5.6 Setting Current Database Time Using Entity Facades (2525437)
Entity facades (both BMP and CMP) must override getDbCurrentTime() in the 
generated xxxFacadeCollImpl.java to return the database current time. This is 
necessary because getDbCurrentTime() in 
oracle.jbo.server.ejb.facade.EntityFacadeCollImpl uses Java system 
time; the SQL flavor and connection details are not known for the entity facade.

5.1.5.7 Replace qView with getRowSet in Migration Documentation (2723075)
In the migration documentation, replace qView with getRowSet.
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5.1.5.8 Documentation Refers to BC4J "Wizards"
The help documentation that is displayed when you click Help in one of the 
component editors refers to a component "wizard" when it should refer to a "wizard or 
editor". For example, the help text that is displayed when you click Help in the Entity 
Object Editor has the title "Entity Object Wizard"; the title should be "Entity Object 
Wizard and Editor".

5.1.5.9 Unable to Run a BC4J JSP in OC4J in VB Bind Mode (2594776)
When accessing the BC4J CORBA server you need to set some properties before 
initializing the ORB. These properties are set internally but in this case it's too late 
because OC4J initializes the ORB at startup.

The workaround is to manually add the following system properties to the OC4J 
command line. If you are using the embedded server then add these to the VM 
settings of the project from which the embedded OC4J instance is started:

-Dorg.omg.CORBA.ORBClass=com.inprise.vbroker.orb.ORB
-Dorg.omg.CORBA.ORBSingletonClass=com.inprise.vbroker.orb.ORBSingleton
-Djavax.rmi.CORBA.UtilClass=com.inprise.vbroker.rmi.CORBA.UtilImpl
-Djavax.rmi.CORBA.PortableRemoteObjectClass=com.inprise.vbroker.rmi.CORBA
.PortableRemoteObjectImpl

5.1.5.10 Problem Running Struts Actions in 9.0.3 Project After Upgrade (2756440)
After opening a 9.0.3 JDeveloper project containing a struts-config.xml file and 
Struts Actions, if you try to select one of the actions and choose Run... from the context 
menu, you may get the error:

The target /your action cannot be started because it does not 
exist.

The workaround is to edit the struts-config.xml file in some way (for example, 
by adding a space somewhere, then deleting that space, and re-saving). After resaving 
the edited struts-config.xml file, then the actions can again be run.

5.1.5.11 Help Sometimes Not Available for Business Component Browser
 You can only access the help system from the Business Component Browser if you 
launch the browser by right-clicking an application module and choosing Test. If you 
invoke the Business Component Browser by running, debugging, or profiling your 
model project, help will not be available.

5.1.5.12 jbo.debugoutput Property can Take Value of "file"
In addition to the documented values of "silent", "console", and "routing_classname", 
you can set the value of jbo.debugoutput to "file" to log BC4J debugging 
information to a text file.
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5.1.6 EJB Issues

5.1.6.1 Cannot Run EJB in Embedded OC4J Server if Workspace Has Two Projects 
(2096700, 2591173)
You may encounter errors if you try to run an EJB application with a CMP entity bean 
in JDeveloper's embedded OC4J server, if the workspace containing your application 
contains two or more projects. To avoid errors, make sure that the output directory 
path is different for the different projects to avoid a naming collision. To specify an 
output directory path, select a project and right click Project Settings >  Configuration 
> Development > Paths, then specify a directory name in the Output Directory text 
field that is different from other projects in the same workspace.

5.1.7 JClient Issues

5.1.7.1 JTree Binding is not Editable (2061405)
When you create a Java Tree control you can define the property EDITABLE in the 
property inspector. If this property is set to TRUE and you edit a node on the tree, you 
will receive an exception. The binding for the tree control does not support this being 
editable.

5.1.7.2 Cannot Run JClient Applications in EJB Mode Running in Webstart 1.2 
(2699458)
Due to a missing signed entry in resource J2EE/HOME/LIB/JAAS.JAR it is not 
possible to run JClient applications in EJB mode running in Webstart 1.2.

5.1.7.3 Webstart not Launched in IE 5.5 Due to Mimetype Problems (2573655)
When attempting to run a JClient webstart application in Internet Explorer 5.5 using 
the local.jsp link generated by the JClient Web Start Wizard, Java Web Start does 
not get launched. Instead IE 5.5 will prompt you to open a file.

The workaround is to create a new mime type using regedit and associate it to the 
.jnlp extension. For example, in regedit, locate HKEY_CLASSES_ROOT\ 
MIME\Database\Content_Type\application\
x-java-jnlp-file;charset=ISO-8859-1 and set property Extension to value 
.jnlp.

5.1.7.4 SpinnerNumberModel for JSpinner Control does not Work for 
oracle.jbo.domain.Number (2738858)
If you intend to represent an Integer field (such as Commission) using a Spinner 
control which should be able to "spin" through all integer values, then you would use 
the SpinnerNumberModel to represent the value, min value, max value and step.

However, in BC4J the default mapping for an numeric attribute is 
oracle.jbo.domain.Number. JUSpinnerBinding currently only supports the 
following types: Double, Float, Long, Integer, Short or Byte .

So, the underlying attribute should be mapped to java.lang.Integer.
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5.1.8 Source Control Support Issues

5.1.8.1 Oracle SCM: JDeveloper Does Not Share Folder Mappings with the Oracle 
SCM RON
If the Oracle Software Configuration Manager (SCM) Repository Object Navigator is 
used to download or synchronize files to the file system, JDeveloper does not 
recognize the downloaded files as SCM files. This is because mapping information 
stored by the RON is not available to JDeveloper.

 To download SCM files to the file system for use in JDeveloper, use one of the 
following options:

■ Use the Workarea Wizard in JDeveloper to create your workarea. The files in the 
workarea will be automatically downloaded to the workarea download folder.

■ Use the Folder Mappings tool in JDeveloper to specify a workarea download 
folder and map folders you want to download to the file system. You can use 
Folder Mappings to download files in a workarea created in the RON.

5.1.8.2 Oracle SCM: Using JDeveloper and the Oracle SCM VHV
After performing source control operations using JDeveloper, such as merging or 
checking files in or out, you should not use the VHV to perform further operations on 
these files.

5.1.8.3 Oracle SCM: Connecting to Oracle Software Configuration Manager 6i 
Release 4.1.1 or Above
Oracle JDeveloper is certified to work with the Oracle Software Configuration 
Manager which is part of Oracle9iDS Release 2 version 9.0.2. Note that Oracle 
JDeveloper will not prevent you from connecting to Oracle Software Configuration 
Manager 6i Release 4.1.1 or above, but this is not a certified combination.

5.1.9 Modeling Issues: General

5.1.9.1 Performing Source Control Operations On Model Element and Diagram 
Files (2211605)
If you store model element or diagram files in a source control system, Oracle 
recommends that you perform any source control operations on those files before you 
load them into memory. If you perform a source control operation on a model element 
or diagram file while it is currently held in memory, any changes to the copy of the file 
currently held in memory could be overwritten. To ensure that a model element or 
diagram file is not currently being held in memory, restart JDeveloper, then perform 
the source control operation before opening the model element or diagram.

5.1.9.2 Exceptions on Startup if Install Directory Has a Space in Name (2709528)
If you install JDeveloper into a directory that has a space in its name, you will get 
exceptions on startup and will not be able to create a new UML diagram.
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5.1.10 Modeling Issues: Modeling Java Classes, BC4J or EJB Components

5.1.10.1 Deleting Modeled Java Classes (2706800)
If you delete from the Navigator a modeled Java class that has associations to other 
Java classes, then the associations are not removed from the model. If you then drag 
any of these orphaned associations onto a diagram, an exception is thrown. To prevent 
this, if you need to delete a modeled Java class that has associations, do so from the 
diagram.

5.1.11 Modeling Issues: Modeling Activities for E-Business Integration

5.1.11.1 E-Business Integration Generator Generates Propagations Using Public 
Database Links (2063917)
A bug in AQ propagation (2146152) means that remote propagations fail when using 
private database links to specify the destination. The E-Business Integration Generator 
presently generates and deploys remote propagations that use public database links in 
order to circumvent this problem.

This bug will be fixed in later versions of the database. After applying this patch, the 
public database links can be manually replaced with private database links, by 
querying the contents of the ALL_DB_LINKS view and creating private database links 
in the appropriate schema, with the same details as the public links being replaced.

5.1.11.2 Using HTTP Propagation on a 9.0.1 Database
If you use a 9.0.1 database and wish to use HTTP propagation, you must download 
and install an upgrade to the XML Developer's Kit for Java from OTN, version 
9.0.2.0.0C. Instructions on how to install this upgrade into the database are provided in 
the download itself. The xsu12.jar file in the lib subdirectory of the download 
should also replace any existing version of xsu.jar in the classpath of the web server 
that runs the AQ propagation servlet.

5.1.12 Web Services Issues

5.1.12.1 Renaming a Method on a Modeled Web Service Fails to Expose It 
(2702659)
When you have a modeled web service created from a modeled Java class, and you 
rename a method by editing the modeled web service or the modeled Java class, the 
renamed method will seem to vanish from the web service although the modeled Java 
class will display the new method name.

You have to reselect the method for publication as a web service. Double-click the 
modeled web service, and on the Exposed Methods page select the method and click 
OK.

5.1.12.2 SOAP Web Service Does Not Start New Session (2218102)
When you have a SOAP web service created using JDeveloper that uses a scope of 
"session", it does not start a new session when accessed by a different client.
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5.1.12.3 Using JMS Web Services with OC4J
OC4J/JMS is not supported in Oracle9iAS 9.0.3 or OC4J 9.0.3. OJMS is the JMS 
interface onto Oracle AQ in the database, and it is Oracle's J2EE 1.3 compliant JMS 
provider.

To run a JMS web service deployed to OC4J 9.0.3 or Oracle9iAS 9.0.3, you should 
configure OC4J to hand over the JMS implementation to OJMS. For more information, 
refer to "Oracle9iAS Containers for J2EE (OC4J) - Java Message Service (JMS) - 
Frequently Asked Questions" on the Oracle Technology Network, 
http://otn.oracle.com/tech/java/oc4j/htdocs/OC4J-JMS-FAQ.html.

5.1.12.4 Creating JMS Web Services that Use Both Send and Receive Operations
When you create a JMS web service that uses both a send and a receive operation you 
must explicitly specify different connection factories and destinations for the send 
operation and the reply-to operation, unless you are certain that the web service client 
wants to send to and receive from the same destination.

In Step 3 of the JMS Web Service Wizard, select Receive operation uses separate JMS 
destination, and enter the connection factory and the destination for the receive 
operation. These must be different to the connection factory and destination for the 
send operation.

5.1.12.5 Running the PL/SQL Web Service Generator with JDK 1.4
To work properly under JDK 1.4, the PL/SQL web service generator needs to be run 
with Oracle's JDK 1.4-specific JDBC drivers. These can be downloaded from Oracle 
Technology network (http://otn.oracle.com). Extract them into the 
oracle_home/jdbc/lib directory.

To configure JDeveloper to use the JDK 1.4 JDBC drivers, you must amend the oracle_
home/jdev/bin/jdev.conf file. Replace the line

AddJavaLibFile ../../jdbc/lib/classes12.jar 

with

AddJavaLibFile ../../jdbc/lib/ojdbc14.jar

JDeveloper will now use the JDK 1.4 version of the JDBC drivers, for all JDBC 
operations.

5.1.12.6 Runtime Error Calling a Web Service from a Generated Stub (2389203)
If you receive a runtime error when calling a web service from a generated stub, and 
the returned value is an unrecognized XML type, you should use a command similar 
to the following to deserialize the XML type into a string:

m_smr.mapTypes(Constants.NS_URI_SOAP_ENC, new QName("", 
"return"), null, null, 
new org.apache.soap.encoding.soapenc.StringDeserializer());

5.1.12.7 Cannot Model Web Services Based on PL/SQL Packages (2466833)
Modeled web services on class diagrams cannot be based on PL/SQL or JMS web 
services.
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5.1.12.8 Creating a Stub with Overloaded Methods to a .NET Web Service (2689939)
When you create a stub to a .NET web service which contains more than one method 
with the same name, the stub is generated with just one method present, for example:

public Float Add(Float a, Float b) throws Exception;

You must manually edit the stub to add the additional overloaded methods, for 
example:

public Float Add(Float a, Float b) throws Exception;

public Integer Add(Integer a, Integer b) throws Exception;

5.1.12.9 Web Service Stub if Generated from JDeveloper Install Path has Space 
(3068701)
If you install JDeveloper in a path where any of the folders have a space in the name 
and then generate a web service which you run on the embedded OC4J server or on an 
external instance of the OC4J server, you will find that a stub to the service will fail 
when the web service is called.

The workaround is to install JDeveloper in a path without a space in any folder name.

5.1.12.10 Generating Stubs for WSDL Files That Refer to Other WSDL Files 
(2627242)
 If you want to generate a stub for a WSDL file that refers to, or imports, another 
WSDL file, the Web Service Stub/Skeleton Wizard will not be able to finish as it 
incorrectly identifies the WSDL file as invalid.

5.1.13 Using WebDAV Connections in JDeveloper
Web-based Distributed Authoring and Versioning (WebDAV) is a set of extensions to 
the HTTP protocol that enables access to files on remote Web servers.

5.1.14 Miscellaneous Issues

5.1.14.1 PL/SQL Compilation Errors Not Displayed (2688533)
If the name of the PL/SQL unit contains the schema name or is surrounded with 
quotes (or both), JDeveloper will not report compilation errors in the Log window. For 
example, you should write:

PROCEDURE my_proc IS

instead of

PROCEDURE scott.my_proc IS

or

PROCEDURE "MY_PROC" IS

Note: Before using WebDAV Connections in Oracle JDeveloper, 
you must first install the WebDAV extension from the Extension 
Exchange on OTN. For more information, refer to the Oracle 
Developer Suite 10g Installation Guide.
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5.1.14.2 Allowable Values for Columns Must be Given a Display Sequence 
(2717508)
Generated JDeveloper modules will be invalid if the Designer table definitions from 
which they were derived contain columns with allowable values whose Display 
Sequence property is set to NULL.

For JDeveloper 9.0.4, you must always provide non-NULL values for the Display 
Sequence properties. You do this through the properties palette of Oracle Designer.

This behavior will change for JDeveloper 9.0.5, when a NULL value will be acceptable 
for a Display Sequence property.

5.1.14.3 Toystore Demo Contains Obsolete bc4jstruts.jar File
The Toystore demo included with JDeveloper contains the file bc4jstruts.jar. This 
copy of bc4jstruts.jar is obsolete, and the demo will not run properly until the 
file is updated.

To update the file, remove it from your project, and replace it with the copy of 
bc4jstruts.jar found in oracle_home/BC4J/jlib.

5.1.14.4 Right Mouse Menu "Go to Source" no Longer Working (3146584)
The context menu item Go to Source for an element in the Show Dependency window 
no longer works. Instead, double-click the item to open the proper editor for the Java 
element.

5.1.14.5 Passivation/Activation of interMedia Domain Objects with Media Content 
to Upload does not Work in 3 Tier Environment (2887647)
When you build a BC4J JSP application that uploads media content to interMedia 
columns and you select "EJB Entity Facades" when asked for what type of Business 
Entities will be modeled, the media content upload will fail if the BC4J JSP application 
is running in the "Stateful" mode with the "failover" option set to true. 

5.2 Platform-specific Issues and Workarounds

5.2.1 Windows Platform Issues and Workarounds

5.2.1.1 Updated JDK Required for Windows Preview Oracle9i JDeveloper
If you are using Oracle9i JDeveloper (9.0.4) as part of the Windows Preview version of 
Oracle Developer Suite 10g (9.0.4), you must upgrade JDeveloper's JDK to version 
1.4.1_05. You can download this version from the Sun Microsystems site 
http://java.sun.com. Look in JDeveloper’s online help system for instructions on 
upgrading to this version.
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5.2.2 Linux, Solaris, and HP-UX Platform Issues and Workarounds

5.2.2.1 General Linux, Solaris, and HP-UX Platform Issues and Workarounds
Sun Java Bug 4751177: Ignore Error Messages

You can safely ignore these error messages which may occur if you run JDeveloper on 
Linux, Solaris, or HP-UX:

java.lang.SecurityException: Could not lockSystem" or "Oct 23, 2002 4:16:55 PM 
java.util.prefs.FileSystemPreferences
checkLockFile0ErrorCodeWARNING: Could not lock System prefs.Unix error code 0.Oct 
23, 2002 4:16:55 PM java.util.prefs.FileSystemPreferences syncWorld
WARNING: Couldn't flush system prefs:
java.util.prefs.BackingStoreException:
Couldn't get file lock.

These errors are caused by a new system preferences feature in JDK 1.4. Details are 
provided in Sun Java bug 4751177.

Cannot create SOAP Server connections on Linux, Solaris, and HP-UX with Oracle9i 
JDeveloper (9.0.4) installed with Oracle Developer Suite 10g (9.0.4)(3042893)

After creating a SOAP Server connection from Oracle9i JDeveloper (9.0.4) installed 
with Oracle Developer Suite 10g (9.0.4), the following java exception occurs:

java.lang.Exception: SOAP-ENV:Server: service
'urn:xml-soap-service-management-service' unknown

5.2.2.2 Solaris-specific Issues and Workarounds
Unable to Select from the Code Insight List by Mouse-Click (2671418)

On Solaris, using the mouse to select from Code Insight results in the Code Insight list 
being dismissed without retaining the selection. The workaround is to use the 
keyboard to select from Code Insight.

Solaris Only: Long Delay Showing Database Objects in Entity Beans from Tables 
Wizard (2691427)

You may experience long delays seeing database objects in entity beans from the Table 
Wizard. This typically happens if you start with an empty workspace and there are no 
database connections defined in the IDE. The workaround to this is to click the Back 
button in the wizard panel which is waiting to show the database objects and then 
click the Next button. All available tables should then be displayed.

Publishing a Diagram as a JPEG or PNG Remotely on Solaris (3142729)

Note:  Platform-specific issues are only reported for the platform 
on which they were first detected; an issue that is listed as 
"platform-specific" may actually occur on several platforms. Unless 
the notes say otherwise, you should only use a platform-specific 
workaround on the stated platform.

Note: This only occurs with Oracle9i JDeveloper 9.0.4 installed 
with Oracle Developer Suite 10g (9.0.4). It occurs on Linux, Solaris, 
and HP-UX. It does not occur with standalone Oracle 9i JDeveloper 
9.0.4 on any platform.
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When you publish a diagram as a JPEG or PNG graphic remotely on a Solaris 
computer, the operation to publish the diagram can take a very long time to complete 
and it may appear that JDeveloper has frozen. You can work around this problem by 
either performing the publish operation directly on the Solaris computer or by 
publishing the diagram as SVG.

5.2.2.3 Linux-specific Issues and Workarounds
ClassNotFoundException exception when deploying EBI files on Linux 
(3168559)

When you try to deploy EBI generated files on Linux, the deployment dialog does not 
appear, and the JVM throws the following exception:

java.lang.ClassNotFoundException: EBIDeploymentProfileDt.m_deploy at
java.net.URLClassLoader$1.run(URLClassLoader.java:199)
at java.security.AccessController.doPrivileged(Native Method)
at java.net.URLClassLoader.findClass(URLClassLoader.java:187)
at java.lang.ClassLoader.loadClass(ClassLoader.java:289)
at oracle.ideimpl.IdeClassLoader.loadClass(IdeClassLoader.java:152)

This issue occurs intermittently and retrying the deployment will usually succeed.

5.2.2.4 HP-UX Issues and Workarounds
JDeveloper requires -Dsun.nio.cs.map="Windows-31J/Shift_JIS" when 
using HP Java2 SDK 1.4.1.05 for PA-RISC (3238704) 

HP Java2 SDK 1.4.1.05 for PA-RISC has an issue (JAGae96995) that causes the 
following exception when JDeveloper is started on HP-UX:

java.lang.NullPointerException
        at java.nio.charset.Charset.put(Charset.java:437)
        at java.nio.charset.Charset.access$200(Charset.java:243)
        at java.nio.charset.Charset$3.run(Charset.java:476)
        at java.security.AccessController.doPrivileged(Native Method)
        at java.nio.charset.Charset.availableCharsets(Charset.java:469)

Oracle has notified HP of this issue, and HP plans to fix it in HP Java2 SDK version 
1.4.1.06. 

Since Oracle Developer Suite 10g uses HP Java2 SDK 1.4.1.05 for PA-RISC, the 
oracle_home/jdev/bin/jdev shell script that starts JDeveloper has been modified 
to work around this issue. Because of this workaround, the two Japanese character sets 
Windows-31J and Shift_JIS cannot be used with JDeveloper. Comments in the shell 
script oracle_home/jdev/bin/jdev describe the workaround and how to enable 
and disable it.

5.3 Configuration Issues and Workarounds
There are no known configuration issues.

5.4 Administration Issues and Workarounds
There are no known administration issues.
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5.5 Documentation Errata

5.5.1 Replace qView with getRowSet in Migration Documentation (2723075)
In the migration documentation, replace qView with getRowSet.

5.5.2 Documentation Refers to BC4J "Wizards"
The help documentation that is displayed when you click Help in one of the 
component editors refers to a component "wizard" when it should refer to a "wizard or 
editor". For example, the help text that is displayed when you click Help in the Entity 
Object Editor has the title "Entity Object Wizard"; the title should be "Entity Object 
Wizard and Editor"
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6
Oracle Business Intelligence Beans

This chapter discusses the following Oracle Business Intelligence Beans (BI Beans) 
topics:

■ Section 6.1, "Introduction"

■ Section 6.2, "General Issues and Workarounds"

■ Section 6.3, "Platform-specific Issues and Workarounds"

■ Section 6.4, "Configuration Issues and Workarounds"

■ Section 6.5, "Administration Issues and Workarounds"

■ Section 6.6, "Documentation Errata"

6.1 Introduction
Oracle Business Intelligence Beans (hereinafter referred to as "BI Beans") is a set of 
standards-based JavaBeans that provides analysis-aware application building blocks 
designed for Oracle OLAP. Using Oracle JDeveloper and BI Beans, you can build Web 
applications quickly and easily. These applications expose the advanced analytic 
features of the Oracle database both to casual information viewers and to high-end 
users who require complete ad-hoc query and analysis functionality. For more 
information, consult the following:

■ The Oracle Developer Suite 10g Installation Guide -- available from the Oracle 
Developer Suite product CD-ROM or DVD, or the Oracle Developer Suite 
Documentation Library.

■ Certification and System Requirements -- can be downloaded from the BI Beans 
product area on Oracle Technology Network 
(http://otn.oracle.com/products/bib/); includes database versions and 
patch sets that are certified for this release as well as certified deployment 
environments.

■ "Getting Started with BI Beans" -- a topic in the JDeveloper Help system; includes 
links to tutorials.

■ BI Beans API Reference -- accessible from the JDeveloper Help menu.

■ BI Beans samples -- published on the BI Beans product area on Oracle Technology 
Network; designed to assist you in coding common application tasks.
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6.2 General Issues and Workarounds

6.2.1 Tutorials and samples
When you install the sample database schema, you might get an error that says the SH 
account is locked. If you want to remove the SH metadata and use only that from 
BIBDEMO, then the DBA must unlock the account. If you do not want to remove the 
SH metadata, then you can ignore this error and allow the installation script to 
continue. BI Beans will then display both BIBDEMO and SH metadata. 

6.2.2 QueryBuilder and queries
■ If you attempt to update a query that uses the NASuppression option, then an 

OLAP API exception might be generated. This problem does not exist when 
running against Oracle OLAP 9.2.0.4 or higher.

■ BI Beans does not support the interspersing of symmetric and asymmetric drill 
operations. That is, the AsymmetricDrilling property of a Query object should 
not be changed during that object's lifetime.

■ In DataDirector, if you set the SuppressionState method to either 
DataDirector.ZERO_SUPPRESSION or DataDirector.NA_ZERO_
SUPPRESSION, then the result is the same: both zeros and nulls are suppressed in 
the results.

■ You cannot save a favorite that references both a calculation and another favorite. 
Attempting to do so results in a null pointer exception.

■ When you use QueryBuilder to create an asymmetric query, changes that you 
make on the Layout panel should be applied to the presentation before making 
changes to the Dimensions panel. Otherwise an exception will occur.

■ In a query, if you create an asymmetric top/bottom step whose selection depends 
on a dimension that is on the page edge, then an error is generated. This problem 
does not exist in Oracle OLAP 9.2.0.4 and higher. If you are running against an 
earlier version of Oracle OLAP, then you can work around the problem by 
qualifying the measure to a specific dimension member from the page edge.

■ If a query that you save in BI Beans 9.0.3 or 9.0.4 includes a favorite that references 
a custom measure, then that query cannot be used with BI Beans 9.0.2.

■ In an Oracle9i (9.2.0.3) database, if you query for dimension members that have a 
sibling relationship, then you might encounter error number BIB-9509. To avoid 
this error, set the following parameter in the database's init.ora file:
_multi_join_key_table_lookup=false.

Note: BI Beans release 10g (9.0.4) is certified with J2SE 1.4.1. There 
are issues with this configuration in the areas of keyboard and 
mouse navigation and of dialog focus, as well as other minor 
issues, which will be addressed in a later release.
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6.2.3 Presentations
■ Because of Sun J2SE 1.4 regression bug 4749538, pie graphs and other graphs with 

circular components may not render optimally. You can resolve this issue by using 
graphic anti-aliasing on the graph and removing 3D effect, if it has been applied.

■ To ensure that HTML presentations work as expected when they are placed in 
frames, you must configure the EventTarget of the BIConstants.PAGE_
EVENT of the FindMember bean to target the frame that contains the presentation. 
For example, if the presentation frame is named pres_frame, then you would 
add code such as the following to the FindMember JSP page:

<%@ page import="oracle.dss.thin.beans.BIConstants"%>
<%@ page import="oracle.dss.thin.beans.EventTargetImpl"%>
<%@ page import="oracle.dss.thin.beans.dataView.FindMember"%>
...
/orabi:BIThinSession>
<% 
FindMember f = (FindMember)pageContext.findAttribute("findMember");
EventTargetImpl target=(EventTargetImpl)f.getEventTarget(BIConstants.PAGE_
EVENT);
target.setTargetFrame("pres_frame");
%>

■ If a number format includes a locale-based ISO currency symbol, then that symbol 
will not be saved. When you load the presentation, the standard locale-based 
symbol (such as "$") will be displayed instead.

6.2.4 BI Beans Catalog
■ Previous releases of the BI Beans Catalog did not save presentations or selections 

that have long dimension names. If you encounter this problem, then you can 
install the 9.0.3.2 (or higher) release of the Catalog to correct it. Alternatively, if 
you want to continue using an earlier version of the Catalog, then you can use the 
following workaround. Copy the SQL*Plus commands that are provided below 
into a script named bi_fixcolumnwidth.sql. You can then call this script with 
the @bi_fixcolumnwidth command:

alter table bism_objects modify comp_subtype1 varchar2(256);
alter table bism_objects modify comp_subtype2 varchar2(512);
alter table bism_objects modify comp_subtype3 varchar2(1333);
drop type bism_objects_table_t;
drop type bism_objects_table_new_t;
create or replace type bism_objects_obj_t as object
(
USER_VISIBLE varchar2(1),
OBJECT_TYPE_ID number(5),
VERSION number(6),
TIME_DATE_CREATED date,
TIME_DATE_MODIFIED date,
OBJECT_ID raw(16),
CONTAINER_ID raw(16),
FOLDER_ID raw(16),
CREATED_BY raw(16),
LAST_MODIFIED_BY raw(16),
OBJECT_NAME varchar2(1333),
TITLE varchar2(128),
APPLICATION varchar2(256),
DATABASE varchar2(256),
DESCRIPTION varchar2(1333),
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KEYWORDS varchar2(1333),
XML clob,
APPLICATION_SUBTYPE1 varchar2(32) ,
COMP_SUBTYPE1 varchar2(256),
COMP_SUBTYPE2 varchar2(512) ,
COMP_SUBTYPE3 varchar2(1333)
);
/
create or replace type bism_objects_obj_new_t as object
(
USER_VISIBLE varchar2(1),
OBJECT_TYPE_ID number(5),
VERSION number(6),
TIME_DATE_CREATED date,
TIME_DATE_MODIFIED date,
OBJECT_ID raw(16),
CONTAINER_ID raw(16),
FOLDER_ID raw(16),
CREATED_BY VARCHAR2(64),
LAST_MODIFIED_BY VARCHAR2(64),
OBJECT_NAME varchar2(1333),
TITLE varchar2(128),
APPLICATION varchar2(256),
DATABASE varchar2(256),
DESCRIPTION varchar2(1333),
KEYWORDS varchar2(1333),
XML clob,
APPLICATION_SUBTYPE1 varchar2(32) ,
COMP_SUBTYPE1 varchar2(256),
COMP_SUBTYPE2 varchar2(512) ,
COMP_SUBTYPE3 varchar2(1333)
);
/
create or replace type bism_objects_table_t as table of bism_objects_obj_t;
/
create or replace type bism_objects_table_new_t as table of bism_objects
obj_new_t;
/

■ When you use JDeveloper to copy objects to the BI Beans Catalog, you specify the 
Catalog User in the first page of the Copy Objects to Remote Catalog wizard. This 
user must have WRITE (or higher) access to the root folder of the runtime Catalog.

■ The following characters are not allowed in object names: \ / : * ? < > |.

■ If you encounter performance issues on a WAN during the copying of objects to 
and from the BI Beans Catalog, then Oracle recommends that you use the Oracle9i 
OCI drivers instead of the thin JDBC drivers, as described in Section 6.4.1, "JDBC 
Drivers".

■ You must ensure that the Oracle database is compatible with the character set that 
is being used for the names of objects that are being saved and restored to the BI 
Beans Catalog. That is, the database character set must be the same as or a 
superset of the Catalog character set.
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■ If a folder in the BI Beans Catalog contains an OLAP Catalog object (that is, a 
metadata object from the OLAP Catalog), then if you save a BI Beans object with 
the same name into that same folder, you create a naming conflict. Although the 
new object is saved, when you run the application, you will not see the 
newly-saved object in the BI Beans Explorer and it will not be loaded. You must 
either rename the object or remove it from the appropriate BI Beans Catalog (that 
is, local or remote).

■ You should use the BI Beans Explorer for file operations in the local file-based 
Catalog, rather than using your operating system's methods for performing such 
operations. Each BI Designer has its own local Catalog. To run the BI Beans 
Explorer to show the local Catalog for one BI Designer, follow these steps:

1. Open a command prompt and navigate to oracle_home/bibeans/bin.

2. Enter bi_explorer.bat (on Windows) or bi_explorer.csh (Linux, 
Solaris, and HP-UX). BI Beans Explorer starts.

3. In BI Beans Explorer, from the File menu, choose Connect. The Connect to 
Catalog dialog appears.

4. Select Choose. The Choose Catalog wizard starts.

5. In the first wizard page, specify File as the Catalog Type, then choose Next.

6. In the second page, specify the root directory. To locate the correct directory to 
enter, start JDeveloper. In your current project, right-click the BI Designer that 
contains the local file-based Catalog, and choose Settings. Click the Design 
Settings tab. The root directory is the path that is specified in the Directory 
field.

7. Choose Finish to return to the Connect to Catalog dialog.

8. Specify a name in the Username field. This is the name that will appear in the 
Last modified by field in BI Beans Explorer.

9. Choose OK. The local catalog appears. You can use BI Beans Explorer to 
manipulate objects in this catalog.

6.2.5 General deployment issues
In HTML-client applications, requirements for image generation on Linux, Solaris, and 
HP-UX differ depending on which JDK you use, as follows:

■ JDK 1.3 -- X server must be running on the middle tier. One option is to use X 
Virtual Frame Buffer (XVFB), which can run in "headless" environments -- that is, 
on computers that lack frame buffer hardware. You can download XVFB for Sun 
Solaris from Oracle Technology Network 
(http://otn.oracle.com/products/ias/ias_utilities.html). XVFB 
for other platforms must be downloaded from the platform vendor's Web site.

■ J2SE 1.4 -- X server is not required. However, you must add the following Java 
Option -Djava.awt.headless=true, as described in the Help topic 
"Requirements for the Deployment Environment."

■ You can deploy BI Beans applications to BEA WebLogic Server. For details, see 
Deploying Applications to BEA WebLogic Server, which is available from the BI Beans 
product area on Oracle Technology Network 
(http://otn.oracle.com/products/bib/)
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6.2.6 Configuration steps for deploying HTML-client applications

6.2.6.1 Deploying to OC4J
You must ensure that you are using the correct JDBC files, as follows:

■ OC4J in Oracle Application Server (9.0.3 or 10g) -- You cannot deploy a BI Beans 
application to the OC4J instance that is part of Oracle Application Server 10g 
without first configuring it as described in the technical note Setting Up a Separate 
OC4J Instance for a BI Beans Application, which is available from the BI Beans 
product area on Oracle Technology Network 
(http://otn.oracle.com/products/bib/). There are two versions of this 
technical note. Refer to the one that is appropriate for your platform.

■ OC4J that was downloaded from Oracle Technology Network -- If you are 
deploying to a standalone OC4J instance that you downloaded from Oracle 
Technology Network, then you must reconfigure OC4J as follows:

1. Stop OC4J.

2. Rename oc4j_home/jdbc/lib to oc4j_home/jdbc/lib.old.

3. Create a new directory named oc4j_home/jdbc/lib.

4. Copy the files classes12.jar, classes12dms.jar, and nls_
charset12.jar from the oracle_home/bibeans/jdbc/lib_92 
directory to the new directory that you created in the previous step.

5. You can now start OC4J and deploy and run a BI Beans application.

6.2.6.2 Migrating Applications Deployed to OC4J
If you have an Oracle BI Beans 9.0.3 application that you want to deploy to OC4J 10g 
(9.0.4), then you must perform the following steps:

1. Copy the BITags.tld file from the public_html/webapp directory to the 
public_html/WEB-INF directory.

2. Open web.xml and change the value of the <taglib-location> element to the 
new location of BITags.tld. For example:

<taglib>
  <taglib-uri>http://xmlns.oracle.com/bibeans/</taglib-uri>
  <taglib-location>/WEB-INF/BITags.tld</taglib-location>
</taglib>

Note: If you use Oracle9i JDeveloper (9.0.4) to insert a new tag 
into the existing 9.0.3 Oracle BI Beans application, then the 
preceding changes happen automatically.
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6.2.6.3 Deploying to Tomcat
Before you package a BI Beans application for deployment to Tomcat, you must edit 
the application's web.xml file to add a leading forward slash (/) to the url-pattern 
element. The following example shows the servlet-mapping element in the 
application's web.xml file. The forward slash (shown with emphasis) has been added 
to the url-pattern:

<servlet-mapping>
   <servlet-name>webapp</servlet-name>
   <url-pattern>/webapp</url-pattern>
</servlet-mapping>

6.2.6.4 Deploying to JBoss
Before you package a BI Beans application for deployment to JBoss, you must edit the 
application's application.xml file to add a leading forward slash (/) to the 
context-root element. The following example shows the web element in the 
application's application.xml file, which is packaged in the generated EAR file. 
The forward slash (shown with emphasis) has been added to the context-root:

<web>
   <web-uri>uixappz.war</web-uri>
   <context-root>/uixapp</context-root>
</web>

6.2.7 Deploying to Java Web Start
Java applet deployments are not supported for this release. However, you can use Java 
Web Start to deploy a BI Beans Java-client application, as shown in the following 
outline. References apply to version 1.4.2; check the Sun Web site for updates. You can 
access documentation for version 1.4.2 from 
http://java.sun.com/products/javawebstart/developers.html.

1. Configure your Web server for Java Web Start, as described in the Java Web Start 
Developer's Guide (http://java.sun.com/j2se/1.4.2/docs/guide/jws/
developersguide/contents.html).

2. Use JDeveloper to deploy the Java-client application, as usual. In the deployment 
profile, you must:

■ Deploy the application as a JAR file.

■ Include the following libraries: BIBEANS Runtime, BC4J Runtime, OLAP API 
92, and Oracle JDBC 92.

3. You must sign the application JAR file. For more information, see (for Solaris) 
http://java.sun.com/j2se/1.4.2/docs/tooldocs/solaris/
jarsigner.html or (for Windows) 
http://java.sun.com/j2se/1.4.1/docs/tooldocs/windows/
jarsigner.html.

4. Generate the JNLP file (the configuration file for Java Web Start) for the 
application, then set all permissions for the <security> element.

Note: To deploy to Java Web Start successfully, you must compile 
the application using Sun's JDK.
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5. Still in the JNLP file, set <j2se version> to 1.3. For example: 

<resources> <j2se version="1.3"/> <jar .../> </resources>

Note: This step is necessary to work around a bug in Java Web Start with J2SE 1.4. 
If you must use J2SE 1.4, then you must use JDK version 1.4.2 or higher, which 
fixes this bug.

6. Copy the signed JAR file and the JNLP file to your Web server.

7. Create an HTML page that opens the JNLP file.

6.2.8 Internationalization issues
■ The default character set for exporting data is UTF-8. To use a different character 

set, you must specify the export character encoding, as follows:

■ Generated JSP application -- Set export encoding using the 
setExportCharacterEncoding method in the BIThinSession tag on the 
export page. For example:

<orabi:BIThinSession id="BIThinSession1"
configuration="/Project1BIConfig1.xml"> 
<orabi:Presentation id="untitled1_Presentation1"
location="Presentation1"/>
<orabi:DialogLink id="untitled1_DialogLink1"
presentationId="untitled1_Presentation1"
targetPage="untitled2.jsp" targetToolId="untitled2_ExportOptions1"
text="Export" />
<% untitled1_Presentation1.setExportCharacterEncoding("SJIS"); %>
</orabi:BIThinSession>

■ Generated uiXML application -- Modify the biuixappn.java file, where n is 
a unique number in the JDeveloper project, by setting 
dataview.setExportCharacterEncoding in the
Analyze_preRendering() method. For example: 
dataview.setExportCharacterEncoding("SJIS")

■ Generated servlet application -- Include the exportCharacterEncoding 
parameter in the web.xml file on the project node. Use the IANA encoding 
name, such as Shift-JIS. For example: 
exportCharacterEncoding=Shift-JIS

■ When you run a JSP, if the value of the charset attribute in the JSP encoding does 
not match the value in the BIThinSession tag, then an error is generated. You can 
work around this problem either by ensuring that the values match or by 
removing the charset value from the BIThinSession.

■ Due to a bug in the OLAP option of Oracle9i Release 2 (9.2.0.4), if the character set 
of the Oracle database is a multibyte character set, then an exception occurs when 
you attempt to access data. If your schema requires a multibyte character set, then 
contact Oracle Support for information about the availability of a patch to correct 
this problem.
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6.2.9 Accessibility limitations
■ The current version of the JAWS screen reader does not identify and read tables in 

Java applications. This problem occurs in the JDeveloper Help system, which 
incorporates the BI Beans Help system. You can access both the standalone BI 
Beans Help system and the integrated JDeveloper Help system from Oracle 
Technology Network, where they are published in a format that allows tables to be 
read correctly by JAWS.

■ Other accessibility issues include the following:

■ Keyboard access does not work in the Hidden Items panel of the 
QueryBuilder.

■ If you are using J2SE 1.4.1, then you cannot access toolbar buttons with the 
keyboard.

■ In some cases, the Esc key does not dismiss the panel.

■ For combo boxes in which you choose a line thickness, JAWS reads the label 
incorrectly. Instead of reading "Line Thickness combo box <number of pixels>," 
JAWS reads "Line Width combo box <number of pixels>."

■ JAWS does not read the description for some of the panels in the OLAP 
Connection wizard.

■ If you are using J2SE 1.4.1, then shortcut keys do not work correctly in the 
New Presentation wizard.

■ In all graph axis UI panels, pressing the Tab key does not move the focus 
correctly.

6.3 Platform-specific Issues and Workarounds
There are no known platform-specific issues.

6.4 Configuration Issues and Workarounds

6.4.1 JDBC Drivers

6.4.1.1 Upgrading the drivers automatically
BI Beans requires the Oracle9i Release 2 JDBC drivers, which ship with BI Beans. 
However, because JDeveloper ships with the Release 1 drivers, you cannot perform 
any BI Beans-related action until you have run the upgrade program, which you are 
prompted to do whenever you attempt to access a BI Beans designtime wizard or to 
open an object from a BI Designer.

Note: Because the location of the JDBC JAR files has changed in BI 
Beans 10g (9.0.4), you must upgrade even if you did so in release 
9.0.3.
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The upgrade program performs these steps:

■ It copies the Release 2 JDBC JAR files from the oracle_
home/bibeans/jdbc/lib_92 directory to the oracle_
home/jdev/lib/patches directory. This change affects the entire JDeveloper 
environment.

■ The Project Settings are handled automatically for projects to which you add BI 
Beans objects.

These automatic steps ensure that you have the right drivers and the right designtime 
settings for any new BI Beans projects that you might create and for any existing 
projects to which you have made additions.

6.4.1.2 Upgrading the drivers manually
If you have projects that are not upgraded automatically, then follow these steps to run 
and deploy them:

■ To run -- Before you run the application, edit its Project Settings, as follows. For 
step-by-step instructions, see the Oracle Developer Suite 10g Installation Guide.

■ For Linux, Solaris, and HP-UX platforms, add -Djava.ext.dirs=oracle_
home/jdev/lib/patches to the Java Options, replacing oracle_home 
with the full path. For Windows, add oracle_home\jdev\
lib\patches. This setting is critical for HTML-client applications, less so for 
Java-client applications.

■ Substitute Oracle JDBC 92 for Oracle JDBC in the Selected Libraries list.

■ To deploy -- Before you create a deployment profile in JDeveloper, do one of the 
following:

■ For HTML-client applications, consult the technical note Setting Up a Separate 
OC4J Instance for a BI Beans Application, which is available from the BI Beans 
product area on Oracle Technology Network 
(http://otn.oracle.com/docs/products/bib/). There are two 
versions of this technical note. Refer to the one that is appropriate for your 
platform. 

■ For Java-client applications, if you already edited the Projects Settings to 
substitute Oracle JDBC 92 for Oracle JDBC, then no additional changes are 
needed. If not, then edit the Project Settings, as described above.

6.4.1.3 Restoring the original drivers
To restore the original drivers, follow these steps:

1. Delete classes12.jar, classes12dms.jar, and nls_charset12.jar from 
the oracle_home/jdev/lib/patches directory.

2. Remove the Java Option -Djava.ext.dirs.

3. Remove Oracle JDBC 92 from the selected libraries list and replace it with Oracle 
JDBC.
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6.4.2 Changing from the thin to the thick drivers
If you want an application to use the Oracle JDBC Thick (OCI) driver rather than the 
default Oracle JDBC Thin (Pure Java) driver, and you are using the default pluggable 
connection drivers that ship with BI Beans, then you must edit the application 
configuration file. You can do this in either of two ways, as follows:

■ By editing the file in JDeveloper, where the configuration file was generated by 
the BI Designer -- Right-click the BI Designer and choose Settings. Select the Run 
Settings tab, then choose either New or Edit for the connection that you want to 
change and follow the wizard that appears. The driver type is part of the 
connection definition. You can specify a connection for either or both the BI Beans 
Catalog and Data Source.

■ By editing the file by hand -- Open the file, which you will find in the src 
directory under the project directory. Its filename will be project_
namebiconfig#.xml, where # is the unique number in the JDeveloper project. 
Locate the <PersistenceConnection> element (for the BI Beans Catalog 
connection) and the <OLAPConnection> element (for the data connection). For 
either or both, change the value of JdbcDriverType to "oci8".

6.4.3 BI Beans configuration diagnostic utility
BI Beans includes a utility that examines and reports on the configuration of your 
client environment. The purpose of the configuration diagnostic utility is to gather 
information about your configuration in order to diagnose problems. It displays 
information such as the release numbers for BI Beans, JDeveloper, and the Oracle 
database, and it runs diagnostic tests against the OLAP Catalog metadata. For 
additional information, see oracle_home/bibeans/bin/
bi_checkconfig.html. 

Note that you must upgrade to the new version of the JDBC drivers before you run the 
utility.  For instructions on how to do this, see Section 6.4.1, "JDBC Drivers". For 
additional information, consult the technical note that describes the utility and is 
installed with it: oracle_home/bibeans/bin/bi_checkconfig.html.

6.4.4 Connections
■ Because of an OLAP bug, the executeCommand method of the Connection 

object might not work in BI Beans applications that connect to 64-bit Linux, 
Solaris, or HP-UX server instances. If you encounter this problem, then you can 
use the DBMS_AW PL/SQL package through a JDBC connection.

■ Because of changes in J2SE 1.4, the getCause method of the BIException class 
and its subclasses was renamed to getBIRootCause in BI Beans release 9.0.3.

6.5 Administration Issues and Workarounds
There are no known administration issues.
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6.6 Documentation Errata
There are no known documentation errors.
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7
Oracle Discoverer Administrator

This chapter discusses issues and workarounds for Oracle Discoverer Administrator 
(Discoverer Administrator).   The chapter includes the following topics:

■ Section 7.1, "General Issues and Workarounds"

■ Section 7.2, "Platform-specific Issues and Workarounds"

■ Section 7.3, "Configuration Issues and Workarounds"

■ Section 7.4, "Administration Issues and Workarounds"

■ Section 7.5, "Useful Information"

■ Section 7.6, "Documentation Errata"

7.1 General Issues and Workarounds
This section describes general issues and their workarounds for Oracle Discoverer 
Administrator.

7.1.1 "Cannot find a required file : dcmresus.msb.” When Trying to Launch Oracle 
Discoverer 9.0.2 after Installing 9.0.4

If you install Oracle Discoverer Administrator 9.0.4 on the same computer as 
Discoverer Administrator 9.0.2, the following error message will be displayed if you 
attempt to start Discoverer Administrator 9.0.2 from the Windows Start menu:

Cannot find a required file : dcmresus.msb.

The message is displayed because of a problem loading certain libraries on a computer 
with multiple Oracle homes. The same message will also be displayed if you attempt 
to start Discoverer Administrator 9.0.2 by double-clicking on dis51adm.exe in 
Windows Explorer.

To work around this problem, do one of the following:

■ Workaround 1: Run Discoverer Administrator 9.0.2 from the Windows command 
line, as follows:

1. From the Windows Start menu, choose Command Prompt to display the 
Command Prompt window.

2. Enter the following at the command prompt:

902_oracle_home\discoverer902\bin\dis51adm.exe

where 902_oracle_home is the directory in which Discoverer Administrator 
9.0.2 was installed.
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■ Workaround 2: Run Discoverer Administrator 9.0.2 from a batch file, as follows:

1. Open a new file in a text editor (for example, Notepad).

2. Enter the following in the new text file:

dis51adm.exe

3. Save the file in the directory 902_oracle_home\discoverer902\bin, and 
give the file a .bat suffix (for example, startdiscoadmin902.bat).

4. To start Discoverer Administrator 9.0.2, you can do either or both of the 
following:

– Double click the new .bat file in Windows Explorer.

– Replace the existing shortcut to Discoverer Administrator 9.0.2 in the 
Programs menu with a shortcut to the new .bat file.

7.1.2 ORA-3113 Errors when Using Heterogeneous Data Services with Oracle 
Discoverer Administrator

If you are accessing data from a non-Oracle data source using Discoverer 
Administrator (for example to create a business area) and ORA-3113 errors are 
displayed, do one of the following:

■ Use a more recent version of the Oracle database (version 9.0.1.4 or later).

■ Contact Oracle Support to determine the availability of patches for earlier versions 
of the Oracle database.

7.1.3 JOB_QUEUE_INTERVAL Settings and Oracle Applications Users
The Oracle Discoverer Administrator Administration Guide recommends setting the JOB_
QUEUE_INTERVAL parameter to 600. However, 600 is only suitable if you are not 
using Discoverer with Oracle Applications. If you are using Discoverer with Oracle 
Applications, keep the JOB_QUEUE_INTERVAL parameter set to the default value of 
90.

7.1.4 Recommended Update for Batch Repository Created with Oracle Discoverer 9.0.2
The BATCHUSR.SQL script (located in oracle_home\discoverer\sql) creates a 
schema in which to store the results of scheduled workbooks (referred to as the batch 
repository user in earlier versions of Discoverer).

The BATCHUSR.SQL script (located in oracle_home\discoverer\sql) has 
changed between Discoverer 9.0.2 and 9.0.4.

The updated BATCHUSR.SQL script provides two benefits:

■ The script tightens the database security surrounding the creation and 
management of the scheduled workbook results schema. The script simply 
removes certain privileges that were found to be unnecessary.

Note: The above workarounds assume that you have already used 
the Oracle Home Selector (typically required for any computer with 
multiple Oracle homes).
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■ The script increases the size limit for the SQL statement used by scheduled 
workbooks from 32KB to 64KB. The increased size limit reflects the increased limit 
supported by the Oracle database. The increase specifically benefits users who 
receive the error message "Exceeded Maximum query size" when scheduling a 
workbook.

The above updates are non-destructive and do not affect any currently scheduled 
workbooks.

Oracle recommends that all customers using an EUL created with Discoverer 9.0.2 
apply these fixes. Simply connect to the database as a database administrator (for 
example, SYSTEM) and run the BATCHUSR.SQL script.

No action is required for customers using an EUL created with Discoverer 9.0.4, 
because you will use the updated BATCHUSR.SQL script when you create the 
scheduled workbook results schema.

7.2 Platform-specific Issues and Workarounds
There are currently no known platform-specific issues.

7.3 Configuration Issues and Workarounds
There are currently no known configuration issues.

7.4 Administration Issues and Workarounds
There are currently no known administration issues.

7.5 Useful Information
This section describes useful information for Oracle Discoverer Administrator.

7.5.1 Upgrading from Oracle Discoverer 3.1
If you are upgrading from Oracle Discoverer 3.1, the Oracle Discoverer Administrator 
Administration Guide documents the requirement to upgrade the EUL to Discoverer 4.1 
as an intermediate step.

For the purposes of this upgrade, if you are not already in possession of Oracle 
Discoverer Administration Edition 4.1, it will be made available on the Oracle 
Technology Network (http://otn.oracle.com).

7.5.2 Manually Editing the End User Layer Tables
Do NOT manually edit the End User Layer (EUL) tables or their contents (for example 
by using SQL*Plus), unless specifically directed to do so by Oracle Support or 
Development. Manual editing of the EUL tables is not supported and any manual 
changes can result in a corrupt EUL.
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7.5.3 Availability of HWOnline files
Previous versions of Oracle Discoverer shipped with the files HWOnline.htm and 
Memo.doc, which were used to demonstrate "drill out" functionality. To reduce disk 
space requirements and installation time, these files and instructions for their use will 
be made available from the Oracle Technology Network 
(http://otn.oracle.com).

7.5.4 Setting Oracle Discoverer Registry Variables for Use by Oracle Discoverer EUL 
Command Line for Java Commands

When using some of the commands provided by the Oracle Discoverer EUL 
Command Line for Java, you might want to explicitly set certain Discoverer registry 
variables, as shown below:

On Windows platforms, Discoverer registry variables are stored in the Windows 
Registry. On Linux, Solaris, and HP-UX platforms, Discoverer registry variables are 
stored in the .reg_key.dc file.

To set these Discoverer registry variables, do one of the following:

■ For Windows only: Specify values for registry variables as required by editing the 
Windows Registry using regedit or regedt32.

■ For Windows, Linux, Solaris, and HP-UX: Specify values for registry variables as 
required by entering the following at a command prompt:

dis51pr -setadminpref registry_variable_name value

For more information about Discoverer registry variables (including descriptions, 
default values and allowable values), see: 

■ Oracle Discoverer Administrator Administration Guide

■ Oracle Application Server Discoverer Configuration Guide

Command Discoverer Registry Variable

-export ■ ArchiveCacheFlushInterval

■ FormatXML
ExportJoinFromMaster

refresh_object ■ DefaultPreserveDisplayPropertyForRefresh

■ EnableTriggers

-import ■ FormatXML

-connect -apps_user ■ AppsFNDNAM

■ AppsGWYUID

-load ■ SetNULLItemHeadingOnBulkLoad

■ MaxNumberJoinPredicates

all commands ■ SqlTrace
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7.5.5 Additional Oracle Discoverer Registry Variables
The following Discoverer registry variables are available, in addition to those 
documented in the Oracle Discoverer Administrator Administration Guide and the Oracle 
Application Server Discoverer Configuration Guide:

7.5.6 Required Privileges For the Scheduled Workbook Results Schema

7.5.6.1 How to grant the SELECT privilege on the synonym v$parameter to enable 
you to run scheduled workbooks
To run scheduled workbooks, the scheduled workbook results schema requires 
SELECT privilege on the synonym v$parameter. SELECT privilege on the synonym 
v$parameter is gained by having SELECT privilege on the underlying view v_
$parameter.

Category
Discoverer 
registry variable Description Default Valid Values

Database DefaultPreserve
DisplayProperty
ForRefresh

When refreshing, 
specifies whether an 
updated item 
description is 
discarded and replaced 
with the original 
description, or whether 
the updated 
description is retained

0 ■ 0 = Use 
updated 
description

■ 1 = Use 
original 
description

Database EnableTriggers Specifies whether 
database triggers are 
disabled.

For example, 
Discoverer attempts to 
make a database call 
for every new column 
found during a refresh. 
If this value is set to 0, 
Discoverer will not 
make the database call.

0 ■ 0 = Disable 
database 
triggers

■ 1 = Enable 
database 
triggers

Database ExportJoinFrom
Master

When exporting a 
business area, specifies 
whether joins from the 
master folder are also 
exported.

0 ■ 0 = Do export 
joins from 
Master Folder

■ Any value 
other than 0 = 
Do not export 
joins from the 
Master Folder

Database SetNULLItem
HeadingOnBulk
Load

When performing a 
bulk load, specifies 
whether item headings 
are set to the same 
value as item display 
names, or set to null.

0 ■ 0 = Set item 
headings to 
item display 
names

■ 1 = Set item 
headings to 
null
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However, the v_$parameter view does not have public access and is owned by the SYS 
user. Therefore, to grant SELECT privilege on v_$parameter (and, by extension, on the 
v$parameter synonym) to the scheduled workbook results schema, you must log in as 
the SYS user and explicitly grant the privilege.

For more information about the scheduled workbook results schema, see the section 
"How to specify the owner of the tables containing scheduled workbooks results" in 
chapter 7 of the Oracle Discoverer Administrator Administration Guide.

How you grant the SELECT privilege on v_$parameter will depend on the version of 
the Oracle database that you are using, as follows:

■ If you using an Oracle9i database:

1. Start SQL*Plus (if it is not already running) and connect as the SYS user (or as 
a user to which the SYSDBA privilege has been granted).

For example, if SQL*Plus is already running, you might type the following at 
the command prompt:

SQL> CONNECT SYS/sys_pw@database AS SYSDBA;

where sys_pw is the password of the SYS user. If you are unable to login as the 
SYS user or are unsure about the SYS password, see your database 
administrator.

2. Type the following at the command prompt:

SQL> grant SELECT on v_$parameter to user;

where user is the name of the scheduled workbook results schema.

■ If you are using a version of the Oracle database earlier than Oracle9i:

1. On the database server computer, start the DBA facility and login as the SYS 
user (for example, on a Windows computer, choose Run... from the Windows 
Start menu and enter SVRMGRL).

2. In the DBA facility, enter connect internal.

3. Enter the following at the command prompt:

SQL> grant SELECT on v_$parameter to user;

where user is the name of the scheduled workbook results schema.

To verify that the scheduled workbook results schema has been granted SELECT 
privilege on v_$parameter:

1. Start SQL*Plus (if it is not already running) and connect as the scheduled 
workbook results schema.

For example, if SQL*Plus is already running, you might type the following at the 
command prompt:

SQL> CONNECT user/user_pw@database;

where user is the user name of the scheduled workbook results schema and user_
pw is the password of the scheduled workbook results schema.
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2. Type the following at the command prompt:

SQL> select count (*) from v$parameter;

If SELECT privilege on the v_$parameter view has been successfully granted to 
the scheduled workbook results schema, SQL*Plus displays the number of rows 
from the v$parameter synonym.

If SELECT privilege on the v_$parameter view has not been successfully granted 
to the scheduled workbook results schema, SQL*Plus displays the message:

ORA - 01031 Insufficient privileges

7.5.7 Running the Oracle Discoverer EUL Command Line for Java (Linux, Solaris, and 
HP-UX only)

To run the Oracle Discoverer EUL Command Line for Java on Linux, Solaris, or 
HP-UX, a number of environment variables must be set correctly. You can either set 
the environment variables explicitly using the discwb.sh script or implicitly using 
the eulapi script, as described below:

■ to explicitly set the environment variables before issuing Discoverer EUL 
Command Line for Java commands, enter the following at the command line 
prompt from which you will be issuing those commands:

oracle_home_path/discoverer/discwb.sh

Subsequently, you can enter Discoverer EUL Command Line for Java commands 
as follows:

java -jar oracle_home_path/discoverer/lib/eulbuilder.jar 
-command_list

For example, to refresh a folder called "Sales1", you might enter the following:

java -jar oracle_home_path/discoverer/lib/eulbuilder.jar 
-connect jchan/12345@my_database -refresh_folder Sales1

■ to implicitly set the environment variables when you run Discoverer EUL 
Command Line for Java commands, use the eulapi script in the directory 
oracle_home_path/bin to run commands. For example, to refresh a folder 
called "Sales1", you might enter the following:

oracle_home_path/bin/eulapi -connect 
jchan/12345@my_database -refresh_folder Sales1

Hint: To avoid entering oracle_home_path/bin each time you run the eulapi 
script, run discwb.sh first.
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7.5.8 Oracle Discoverer and Real Application Clusters (RAC)/Transparent Application 
Failover (TAF)

Oracle Discoverer's support for Transparent Application Failover (TAF) on a Real 
Application Cluster (RAC) computer requires a failover mode of "select", as shown in 
the example tnsnames.ora entry below:

NAME =
   (DESCRIPTION=
       (ADDRESS=
           (PROTOCOL=tcp)
           (HOST=servername)
           (PORT=1521))
       (CONNECT_DATA=
       (SERVICE_NAME= NAME)
       (FAILOVER_MODE=
               (TYPE=select)
               (METHOD=basic)
               (RETRIES=4)
               (DELAY=15))))

Oracle Corporation recommends that you should initially set RETRIES and DELAY to 
the values given in the example above (that is, 4 and 15 respectively). However, you 
may need to increase these values for your own computer.

In certain rare scenarios, end users may see an error message if failover occurs. When 
they acknowledge the error message, their sessions will continue as normal. A fix for 
these scenarios is planned for release as a patch to the 9.0.4 release.

7.6 Documentation Errata
This section describes known errors in the documentation.

7.6.1 Item Class Wizard: Choose Attributes dialog description
The "Notes" section in the Item Class Wizard: Choose Attributes dialog description on 
page 24-78 of the Oracle Discoverer Administrator Administration Guide should contain 
an extra bullet point as shown below:

■ A one-to-one relationship must exist between the item used for the list of values 
and the item used for the sort order

7.6.2 Correction to /export (EUL Objects) Example
The example provided for the /export (EUL Objects) command on page 21-20 of the 
Oracle Discoverer Administrator Administration Guide should read as follows:

To export two business areas named "Test BA" and "Final BA", residing in an EUL 
named "eul_sales", into a file named export.eex, and write to a log file named 
export.log, enter:

dis51adm.exe /connect me/mypassword /export export.eex 
/business_area "Test BA" /business_area "Final BA" /all /eul 
eul_sales /log export.log
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7.6.3 Missing ‘-jar’ in Example Syntax given for Running Oracle Discoverer EUL 
Command Line for Java commands

The examples in sections 1.7 and 1.9 of the Oracle Discoverer EUL Command Line for Java 
User’s Guide are missing the "-jar" part of the command line syntax. When running the 
command line for Java, use the following syntax:

java –jar eulbuilder.jar -command list

7.6.4 About Scheduled Workbooks and Compatibility Between the Current Version of 
Oracle Discoverer and Previous Releases

The section "About scheduled workbooks and compatibility between the current 
version of Discoverer and previous releases" on page 7-15 of the Oracle Discoverer 
Administrator Administration Guide contains the following statement:

In this case you must install the new version of the batch PL/SQL package (EUL5_
BATCH_USER) using the SQL script batchusr.sql.

The above statement should read:

In this case you must install the new version of the batch PL/SQL package (EUL5_
BATCH_REPOSITORY) using the SQL script batchusr.sql.

7.6.5 <ORACLE_HOME>\discoverer\util should read <ORACLE_HOME>\discoverer\sql
All references in the Oracle Discoverer Administrator Administration Guide and the Oracle 
Discoverer Administrator Tutorial to files located in the 
<ORACLE_HOME>\discoverer\util directory should instead specify the 
<ORACLE_HOME>\discoverer\sql directory.

For example, the path <ORACLE_HOME>\discoverer\util\eul5_id.sql should 
read <ORACLE_HOME>\discoverer\sql\eul5_id.sql. 
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8
Oracle Discoverer Desktop

This chapter discusses issues and workarounds for Oracle Discoverer Desktop 
(Discoverer Desktop).   The chapter includes the following topics:

■ Section 8.1, "General Issues and Workarounds"

■ Section 8.2, "Platform-specific Issues and Workarounds"

■ Section 8.3, "Configuration Issues and Workarounds"

■ Section 8.4, "Administration Issues and Workarounds"

■ Section 8.5, "Useful Information"

■ Section 8.6, "Documentation Errata"

8.1 General Issues and Workarounds
This section describes general issues and their workarounds for Oracle Discoverer 
Desktop.

8.1.1 "Cannot find a required file : dcmresus.msb." When Trying to Run Oracle 
Discoverer 9.0.2 after Installing 9.0.4

If you install Oracle Discoverer Desktop 9.0.4 on the same computer as Oracle 
Discoverer Desktop 9.0.2, the following error message will be displayed if you attempt 
to start Discoverer Desktop 9.0.2 from the Windows Start menu:

Cannot find a required file : dcmresus.msb.

The message is displayed because of a problem loading certain libraries on a computer 
with multiple Oracle homes. The same message will also be displayed if you attempt 
to start Discoverer Desktop 9.0.2 by double-clicking on dis51usr.exe in Windows 
Explorer.

To work around this problem, do one of the following:

■ Workaround 1: Run Discoverer Desktop 9.0.2 from the Windows command line, as 
follows:

1. From the Windows Start menu, choose Command Prompt to display the 
Command Prompt window.

2. Enter the following at the command prompt:

902_ORACLE_HOME\discoverer902\bin\dis51usr.exe

where 902_ORACLE_HOME is the directory in which Discoverer Desktop 
9.0.2 was installed.
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■ Workaround 2: Run Discoverer Desktop 9.0.2 from a batch file, as follows:

1. Open a new file in a text editor (for example, Notepad).

2. Enter the following in the new text file:

dis51usr.exe

3. Save the file in the directory 902_ORACLE_HOME\discoverer902\bin, and 
give the file a .bat suffix (for example, startdiscodesktop902.bat).

4. To start Discoverer Desktop 9.0.2, you can do either or both of the following:

– Double click the new .bat file in Windows Explorer.

– Replace the existing shortcut to Discoverer Desktop 9.0.2 in the Programs 
menu with a shortcut to the new .bat file.

8.2 Platform-specific Issues and Workarounds
There are currently no known platform-specific issues.

8.3 Configuration Issues and Workarounds
There are currently no known configuration issues.

8.4 Administration Issues and Workarounds
There are currently no known administration issues.

8.5 Useful Information
This section describes useful information for Oracle Discoverer Desktop.

8.5.1 Manually Editing the End User Layer Tables
Do NOT manually edit the End User Layer (EUL) tables or contents (for example, by 
using SQL*Plus), unless specifically directed to do so by Oracle Support or 
Development. Manual editing of the EUL tables is not supported and any manual 
changes can result in a corrupt EUL.

8.5.2 Refresh Query For Users Only Able to Run Scheduled Workbooks
For end users who are only able to run scheduled workbooks, note that the Refresh 
button in the Scheduling Manager dialog will not re-run the query from the base 
tables, but from the table that stores the scheduled workbook results. This is also the 
case for the "Run query automatically" option on the General tab of the Options 
dialog.

Note: The above workarounds assume the user has already used 
the Oracle Home Selector (typically required for any computer with 
multiple Oracle homes).
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8.5.3 Availability of HWOnline files
Previous versions of Oracle Discoverer shipped with the files HWOnline.htm and 
Memo.doc, which were used to demonstrate "drill out" functionality. To reduce disk 
space requirements and installation time, these files and instructions for their use will 
be made available from the Oracle Technology Network 
(http://otn.oracle.com).

8.5.4 Additional Oracle Discoverer Registry variables
The following Oracle Discoverer registry variables are available, in addition to those 
documented in the Oracle Discoverer Administrator Administration Guide and the Oracle 
Application Server Discoverer Configuration Guide:

Category
Discoverer 
registry variable Description Default Valid Values

Database DefaultPreserve
DisplayProperty
ForRefresh

When refreshing, 
specifies whether an 
updated item 
description is 
discarded and replaced 
with the original 
description, or whether 
the updated 
description is retained

0 ■ 0 = Use 
updated 
description

■ 1 = Use 
original 
description

Database EnableTriggers Specifies whether 
database triggers are 
disabled.

For example, 
Discoverer attempts to 
make a database call 
for every new column 
found during a refresh. 
If this value is set to 0, 
Discoverer will not 
make the database call.

0 ■ 0 = Disable 
database 
triggers

■ 1 = Enable 
database 
triggers

Database ExportJoinFrom
Master

When exporting a 
business area, specifies 
whether joins from the 
master folder are also 
exported.

0 ■ 0 = Do export 
joins from 
Master Folder

■ Any value 
other than 0 = 
Do not export 
joins from the 
Master Folder

Database SetNULLItem
HeadingOnBulk
Load

When performing a 
bulk load, specifies 
whether item headings 
are set to the same 
value as item display 
names, or set to null.

0 ■ 0 = Set item 
headings to 
item display 
names

■ 1 = Set item 
headings to 
null
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8.5.5 Oracle Discoverer and Real Application Clusters (RAC)/Transparent Application 
Failover (TAF)

Oracle Discoverer's support for Transparent Application Failover (TAF) on a Real 
Application Cluster (RAC) computer requires a failover mode of "select", as shown in 
the example tnsnames.ora entry below:

NAME =
   (DESCRIPTION=
       (ADDRESS=
           (PROTOCOL=tcp)
           (HOST=servername)
           (PORT=1521))
       (CONNECT_DATA=
       (SERVICE_NAME= NAME)
       (FAILOVER_MODE=
               (TYPE=select)
               (METHOD=basic)
               (RETRIES=4)
               (DELAY=15))))

Oracle Corporation recommends that you should initially set RETRIES and DELAY to 
the values given in the example above (that is, 4 and 15 respectively). However, you 
may need to increase these values for your own computer.

In certain rare scenarios, end users may see an error message if failover occurs. When 
they acknowledge the error message, their sessions will continue as normal. A fix for 
these scenarios is planned for release as a patch to the 9.0.4 release.

8.6 Documentation Errata
There are currently no known documentation issues.
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Oracle Forms Developer

This chapter contains the following Oracle Forms Developer topics:

■ Section 9.1, "General Issues and Workarounds"

■ Section 9.2, "Platform-specific Issues and Workarounds"

■ Section 9.2.1, "Windows Platform Issues and Workarounds"

■ Section 9.2.2, "Linux, Solaris, and HP-UX Platform Issues and Workarounds"

■ Section 9.3, "Configuration Issues and Workarounds"

■ Section 9.4, "Documentation Errata"

These topics include information about Oracle Forms Developer (Forms Developer), 
the Oracle Forms Builder program (Form Builder), and the entire Oracle Forms 
environment (Forms).

9.1 General Issues and Workarounds
This section contains general issues and workarounds for Oracle Forms Developer 
(Forms Developer).

9.1.1 No Need To Recompile Forms When Upgrading To Oracle Forms 10g (9.0.4)
When upgrading to Oracle Forms 10g (9.0.4) from a previous version of Oracle9i 
Forms, you do not need to recompile your Forms Applications.

9.1.2 Forms Cannot Handle Multibyte CLOB Data Correctly
(3148851 and 1480307) When running such a module and when it fetches records from 
database, FRM-40505 error will occur.

9.1.3 Embedded Fonts in Forms Developer
(2972738) Oracle Forms has several places where text is displayed, but where the 
object in question is not exposed through the Builder, or does not expose a Font 
Property.

For example:

■ Window Titles

■ Console Line

■ Cancel Query dialog
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■ LOV window Search Box

■ Field Help Dialog

It is not obvious where the font comes for these objects and in several cases (e.g. 
Console line, Help dialog) the value is hardcoded into the Forms Applet. This 
hard-coded font in the Console and Field Help Dialog is 12pt Sans Serif.

9.1.4 Iconic Push Buttons
Forms Developer allows you to create iconic push buttons. That is, an image is used 
instead of text for the push button. In Forms 6i, you could specify an "Icon Filename" 
in the property palette. According to the documentation, this filename should not 
contain the ".ico" extension. 

There is also a variable UI_ICON. This variable is not changing, and will work with all 
changes.

Oracle Forms supports image types that work on the web. In order to see these images 
at design time, there is now a new, optional, environment/registry variable UI_ICON_
EXTENSION. You can set this variable as:

■ "gif" (case insensitive): In this case, the extension that will be added to "Icon 
Filesname" is ".gif"

■ "jpg": ".jpg"

■  "ico": ".ico"

■  not set, or set incorrectly: ".ico"

9.1.5 Restriction For Data Block Wizard
(2217028) Oracle database allows you to create objects with names that start with 
invalid characters, such as numbers, if you enclose them in double-quotes, for 
example, 'create table "123" (c char)'. For these kinds of database objects, 
you should create a block or item manually instead of using the Data Block Wizard 
because the Data Block Wizard will cause ORA-00911, ORA-00931 or ORA-04043.

9.1.6 When-Mouse-Click Doesn’t Fire For Right Mouse Click
(3208500) The when-mouse-click trigger does not fire if the user clicks on an item with 
the right mouse button (Button 3 in Windows, Button 2 in Linux, Solaris, or HP-UX).

9.2 Platform-specific Issues and Workarounds

9.2.1 Windows Platform Issues and Workarounds

9.2.1.1 FRM-18113 Error When Clicking On Design Capture
(3071580) Clicking on Design Capture triggers "FRM-18113: Form Builder failed to 
Initialize the Oracle Designer as an Automation Server." This error occurs because the 
appropriate Windows registry settings do not exist.

To import the appropriate registry settings, double click <ORACLE_
HOME>\CGENF61\de9i.reg, then exit and restart Oracle Forms.
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9.2.1.2 Location of JAWS Scripts
JAWS scripts are now installed with Forms Developer. The location for these scripts is 
oracle_home/forms90/ScreenReader/, and are also available at Oracle 
Technology Network (OTN) at http://otn.oracle.com/.

9.2.1.3 Java Related Dialogs And Windows Are Not Read By Jaws
(3032246) You need to add access-bridge.jar and jaccess-1_3.jar to the CLASSPATH.

9.2.1.4 Graphics Fails Against Database 9.0.1.4.0 (64bit)
(3080826) Due to a limitation in the 8.0.6 RSF, Oracle Graphics 6i on Windows cannot 
connect to a 64-bit database. Thus, if you are using Oracle Forms 10g (9.0.4) to connect 
to a 64-bit database, and want to integrate with Oracle Graphics, you will need to 
upgrade your Oracle 6i Home (where Graphics is installed) to include an RSF version 
that contains a fix to bug 3088708. Please contact Oracle Support regarding availability 
of such an RSF.

9.2.2 Linux, Solaris, and HP-UX Platform Issues and Workarounds

9.2.2.1 General Linux, Solaris, and HP-UX Platform Issues and Workarounds

9.2.2.1.1 USER_EXIT in Linux, Solaris, and HP-UX  The USER_EXIT directory is not 
available when you install Oracle Developer Suite on Linux, Solaris, or HP-UX.

Starting with Forms 9i, the demo user exit is not shipped. However, the makefiles are 
available in oracle_home/lib.

1. You’ll have to copy the following files from the Forms 6i (oracle_
home/forms60/USEREXIT): 

■ UE.H: Header file with definitions; do not change. 

■ UE_SAMP.H: Header file with prototype of the user exit function. 

■ UE_SAMP.PC: The code of the demo user exit; you can use this as a template 
for your own user exits. 

■ UE_XTB.C: This file holds the table of user exits. 

■ Precompile and compile the user exit code as follows: 

proc ue_samp.pc 

cc -c ue_samp.c

2. Compile the file ue_xtb.c which holds the table of user exits:

cc -c us_xtb.c 

3. Relink the Forms executables with user exit:

make -f ins_forms.mk f90webmx EXITS="ue_xtb.o ue_samp.o" 

The makefile assumes that your user exit source code is in ue_samp.pc. If your 
file has a different name, you can either change the makefile (line EXITS=ue_
xtb.o ue_samp.o) or pass the file names on the command line. 



Platform-specific Issues and Workarounds

9-4 Release Notes

For example: 

make -f ins_forms.mk f90webmx EXITS="ue_xtb.o myexit.o" 

4. After creating f90webmx,you should specify a Listener Servlet initialization 
parameter in the web.xml file.

5. Create a form to test your user exit. The demo user exit adds two items, 
BLOCK1.ITEM1 and BLOCK1.ITEM2, and puts the result into BLOCK1.ITEM3. 

1. Create a form called ue_samp.fmb with a non-basetable block called BLOCK1, 
and three text items ITEM1, ITEM2 and ITEM3. 

2. Create a button with a WHEN-BUTTON-PRESSED trigger with the following 
code: 

user_exit('UE_SAMP'); 

The test form does not need a connection to the database. 

3. Create an ON_LOGON trigger on form level with the following code:

 null; 

6. Save and generate the form. 

RESTRICTIONS: The required version of the pre-compiler to use must match the 
Required Support Files (RSF) version of Forms. Pro*C 9.0.1 is bundled with Oracle 
Developer Suite 10g. 

If you encounter FRM-40800, try renaming f90webmx to f90webm.

9.2.2.2 Using TK90_UNKNOWN
(3193143) In a Linux, Solaris, or HP-UX environment, Forms Developer picks up 
Tk2Motif.rgb under $ORACLE_HOME/guicommon9/tk90/admin/<language> 
based on the language portion of your NLS_LANG environment variable by default. 
For example if your NLS_LANG is set to AMERICAN_AMERICA.JA16EUC, $ORACLE_
HOME/guicommon9/tk90/admin/Tk2Motif.rgb is picked up. However, since 
$ORACLE_HOME/guicommon9/tk90/admin/Tk2Motif.rgb is not designed for 
JA16EUC character set, you may encounter FRM-91111 or FRM-10039. 

You can specify the location of your Tk2Motif.rgb file by setting TK90_UNKNOWN 
environment variable. For instance, TK90_UNKNOWN environment variable can be set 
to $ORACLE_HOME/guicommon9/tk90/admin/JA.

9.2.3 HP-UX Issues and Workarounds
If you want to use Forms in the HP-UX Japanese environment with NLS_
LANG=JAPANESE_JAPAN.JA16SJIS, you’ll need to modify these files before using 
Forms because these files contain EUC encoded Japanese resources.

Convert this file to SJIS encoding, or remove the last 7 entries from this file. Otherwise, 
Forms may fail (FRM-91500):

■ $ORACLE_HOME/guicommon9/tk90/admin/JA/Tk2Motif.rgb

Convert these files to SJIS encoding:

■ $ORACLE_HOME/forms90/admin/resource/JA/fmrweb.res

■ $ORACLE_HOME/forms90/admin/resource/JA/fmrpcweb.res

Otherwise, the following error occurs when running Forms:

Error opening Oracle*Terminal file frmweb
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9.3 Configuration Issues and Workarounds

9.3.1 SSO Dynamic Resource Creation Fails When 904 BI-Forms Uses 902 
Infrastructure on the Same Machine

(3231685) When you install BI-Forms and Infrastructure on the same computer, URL 
rewriting doesn't work once Forms has re-directed to DAS. You’ll see "FRM-92102: A 
network error has occurred. The Forms Client has attempted to reestablish its 
connection to the Server 5 time(s) without success." This only happens if you're 
running 9.0.4 Forms against a 9.0.2 infrastructure (installed on the same machine) and 
using Internet Explorer.

This can affect SSO support in Forms. If a user tries to run Forms with SSO enabled, 
and connects using an existing Forms configuration, there is no issue.

However, when a user attempts to run Forms without providing an existing Forms 
configuration, Forms redirects to DAS to allow the user to dynamically create a 
resource for this configuration. When this happens, the resource is created properly by 
DAS but Forms fails to connect after DAS redirects back to the Forms servlet. If the 
user copies the same URL at that point and runs it in a different browser, there is no 
issue. This is a one-time issue, and if administrators have correctly created DAS 
resources, users will never experience this issue.

Similarly, if you don't have DAS (part of an Infrastructure installation) and BI-Forms 
installed on the same machine, you won't encounter this issue.

9.3.2 Forms and Reports Integration

9.3.2.1 Cannot Invoke Reports Builder from Form Builder
(2228305) To set up Oracle Forms and Oracle Reports integration in the Forms Builder, 
modify the file f90desm.sh by uncommenting the line that calls reports.sh.

9.3.2.2 Restarting OPMN In-process Reports Server Raises Error
(3148596) Perform the following to correctly setup Reports/Graphics for 
Forms/Reports/Graphics integration:

1. In the g90runm.sh script enter the following:

ORACLE_GRAPHICS6I_HOME=location_forms6i

export ORACLE_GRAPHICS6I_HOME

TK_PRINTER=real_printer

2. In the reports.sh script enter the following:

ORACLE_GRAPHICS6I_HOME=location_forms6i

export ORACLE_GRAPHICS6I_HOME

REPORTS_DEFAULT_DISPLAY=NO

export REPORTS_DEFAULT_DISPLAY

DISPLAY=machine_name:0.0; export DISPLAY
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9.3.2.3 Forms Migration Assistant: RUN_PRODUCT(Reports) rp2rro Reports Object 
Is Not Created in Object Library
(3151894) When an Oracle Forms 6i module has a RUN_PRODUCT Built-in that calls 
Reports, the Forms Migration Assistant creates 11 parameters and RP2RRO Reports 
objects after the conversion.

However, when a Forms 6i Object Library that contains the same Built-in is converted 
with the Forms Migration Assistant, then a new Object Library tab with the rp2rro 
parameters that contain all 11 parameters is created but the Reports object RP2RRO is 
not. 

9.4 Documentation Errata

9.4.1 Oracle Forms Services Deployment Guide

P60: 4.3.4.1
connectionDisallowedURL  required

Should Read:
connectionDisallowedURL  optional

P60: 4.3.4.1
HTML delimiter

Should Read:
HTMLdelimiter 

P75: 4.9.1
Registry.dat file in the forms90/java/oracle/forms/registry directory. 

Should Read:
Registry.dat file in the forms90/java/oracle/forms/registry directory.

P87: 5.3.0.2
MaxClient 

Should Read:
MaxClients

P119: 7.2.2
<ORACLE_HOME>/j2ee/OC4J_BI_FORMS/application-deployments/forms90/1_default_
island/application.log

Should Read:
<ORACLE_HOME>/j2ee/OC4J_BI_FORMS/application-deployments/forms90app/OC4J_BI_Forms_
default_island_1/application.log
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P119: 7.2.2
<ORACLE_HOME>/j2ee/OracleDS/application-deployments/forms90/application.log

Should Read:
<ORACLE_HOME>/j2ee/DevSuite/application-deployments/forms/application.log

P140: 8.4
2. In the navigator pane, select "General Configuration" | "Session Management" | 
"Session Binding".

3. In the "Session Binding Configuration" screen, select "Default Session Binding" and 
then select "Edit".

4. The "Change/Add Session Binding" dialog box appears. 

5. ... select "Administration" | "Monitoring" | "Health Monitor".

Should Read:
2. In the navigator pane, select "Origin Servers, Sites, and Load Balancing" | "Session 
Binding".

3. In the "Session Binding" screen, select "Default Session Binding" and then select 
"Edit Selected".

4. The "Edit Session Binding" dialog box appears. 

5. ... select "Monitoring" | "Health Monitor". 

P143, A.1.4.0.1
Netscape Navigator 4.7.3

Netscape Navigator 4.7.8

Should Read:
Netscape Navigator 4.7.x

Netscape Navigator 7.0.x

Page 149: 3.5.2
Internet Explorer 5.x or 6*    native VM**    baseie.htm

Internet Explorer 5.x or 6*    jinitiator      basejini.htm

Should Read:
Internet Explorer 5.x or 6*    native**        baseie.htm

Internet Explorer 5.x or 6    jinitiator      basejini.htm 

P150: B.1
jinit_classid=clsid:CAFECAFE-0013-0001-0009-ABCDEFABCDEF
# Parameter related to the version of JInitiator
jinit_exename=jinit.exe#Version=1,3,1,9
# Parameter related to the version of JInitiator
jinit_mimetype=application/x-jinit-applet;version=1.3.1.9
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Should Read:
jinit_classid=clsid:CAFECAFE-0013-0001-0013-ABCDEFABCDEF
# Parameter related to the version of JInitiator
jinit_exename=jinit.exe#Version=1,3,1,13
# Parameter related to the version of JInitiator
jinit_mimetype=application/x-jinit-applet;version=1.3.1.13 

Page153: B.2.1:
# 1/ The Forms installation process should replace all occurrences of 
# <percent>FORMS_<ORACLE_HOME><percent> with the correct <ORACLE_HOME> 
# setting, and all occurrences of <percent>O_JDK_HOME<percent> with 
# the location of the JDK (usually $<ORACLE_HOME>/jdk).

Should Read:
# 1/ The Forms installation process should replace all occurrences of
# <percent>FORMS_ORACLE_HOME<percent> with the correct ORACLE_HOME 
# setting, and all occurrences of <percent>O_JDK_HOME<percent> with
# the location of the JDK (usually $ORACLE_HOME/jdk).

Page155: B.2.2
# 1/ The Forms installation process should replace all occurrences of
# <percent>FORMS_<ORACLE_HOME><percent> with the correct <ORACLE_HOME> 
# setting, and all occurrences of <percent>O_JDK_HOME<percent> with 
# the location of the JDK (usually $<ORACLE_HOME>/jdk).

Should read:
# 1/ The Forms installation process should replace all occurrences of
# <percent>FORMS_ORACLE_HOME<percent> with the correct ORACLE_HOME 
# setting, and all occurrences of <percent>O_JDK_HOME<percent> with 
# the location of the JDK (usually $ORACLE_HOME/jdk).

P157: B.2.2 
# (/cdm/solaris/o_jdk/1_2_2_0_0/jre/lib/sparc)
# - Forms needs two paths to the jre, for libjvm.so and libhpi.so
# - In ojdk 1.3.1 the location of libjvm.so is lib/sparc (there is no

Should Read:
# (.../jre/lib/sparc)
# - Forms needs two paths to the jre, for libjvm.so and libhpi.so
# - In JDK 1.4.1 the location of libjvm.so is lib/sparc (there is no

P169: B.5
<ORACLE_HOME>/forms90/html

Should Read:
<ORACLE_HOME>/tools/web90/html 
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Oracle Reports

This chapter discusses issues and workarounds for Oracle Reports, including Oracle 
Reports Developer (Reports Developer) and Oracle Application Server Reports 
Services (Reports Services). The chapter includes the following topics:

■ Section 10.1, "General Issues and Workarounds"

■ Section 10.2, "Platform-specific Issues and Workarounds"

■ Section 10.2.1, "Windows Platform Issues and Workarounds"

■ Section 10.2.2, "Linux, Solaris, and HP-UX Platform Issues and Workarounds"

■ Section 10.3, "Configuration Issues and Workarounds"

■ Section 10.4, "Administration Issues and Workarounds"

■ Section 10.5, "Documentation Errata"

The notes in this chapter cover issues and workarounds that are not documented in 
Oracle Reports 10g manuals and online help. For information about the new features 
in this release, refer to the Oracle Reports 10g page on OTN 
(http://otn.oracle.com/products/reports/index.html), and to the 
"About this release" topic in the Reports Builder online help.

10.1 General Issues and Workarounds
This section describes general issues and workarounds for Oracle Reports.

10.1.1 Running a Simple Matrix Report to the Web
Problem

If you try to create a simple matrix report and run it to Web by using the Run to Web 
functionality, the report does not display correctly.

Workaround

To fix this issue, download and install the patch for your operating environment. The 
patches are at http://metalink.oracle.com:

■ Windows ARU number: 5147374

■ Solaris ARU number: 5147755

■ HP-UX ARU number: 5158238

Note: You can also download the latest version of the Reports 
Builder online help from the Oracle Reports 10g OTN page.
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10.1.2 Opening / Running an encoded JSP report
Description

If your JSP report's character encoding (for example, EUC-JP) differs from the 
character set portion of the NLS_LANG environment variable (for example, JA16SJIS), 
then you will get the following errors:

■ when running the JSP file:

REP-6106 or 6104 with javax.servlet.jsp.JspException  (multibyte)
REP-0495 Unable to tokenize the query (singlebyte)

■ when opening the JSP file using Reports Builder:

REP-0069 Internal Error or REP-6106

Workaround

To work around this issue, you must ensure that your JSP report's character encoding 
matches the IANA encoding corresponding to Reports Builder's character set portion 
of the NLS_LANG variable.

For example, the JSP report encoding

<%@ page contentType="text/html;charset=EUC-JP" %>
<META http-equiv="Content-Type" content="text/html;charset=EUC-JP">

uses the IANA character encoding EUC-JP. For this report, you should use the
NLS_LANG setting

NLS_LANG=JAPANESE_JAPAN.JA16EUC.

The JSP report’s encoding (EUC-JP) will then correspond to the character encoding 
part of the NLS_LANG environment variable (JA16EUC).

10.1.3 Dynamically Embedding a Character Set in a JSP file
In Oracle Reports, Web-report templates are configured by default for Western 
European character encoding. For other languages, you must specify the character 
encoding for a JSP file by using both the charset attribute of the <meta> tag and the 
<%@page%> page directive.

To dynamically associate the appropriate character encoding with the JSP file, you can 
make the following modifications:

1. In the directory oracle_home/reports/templates/, edit the files rw*.html 
and blank_template.jsp:

a.  Modify the page directive to read

<%@ page contentType="text/html;charset=yourIANAencoding" %>

where

yourIANAencoding is the IANA character encoding that corresponds to the 
character encoding part of your NLS_LANG environment variable.

b.  Modify the <meta> tag inside the <head> tag to read:

<meta http-equiv="Content-Type"
content="text/html;charset=yourIANAencoding" />
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2. In the directory oracle_home/reports/templates/, edit the file 
template.xsl:

a.  Modify the <xsl:output> tag to read:

<xsl:output
     method="jsp"
     indent="yes"
     encoding="yourIANAencoding"
   />

 where

yourIANAencoding is the IANA encoding that corresponds to the character 
encoding part of your NLS_LANG environment variable.

b. Add the following page directive:

<%@ page contentType="text/html;charset=yourIANAencoding" %>

c. Add or modify the <meta> tag inside the <head> tag:

<meta http-equiv="Content-Type"
content="text/html;charset=yourIANAencoding" />

where

yourIANAencoding is the IANA encoding that corresponds to the character 
encoding part of your NLS_LANG environment variable.

10.1.4 Running a Multibyte report containing an embedded Oracle Object
On Windows and Linux platforms, Reports Builder stops responding when you run a 
multibyte report containing an embedded Oracle Object type. This issue will be fixed 
in a later release.

10.1.5 Viewing Oracle Enterprise Manager screens in non European languages
Oracle In the Enterprise Manager Application Server Control, you may see garbled 
titles on the following Reports Server pages for non-Western European languages:

■ Engine

■ Configuration

■  Edit Configuration File

This is a known problem and will be fixed in a later release.

10.1.6 Specifying the encoding of an XML PDS Report
When you create a report against an XML data source, you must ensure that the 
encoding of the data source and its DTD matches the encoding of Reports Builder.

For example, when you create an XML report against a table encoded in a Japanese 
character set, the group element name is encoded in Japanese. To match the data 
source, you should encode the group's element name in the DTD in Japanese. The 
XML and DTD files can be in any encoding that supports Japanese, such as Shift_JIS, 
EUC-JP, or UTF-8.
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If you do not match the XML data source and DTD encoding to the Reports Builder 
encoding, you will see the following error:

ERR-063001 xxx.dtd null

To avoid this problem, ensure that both the XML data source and DTD for your XML 
report use the same encoding that you have in the character encoding part of the
NLS_LANG environment variable in effect for your Reports Runtime.

For example, if NLS_LANG=JAPANESE_JAPAN.JA16SJIS for your Reports Runtime, 
then both your XML data source and DTD should use Shift_JIS.

10.1.7 FTP and WebDaV Destinations Not Supported from Reports Builder
Currently there is no support for FTP and WebDaV destinations from the Reports 
Builder environment. However, they are supported from the Reports Runtime and the 
Reports Server environments.

10.1.8 Oracle9i JDeveloper Integration

10.1.8.1 Deadlock When Debugging JSP Reports in Oracle9i JDeveloper
When you are debugging an OracleAS Reports Services JSP in Oracle9i JDeveloper 
(JDeveloper), you must disable any breakpoints that are not of source type. If you do 
not disable these breakpoints, a deadlock occurs. You can disable breakpoints that are 
not of source type in the Breakpoints window.

10.1.8.2 Graph Not Appearing in Oracle9i JDeveloper
When you run a JSP report with the rw:graph tag in JDeveloper, the graph image is 
not visible in the browser. To fix this problem, set the IMAGEURL parameter in the 
rwservlet.properties file in oracle_home/reports/conf:

IMAGEURL=http://host:port/Workspace-Project-context-root/servlet/
oracle.reports.rwclient.RWClient

10.1.8.3 Reports in-process server
If you set the JDeveloper Java Virtual Machine (JVM) to ojvm, minimal, or vanilla 
(Project Settings > Runner > Virtual Machine), the rwservlet's in-process server is not 
killed when you terminate JDeveloper’s embedded OC4J server. As a result, a port 
conflict occurs the next time you start OC4J. To avoid this problem, do one of the 
following:

■ Set the JVM to hotspot.

■ Disable the in-process server in 
oracle_home/reports/conf/rwservlet.properties by setting 
server_in_process=no.

■ Use the standalone Reports Server instead.

Note: You will not see this error if you use a XML schema instead of 
a DTD.



Platform-specific Issues and Workarounds

Oracle Reports 10-5

10.2 Platform-specific Issues and Workarounds
This section contains issues and workarounds that apply to specific operating 
environment platforms supported by Oracle Developer Suite.

10.2.1 Windows Platform Issues and Workarounds
This section contains issues and workarounds that apply specifically to supported 
Microsoft Windows platforms.

10.2.1.1 Using osfind with JDK 1.4
Oracle Reports’s architecture uses VisiBroker’s osagent to find the various servers 
running in the network.

You use osfind to find various osagent instances running on the network. However, 
osfind does not work with the JDK version used by Oracle Application Server 
(version 1.4). To work around this issue and find osagent instances running on the 
network, you must run osfind with the following settings:

osfind -J-Xbootclasspath /p:oracle_home\vbroker4\lib\vbjboot.jar

10.2.1.2 Invoking the Getting Started Page From Reports Builder
If you open the Getting Started page from Reports Builder using Netscape 7.0, you 
might get a Failed to locate browser error. To correct this problem:

1. Open the Windows registry using a registry editor (for instance, regedit.exe).

2. Navigate to the following key:

HKEY_CURRENT_USER\Software\Oracle\Toolkit\Tkbrowser

3. Delete all other values except Default.

4. Run Reports Builder and select Getting Started.

5. Click OK. The Information Navigator Preferences dialog box appears.

6. Select Netscape Navigator 7.0+ as the browser. Ensure that the path and the 
browser program name are accurate. To change the browser location (if the path or 
the program name is incorrect):

a. Click Browse.

b. Navigate to the location and program name you want.

c. Click OK.

7. In the Information Navigator Preferences dialog box, click OK.

10.2.1.3 Printing Reports Without Hardware-based Left Margins
Oracle Reports 10g (9.0.4) has been changed to generate the report output relative to 
the top-left corner of the physical paper. Earlier, the printer's printable area was used, 
causing inconsistencies in the location of the report output when used across different 
printer models.

If required, you can revert to the earlier behavior by setting the registry key REPORTS_
ADD_HWMARGIN to YES.

Note: Create a backup of the registry before proceeding to edit it.
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To set the REPORTS_ADD_HWMARGIN registry key to YES:

1. Back up the Windows registry, then edit it using a registry editor such as 
regedit.exe.

2. Navigate to the key HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE, then find the 
HOMEn key that contains the directory for the Oracle home that contains Reports.

3. With this key selected, add a new String sub-key named 
REPORTS_ADD_HWMARGIN and set its value to YES.

By default, the non-printable left margin of the printer is ignored. The printing origin 
starts from the top-left corner (0,0) of the physical paper and not the printable area. If 
you have set the registry key value to YES and then want to switch to the default, you 
can set the key value to NO, or you can delete the key.

You must provide enough margin in your report's layout to put the data within the 
printable area. The margin fields in the Page Setup dialog box of Reports Builder have 
been disabled to ensure consistency with OracleAS Reports Services.

10.2.2 Linux, Solaris, and HP-UX Platform Issues and Workarounds

10.2.2.1 General Linux, Solaris, and HP-UX Platform Issues and Workarounds
This section contains issues and workarounds specifically for all supported SPARC 
Solaris, HP HP-UX, and Linux x86 platforms. 

10.2.2.1.1 Running a Report to DelimitedData on OracleAS Portal  If you have registered your 
Reports Server in Oracle Application Server 10g Portal, then you cannot run a report to 
DESFORMAT=DELIMITEDDATA using that Reports Server.

Workaround

To work around this issue, you must either unregister your Reports Server from Oracle 
Application Server 10g Portal or use a standalone Reports Server to run the report to 
DESFORMAT=DELIMITEDDATA.

10.2.2.1.2 Providing the location to a character set-specific Tk2Motif.rgb file  The file 
Tk2Motif.rgb file contains resource settings for the Motif version of the Oracle 
Toolkit. For example, it specifies the font mapping between the character set used by 
Oracle Reports, specified in NLS_CHARACTERSET, and X fonts.

Oracle Reports looks for this file in the directory oracle_
home/guicommon9/tk90/admin/language, where language is derived from the 
language setting in NLS_LANG. 

Note: Refer to Windows online help for instructions on how to 
back up the registry.

Note:  Platform-specific issues are only reported for the platform 
on which they were first detected; an issue that is listed as 
"platform-specific" may actually occur on several platforms. Unless 
the notes say otherwise, you should only use a platform-specific 
workaround on the stated platform.
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If the file does not exist, then Oracle Reports looks for the default version in oracle_
home/guicommon9/tk90/admin. This version is configured for WEISO8859P1, the 
Western European character set.

If your NLS_LANG or NLS_CHARACTERSET specifies a character set that is not 
normally used for the language you have set in NLS_LANG, then you will get an error.

For example, if you have set NLS_LANG=AMERICAN_AMERICA.JA16EUC, then Oracle 
Reports locates Tk2Motif.rgb in the directory
oracle_home/guicommon9/tk90/admin/. The language setting in NLS_LANG is 
AMERICAN, and there is no language subdirectory associated with AMERICAN, so Oracle 
Reports uses the default file. Since this version is designed for WE8ISO8859P1, and 
your NLS_LANG character set is JA16EUC, you get the error REP-3000.

To workaround this problem, set the value of the environment variable 
TK90_UNKNOWN to the location of your character set-specific Tk2Motif.rgb file.

For example, if you have NLS_LANG=AMERICAN_AMERICA.JA16EUC, then set 
TK90_UNKNOWN=oracle_home/guicommon9/tk90/admin/JA. Even though your 
language is set to AMERICAN, Oracle Reports will use the Tk2Motif.rgb file in the JA 
language subdirectory.

10.2.2.1.3 Implementing removal of DISPLAY and printer dependencies  With Oracle Reports 
10g (9.0.4), it is no longer necessary to have the DISPLAY environment variable or a 
valid printer defined at runtime.

The REPORTS_DEFAULT_DISPLAY environment variable specifies whether to 
implement the following features:

■ The elimination of the dependency on the DISPLAY environment variable, which 
was required in prior releases to define the windowing system display surface for 
creating images and getting pixel resolution.

■ The elimination of the dependency on having a valid printer defined for font 
information (PRINTER and TK_PRINTER environment variables set to a valid 
printer, or a valid entry in uiprint.txt).

■ Using screenprinter.ppd for surface resolution for images and font 
information.

■ Enhanced imaging support

Note:

■ For existing customers upgrading to Oracle Reports 10g (9.0.4), 
the default setting (YES) may impact the appearance, number 
of pages, output file size, or performance of existing reports.

■ Even when the DISPLAY environment variable is set, it will not 
be used unless REPORTS_DEFAULT_DISPLAY is set to NO.
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10.2.2.2 Solaris Issues and Workarounds

10.2.2.2.1 Reports Builder stops responding on Solaris 2.9  On Solaris 2.9, Reports Builder 
stops responding if you invoke either the Report Wizard or the Data Wizard after 
accessing any of the following:

■ Reports Builder online help

■  Data Model Editor

■  Text Query Editor

■  JDBC Query Editor

■  OLAP Query Editor

Reports Builder may stop responding when you use the query editor from the Report 
Wizard's data panel.

To fix this issue, download and install the patch from 
http://metalink.oracle.com. The ARU patch number is: 5188895.

After you have installed the patch, you must enable it by setting the environment 
variable REPORTS_SOLARIS_9=YES.

10.2.2.2.2 Invoking the Graph Wizard in a multibyte environment  On Solaris, invoking the 
Graph Wizard in a multibyte (Japanese, Simplified Chinese, and Korean) environment 
causes Reports Developer to stop responding.

To work around this issue, you must:

1. Install J2SE Version 1.4.2 on your computer. You can download J2SE 1.4.2 from Sun 
Microsystem’s Java web site (http://java.sun.com).

2. Set the path to the J2SE home in the reports.sh file:

PATH=$J2SEHOME/bin:$ORACLE_HOME/jdk/bin:
$ORACLE_HOME/bin:${PATH};export PATH

3. Modify LD_LIBRARY_PATH in reports.sh to point to the location of the J2SE 
home:

LD_LIBRARY_PATH=$J2SEHOME/lib/sparc:
$ORACLE_HOME/jdk/jre/lib/sparc:$ORACLE_HOME/lib:
${LD_LIBRARY_PATH}; export LD_LIBRARY_PATH

See Also:

■ Oracle Application Server Reports Services Publishing Reports to the 
Web and the Reports Builder online help for more information 
on the REPORTS_DEFAULT_DISPLAY environment variable 
and screenprinter.ppd.

■ The section "Fonts in Report Output" in the chapter "Managing 
Fonts in Oracle Reports" in Oracle Application Server Reports 
Services Publishing Reports to the Web.

Note: Although these issues were seen on Solaris, they may also 
exist on Linux and HP-UX.
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10.2.2.3 Linux Issues and Workarounds
This section contains issues and workarounds specifically for supported Linux x86 
platforms.

10.2.2.3.1 Radio box selection using mouse in New Program Unit dialog box does not take effect 
(3209858)  Reports Builder has a known issue with selecting a radio button with your 
mouse.

When you select a radio button in the New Program Unit dialog box, close the dialog 
box (for example, by clicking on Cancel) and then reopen the New Program Unit 
dialog box, you cannot select the same radio button.

For example, if you select the Function radio button, close the New Program Unit 
dialog box, and then reopen it, you cannot select the Function radio button.

You can work around this using either of the following methods:

■ Select a radio button other than the one you selected previously, then select the 
one you want. For example, to select the Function radio button, first select the 
Procedure radio button. You can then select the Function radio button.

■ Use your keyboard to select the radio button. Navigate to the radio button using 
the Tab, Up, and Down keys, then use the space bar to select the radio button.

For further details, please refer to bug 3209858: RWBUILDER: NEW PROGRAM UNIT: 
CANNOT MAKE RADIO BUTTON SELECTION WITH MOUSE

10.2.2.4 HP-UX Issues and Workarounds

10.2.2.4.1 Running Oracle Reports in a Japanese Environment on HP-UX  If you want to use 
Oracle Reports in the HP-UX Japanese environment with 
NLS_LANG=JAPANESE_JAPAN.JA16SJIS, you will need to modify the appropriate 
Tk2Motif.rgb file before using Oracle Reports because this file contains EUC and not 
SJIS encoded Japanese resources.

To do this, edit the file 
oracle_home/guicommon9/tk90/admin/JA/Tk2Motif.rgb. Either convert the 
entries to SJIS encoding, or remove the last seven entries. Otherwise, Oracle Reports 
may fail.

10.3 Configuration Issues and Workarounds
This section contains issues and workarounds for Oracle Reports Developer 
configuration.

10.3.1 Repairing Fonts Not Appearing Correctly in Web Source View
Text in the user interface of Reports Builder, such as the window title, uses fonts taken 
from the system resource files for the current language. These system resource files are 
supplied with the Oracle Reports installation. In Oracle Reports, you can map these 
fonts in the [RWBUILDER] section of uifont.ali. If found, the mapped font is used 
instead of the original font; if not, Oracle Reports uses the original font.

Note: The mapped font needs to be a fixed-width font.
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In the Web Source view of the Report Editor, the following languages may appear 
garbled: Arabic, Central European languages, Cyrillic, Greek, Hebrew, Japanese, Thai, 
and Turkish. To work around this issue, you can set the font names for Reports Builder 
in uifont.ali as follows:

[rwbuilder]
.....AR8MSWIN1256="Courier New"
.....CL8MSWIN1251="Courier New"
.....EE8MSWIN1250="Courier New"
.....EL8MSWIN1253="Courier New"
.....IW8MSWIN1255="Courier New"
.....JA16SJIS="MS Gothic"
.....TH8TISASCII="Andale Duospace WT"
.....TR8MSWIN1254="Courier New"

You can download a copy of the Andale Duospace WT (fixed-width) font from 
OracleMetalink (http://metalink.oracle.com). The ARU number is 2638552.

10.3.2 Optimizing the Deployment of Reports
Before you deploy a report on a computer that is either slow or is running on a load, 
you may want to configure the following:

■ Ping timeout (OPMN-side): Ping timeout is the measure that OPMN uses to 
determine the time that it must wait for a callback from an in-process Reports 
Server (in OC4J_BI_FORMS), before considering it as a timeout.

The default timeout period is 150. This period is calculated from: ping timeout, 
ping interval, and number of retries. The default values for these are:

■ ping timeout = 30 seconds

■ ping interval = 20 seconds

■ number of retries = 3

Based on these values, there will be three ping attempts with a timeout of 30 
seconds each at 20 second intervals. The first ping is done after the specified ping 
interval. Thus, from the time the OC4J is started by OPMN, approximately 150 (20 
+ 3*30 + 2*20) seconds will elapse before the process is considered unresponsive 
and restarted. However, if after OPMN connects to OC4J but OC4J is too slow in 
sending regular ONS notifications then the 30 second timeout is applicable.

■ Callback timeout (Reports Server-side): Callback timeout is the measure that 
Reports Server uses to determine the time that it must wait for a response from the 
engine before timing out. You can specify this value in the Reports Server 
configuration file, server_name.conf. This time out period is in milliseconds.

Note: The number of retries is applicable only when OPMN 
successfully connects to OC4J and receives regular ONS 
notifications from the process.

See Also: Oracle Application Server Reports Services Publishing 
Reports to the Web for more information on the opmn.xml file.
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For example:

<engine id="rwEng" class="oracle.reports.engine.EngineImpl" initEngine="1"
maxEngine="1" minEngine="0" engLife="50" maxIdle="30"
callbackTimeOut="80000">

10.3.3 Improving Image Resolution of Graphs Displayed in a PDF File or on a Printer
The REPORTS_GRAPH_IMAGE_DPI environment variable specifies a dots per inch 
(DPI) value for graphs displayed to a PDF file or on a printer. The default value for 
this environment variable is 72 DPI, which minimizes the time it takes to generate the 
report and reduces the report file size.

If you specify a value higher than 72 DPI, you will see an improvement in the image 
resolution. However, this increases the time it takes to generate the report and 
increases the report file size.

For instance, setting the value to 250:

■ Increases the time to generate a report by 5 to 6 times that of a report generated at 
72 DPI.

■ Increases the PDF file size by 5 to 6 times that of a report generated at 72 DPI.

Usage Notes

■ The valid values are 72 through 300.

■ The default value is 72.

■ For Windows, set the value in the Windows registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEn\
REPORTS_GRAPH_IMAGE_DPI. Refer to Section 10.2.1.3, "Printing Reports 
Without Hardware-based Left Margins" for instructions on how to set a registry 
key value.

■ For Linux, Solaris, and HP-UX, set the value by setting the environment variable 
in reports.sh.

■ When you set a DPI value greater than 250 and your chart is bigger than 5"x5", you 
may also need to change the JVM heap size value using
REPORTS_JVM_OPTIONS to avoid an Out Of Memory error in the JVM.

■ This variable is currently not supported in Oracle Reports distribution 
functionality as this is specific to PDF and printer outputs only.

10.3.4 Specifying the Values for Oracle Reports' Java Virtual Machine
You may want to set Oracle Reports’ Java Virtual Machine (JVM) options explicitly to 
get certain specific behaviors from the JVM that aren't enabled by default. To do this, 
use the command line option JVMOPTIONS.

Note: Increase the timeout when the machine is very slow.

See Also: Oracle Application Server Reports Services Publishing 
Reports to the Web for more information on setting the JVM options.
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You can use JVMOPTIONS to set options for Reports Runtime, Reports Builder, or 
Reports Converter's JVM. For example, you can use the following command line to 
start Reports Builder with a 512MB heap space:

rwbuilder jvmoptions=-Xmx512M

You can set more than one option by enclosing the value in quotes:

rwbuilder jvmoptions="-Xmx256M -Xms=128M"

The syntax of JVMOPTIONS is

JVMOPTIONS=option | "option [option]"

where option is a valid option for a Reports JVM.

The default value for JVMOPTIONS is -Xmx256M.

10.3.5 Resolving Reports-Portal Integration Error When Attempting OID Create 
Resource

In OracleAS Portal, when you have configured Oracle Reports Security settings for 
Reports Definition File Access by editing a reports definition file, you may encounter 
the following error when you click Run or Run as Portlet:

500 Internal Server Error
Unexpected Error. Please contact Administrator

This error occurs when all of the following conditions are true:

■ You have an Interop deployment (which allows for a mixed 9.0.2/9.0.4 
environment), with 9.0.4 MT (mid-tier), 9.0.4 IM (Identity Management), and 9.0.2 
MR (metadata repository) configured to run together.

■ You are running Oracle Reports within OracleAS Portal, using the SSOCONN 
parameter.

■ The connection resource you specify in the SSOCONN parameter was not created 
in the Oracle Internet Directory (OID) server.

To work around this issue, do the following:

1. In the 9.0.4 IM Oracle home, open the following file in a text editor:

oracle_home/Apache/Apache/conf/mod_osso.conf

2. Add the following line to the file:

OssoRedirectByForm on

For example:

<IfModule mod_osso.c>
OssoIpCheck off
OssoIdleTimeout off
OssoConfigFile
/private1/iasinst/install_set1/904infra/Apache/Apache/conf/osso/osso.conf
OssoRedirectByForm on
</IfModule>

Note: The value of JVMOPTIONS overrides the value in the 
REPORTS_JVM_OPTIONS environment variable.
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10.3.6 Running to Web Layout on Reports Builder
You can preview a report from Reports Builder by using the Run To Web Layout 
functionality. You do not need to have the Reports Server configured in order to use 
this functionality, because Reports Builder includes an embedded Oracle Application 
Server Containers for J2EE(OC4J) server.

After you upgrade to Oracle Reports 10g (9.0.4) from Oracle9i Reports Release 2 (9.0.2), 
you must ensure that the location in the environment variables CLASSPATH or 
REPORTS_CLASSPATH refer only to the oc4j.jar file in the 10g (9.0.4) Oracle 
home. You must remove the path to the 9.0.2 Oracle home oc4j.jar if it exists in 
either REPORTS_CLASSPATH or CLASSPATH.

If you include the 9.0.2. oc4j.jar file path in either CLASSPATH or REPORTS_
CLASSPATH, the Run to Web Layout functionality will fail with the following error:

The major.minor version '48.0' is too recent for this tool to 
understand

10.4 Administration Issues and Workarounds
This section describes administration issues and their workarounds for Oracle Reports 
Developer.

10.4.1 Authenticating EM Access to Reports Server Information
The identifier element in server_name.conf contains a new value called 
SERVERACCESSKEY. This value is used to ensure that the Reports Server information 
in Oracle Enterprise Manager (EM) is secure. The following authentication is 
implemented:

■ The value of the identifier element in the server_name.conf file is encrypted 
and is of the form %SERVERACCESSKEY_USER%/%SERVERACCESSKEY_
PASSWORD%. For example:

<identifier confidential="yes" encrypted="no">
  %SERVERACCESSKEY_USER%/%SERVERACCESSKEY_PASSWORD%
</identifier>

■ The corresponding entries in the targets.xml file are:

<Property NAME="UserName" VALUE="%SERVERACCESSKEY_USER%" ENCRYPTED="FALSE"/>
<Property NAME="Password" VALUE="%SERVERACCESSKEY_PASSWORD%"
ENCRYPTED="FALSE"/>

The default installation ensures that the install time values of %SERVERACCESSKEY_
USER% and %SERVERACCESSKEY_PASSWORD% match those in targets.xml.

To change the user name and password:

1. Edit the oracle_home/reports/conf/server_name.conf file, as follows:

<identifier confidential="yes" encrypted="no">
   new_username/new_password
</identifier>

Note: %SERVERACCESSKEY_USER% and %SERVERACCESSKEY_
PASSWORD% in server_name.conf and targets.xml must 
match for the Reports Server pages in EM to display data correctly.



Administration Issues and Workarounds

10-14 Release Notes

2. Edit the oracle_home/sysman/emd/targets.xml file, as follows:

<Property NAME="UserName" VALUE="new_username" ENCRYPTED="FALSE"/>
<Property NAME="Password" VALUE="new_password" ENCRYPTED="FALSE"/>

3. Restart EM and Reports Server. The user name and password in server_
name.conf and targets.xml will be encrypted after the restart.

10.4.2 Running Reports on OracleAS Portal as an Item Link
When you install OracleAS Portal with a non-default language setting, some entries 
required to publish a report as an item link on a portal page are not installed 
automatically. You must install the language of your choice by using the rwlang.sql 
script.

Run the script rwlang.sql in the directory oracle_
home/portal/admin/plsql/wwd/ if:

■ You selected at least one language in addition to the default ("US") when you 
installed OracleAS Portal

■ You want to publish a report as an item link in OracleAS Portal.

This is a one time post-installation task and will ensure that you can publish a report 
as an item link on OracleAS Portal.

To run the script:

1. Navigate to the directory oracle_home/portal/admin/plsql/wwd/.

2. Run SQL*Plus.

3. Logon to OracleAS Portal using the portal schema.

4. Run the script rwlang.sql with a list of language identifiers corresponding to 
the languages you installed with OracleAS Portal:

@rwlang.sql language_list

where language_list is a list of language identifiers, separated by commas.

For example, if you installed French and Japanese when you installed OracleAS 
Portal, you would run the following command:

@rwlang.sql f,ja.

Usage Notes:

■ Do not leave spaces before or after the comma (,), otherwise SQL*Plus will 
interpret the language list as two parameters, instead of one parameter containing 
a comma delimiter.

Note: Beginning with Oracle Reports 10g (9.0.4), Enterprise 
Manager (EM) will not use OID authentication to access Reports 
Server information. It will use the SERVERACCESSKEY value to 
specify the authentication.

Note: This is the portal schema you used to install OracleAS 
Portal PL/ SQL packages.
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■ The file rwlang.sql contains a complete list of language identifiers. You can 
view the file with a text editor to find the identifiers you want.

10.5 Documentation Errata
This section describes known errors in the documentation.

10.5.1 REPORTS_CLASSPATH variable in Linux, Solaris, and HP-UX
Chapter 8, sections 8.1.2 through 8.2, of the Oracle Application Server Reports Services 
Publishing Reports to the Web manual specifies the reports.sh file as containing the 
REPORTS_CLASSPATH variable on Solaris. The REPORTS_CLASSPATH variable is 
located in the reports.sh file for all Linux, Solaris, and HP-UX platforms.

10.5.2 Oracle Reports Documentation Page on Oracle Technology Network
Due to improvements on OTN, the URL that directly accesses the Oracle Reports 
Documentation page is incorrect in the documentation. Instead of 
http://otn.oracle.com/docs/products/reports/content.html, the 
revised URL is http://otn.oracle.com/documentation/reports.html

10.5.3 Revised Section 13.3.3.2 of Oracle Application Server Reports Services 
Publishing Reports to the Web

Chapter 13, section 13.3.3.2, of the Oracle Application Server Reports Services Publishing 
Reports to the Web manual contains procedures that are outdated. Replace the section 
with the following section, "Deploying an Oracle Reports JSP to an OC4J_BI_FORMS 
Instance":

10.5.3.1 Deploying an Oracle Reports JSP to an OC4J_BI_FORMS Instance
This section describes how to deploy an Oracle Reports JSP file to either an existing or 
a new instance of OC4J_BI_FORMS.

10.5.3.1.1 To deploy to an existing OC4j_BI_FORMS instance:  

1. Ensure that you have created the J2EE application. Refer to the manual Oracle 
Application Server Reports Services Publishing Reports to the Web for more 
information on creating a J2EE application for Oracle Reports.

2. In Oracle Enterprise Manager, display the detail page for your middle tier.

3. Under System Components, click OC4J_BI_Forms.

4. In the OC4J_BI_FORMS page, click Administration.

5. Under Deployed Applications, click Deploy EAR file to deploy the EAR file you 
created.

6. On the first page of the Deploy Application wizard, click Browse to select the J2EE 
application (EAR file) you want to deploy, or enter the location of the EAR file you 
created.

7. In Application Name, specify a unique application name for this application. For 
example, you can name your application MyReportApp.

8. From the Parent Application list, select the parent application and click Continue.

9. On the URL Mapping page, note the text in the URL Mapping field. This is the 
name your users will enter to access the new application.
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10.  In the URL Mapping field, add a forward slash (/) to the beginning of the 
application name, since it is part of a URL address. For example, if you have 
named your application MyReportApp then you should change the URL 
Mapping field to read

/MyReportApp.

11.  Click Finish.

12.  On the next page, click Deploy.

13.  On the OC4J_BI_Forms Detail page that displays, you should now see your 
application (MyReportApp) listed under Deployed Applications.

14.  Click your application name (MyReportApp).

15.  On the Application page, under Properties, click General.

16.  Under Library Paths, click Add Another Row, then add the following path to the 
rwrun.jar library:

oracle_home\reports\jlib\rwrun.jar.

17.  Add another row with the following path to the zrclient.jar library:

oracle_home\jlib\zrclient.jar.

18.  Click Apply, then click OK.

19. Restart your application. Click Stop, then Start. Your application will restart The 
new library paths are now in effect.

10.5.3.1.2 To deploy to a new OC4j_BI_FORMS instance:  

1. Ensure that you have created the J2EE application. Refer to the manual Oracle 
Application Server Reports Services Publishing Reports to the Web for more 
information on creating a J2EE application for Oracle Reports.

2.  In Oracle Enterprise Manager, display the detail page for your middle tier.

3.  Click Create OC4J Instance.

4. Type the name of your OC4J instance.

5. Click Create.

6. Once the OC4J instance is created, click OK.

7. On Application Server page, under System Components, you should now see the 
new OC4J instance.

8. Next, manually configure the OC4J instance to support connection to a Reports 
Server and to support security integration.

10.5.3.1.3 To configure the new OC4J instance:  

1.  Copy properties and their definitions from an existing OC4J instance to your new 
instance. The properties are in the oc4j.properties file of an existing OC4J 
instance. 

For example, if you have an existing OC4J_BI_FORMS instance and a new OC4J 
instance myinstance, then copy the properties from 
oracle_home/j2ee/OC4J_BI_FORMS/config/oc4j.properties into 
oracle_home/j2ee/myinstance/config/oc4j.properties.
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Copy the following properties and their definitions:

– oracle.home

– oracle.path

2. In the file oracle_home/opmn/conf/opmn.xml, add the PATH (Windows) or 
LD_LIBRARY_PATH (Linux, Solaris, and HP-UX) property. To do this, 

a. In oracle_home/opmn/conf/opmn.xml, find the XML element that 
describes your new OC4J instance:

<process-type id="myapp" module-id="OC4J">
  <module-data>
    <category id="start-parameters">
      <data id="java-options" 
            value="-server
-Djava.security.policy=oracle_home/j2ee/MyInst/config/java2.policy
-Djava.awt.headless=true"/>
     <data id="oc4j-options" value="-properties"/>
    </category>
    <category id="stop-parameters">
     <data id="java-options"
           value="
-Djava.security.policy=oracle_home/j2ee/MyInst/config/java2.policy
-Djava.awt.headless=true"/>
    </category>
  </module-data>
  <start timeout="900" retry="2"/>
  <stop timeout="120"/>
  <restart timeout="720" retry="2"/>
  <port id="ajp" range="3301-3400"/>
  <port id="rmi" range="3201-3300"/>
  <port id="jms" range="3701-3800"/>
  <process-set id="default_island" numprocs="1"/>
</process-type>

b. Add either the PATH (for Windows) or LD_LIBRARY_PATH (for Linux, Solaris, 
and HP-UX) and module data properties by copying them from the OC4J_
BI_FORMS instance in the same opmn.xml file. For example, on a Solaris 
computer:

<environment>
  <variable id="LD_LIBRARY_PATH" 
            value="$ORACLE_HOME/lib:
                   $ORACLE_HOME/network/lib:
                   $ORACLE_HOME/jdk/jre/lib/sparc"/>
</environment>
<category id="start-parameters">
  <data id="java-options" value="-server
-Djava.security.policy=$ORACLE_HOME/j2ee/OC4J_BI_Forms/config/java2.policy
-Djava.awt.headless=true -Xmx512M 
-Xbootclasspath/p:$ORACLE_HOME/vbroker4/lib/vbjboot.jar"/>
  <data id="oc4j-options" value="-properties -userThreads"/>
</category>
<category id="urlping-parameters">
  <data
    id="/MyReportsApp/rwservlet/pingserver?start=auto" value="200"/>
</category>
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       <dependencies>
         <database infrastructure-key="portal"/>
         <managed-process process-type="HTTP_Server"
                          process-set="HTTP_Server" 
                          ias-component="HTTP_Server" 
                          autostart="true"/>
       </dependencies>

where MyReportsApp is your newly created Web application name for Oracle 
Reports.

c. Restart the OC4J instance.

10.5.4 Possible Outdated Screenshots in Oracle Reports Server Reports Services 
Publishing Reports to the Web

Chapter 19, "Managing and Monitoring OracleAS Reports Services", of the Oracle 
Application Server Reports Services Publishing Reports to the Web manual may show 
screenshots that do not reflect the latest updates to the Oracle Enterprise Manager user 
interface.
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Oracle Designer

This chapter discusses the following Oracle Designer topics:

■ Section 11.1, "General Issues and Workarounds"

■ Section 11.2, "Platform-specific Issues and Workarounds"

■ Section 11.3, "Configuration Issues and Workarounds"

■ Section 11.4, "Administration Issues and Workarounds"

■ Section 11.5, "Documentation Errata"

In addition to these release notes, you should also read Chapter 12, "Oracle Software 
Configuration Manager" for the SCM release notes.

11.1 General Issues and Workarounds
This section discusses general issues and workarounds for Oracle Designer.

11.1.1 Installation
This section discusses installation issues and workarounds.

11.1.1.1 Oracle Designer patchsets to 9.0.4
The Oracle Designer development team is committed to producing regular patchsets 
following the release of 9.0.4. The latest patchsets are available on OracleMetalink 
(http://metalink.oracle.com). To find the latest patchset on OralceMetalink, 
click the Patches button, then, in the new OracleMetalink patch search facility, either 
enter the patch ID (if known) or search by "Product or Family" for "Oracle Designer - 
Repository Family". The latest Oracle Developer Suite patchset is listed in the Release 
list (drop down box). For additional information about availability and compatibility 
of the latest releases, see Support note:60705.1.

11.1.1.2 Oracle Designer/SCM Patchset 9.0.4.3: immediate installation may be 
required
Important: If your repository has been installed or upgraded via the repository 
administration utility (RAU) that came with Oracle Designer/SCM release 9.0.2.7, you 
must immediately patch all Oracle Designer 9.0.4.2 clients by applying the Oracle 
Designer/SCM patchset 9.0.4.3.
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Oracle Designer/SCM 9.0.4.2 works against an earlier version of the repository that 
came with Oracle Designer/SCM 9.0.2.6 and will not work against a later repository 
from Oracle Designer/SCM release 9.0.2.7. Oracle Designer/SCM patchset 9.0.4.3 (a 
maintenance release) patches your 9.0.4.2 installation allowing it to connect to the 
9.0.2.7 compatible repository.

If your repository is still at a version compatible with Oracle Designer/SCM 9.0.2.6, 
Oracle Designer/SCM 9.0.4.2 will work with that repository. However, Oracle strongly 
recommends that you install the Oracle Designer/SCM 9.0.4.3 patchset on your 9.0.4.2 
clients and upgrade your repository as soon as possible.

If you wish to create a new repository, then, before doing so, Oracle strongly 
recommends that you install the Oracle Designer/SCM 9.0.4.3 patchset on your 9.0.4.2 
installation. This will prevent you subsequently having to upgrade it via the RAU 
when you later apply the Oracle Designer/SCM 9.0.4.3 patchset.

11.1.1.3 Japanese in the multi-language environment
When installing Oracle Developer Suite 10g (9.0.4) on a client computer, you can select 
a one or more product languages. If you include Japanese as one of these languages 
(for example, if you select Japanese, Korean and English) then, in the Designer 
product, the user interface text will always be in Japanese. You cannot alter this later 
by changing the NLS language setting on the client computer. If you do not include 
Japanese as one of the product languages (for example, if you select Chinese, Korean 
and English) then the user interface text in Designer will always be in English.

If you do not require the user interface text to be in Japanese, then you must not 
include Japanese as one of the product languages. If you do require the user interface 
text to be in Japanese, you should, in addition to selecting Japanese as a product 
language, also check that a Japanese font has been installed.

11.1.1.4 Setting up the repository for NLS operation
If you have a National Language Support (NLS) version of the repository, you can 
change the display language for the following text:

■ Repository Core Model

– datatype values

– element type names

– property names

– text type descriptions

– report group names

– report parameters

– report title names

■ Designer Model

■ Valid Preference Meanings

■ User Preference Names

The currently valid display languages are the default (English) or Japanese.

With Oracle Designer, if you also use Generator tools, you can change the display 
language for Generator preference descriptions and their valid value meanings. 
Changing the display language for "Valid Preference Names" will also change the 
display language for the Repository Object Browser (ROB).
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The translated text files for the display languages that the repository supports are 
installed in the directory oracle_home\REPADM61\NLS if you have an NLS version 
of the repository.

To set up the repository for NLS operation, perform the following tasks:

1. Load the language text files (see "Loading language text files" in the online help 
for the Repository Administration Utility).

2. Change the display language to the one you want (see "Changing the display 
language" in the online help for the Repository Administration Utility).

11.1.1.5 Enabling repository support for Oracle Designer Objects when the 
repository only supports core objects
When installing a repository from the Repository Administration Utility (RAU), you 
may select either "support for Repository (core) objects" or "support for Oracle 
Designer Objects". If your repository was installed by selecting the "support for 
Repository (core) objects" option then you must also install support for Oracle 
Designer Objects before the repository can be used by the Oracle Designer client tools. 
This is achieved by re-running the RAU and installing the required support. If your 
repository additionally requires upgrading, then choose one of the following two 
options:

■ Upgrade the repository first using the latest version of the RAU, and then install 
support for Oracle Designer objects.

■ install support for Oracle Designer Objects using a version of the RAU that is 
compatible with the existing repository, and then upgrade it using the latest 
version of the RAU. 

Enabling support for Oracle Designer Objects will cause the repository to become 
non-versioned. Any version history information from the production repository will 
not be visible. To switch the versioning on again, in the Repository Administration 
Utility choose Options > Enable Version Support. The version history information 
will then be visible (see bug 1419412).

11.1.1.6 Migration from Oracle Designer Web Assistant (ODWA) to Repository 
Object Browser (ROB)
Starting with version 9.0.2.4, Oracle Designer includes a web based reporting tool 
called Repository Object Browser (ROB). ROB is functionally similar to the Oracle 
Designer Web Assistant (ODWA) tool, which is part of Oracle iDevelopment 
Accelerator suite. This section is a guide for users of ODWA migrating to ROB.

11.1.1.6.1 Installing ROB  ROB will be installed automatically as a part of the repository 
install/upgrade process, by the Repository Administration utility (RAU). Unlike the 
ODWA, all the ROB objects will be installed within the REPOWNER schema. Access to 
all the subordinate users will be automatically created using the previously selected 
type of synonyms. Installing ROB on a repository having ODWA will not affect the 
ODWA data but the repository users will no longer be able to access ODWA.

Note: If you do not have these translated text files in the \NLS 
directory, you cannot change the display language.
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11.1.1.6.2 ODWA Data  ODWA operates mainly on the data stored in the repository, 
although it also maintains some ODWA specific data. This data includes details about 
ODWA Hotspots, ODWA graphic categories and ODWA search library. All the data 
captured by ODWA is stored in a set of tables in ODWA owner schema. The following 
table lists these tables and details about the data stored in them:

11.1.1.6.3 Migration to ROB  All the data contained in the ODWA tables can be migrated 
to ROB. ROB uses tables in the Repos owner schema with the same name and 
structure as that of ODWA owner tables to hold the ROB specific data. Hence 
migration of the hotspots and other saved query libraries from ODWA to ROB is an 
easier task. This can be accomplished with a simple SQL script that reads the ODWA 
tables listed above and inserts the data into ROB tables with the same name. For 
example the ODWA query library can be migrated by executing the following insert 
statement:

insert into REPOS.ODWA_QUERY_LIBRARY
   select  ID,
           CATEGORY,
           LABEL,
           DESCRIPTION,
           PUBLISHED,
           OWNER,
           LAST_DATE_CHANGED,
           BASIC,
           ADVANCED,
           VERSION,
           AUDIT_TAB
   from ODWA.ODWA_QUERY_LIBRARY;

where REPOS is the repository owner schema and ODWA is the ODWA owner schema.

Only the tables listed in the previous topic need to be migrated in this manner, the 
other ODWA tables like ODWA_SESSIONS need not be migrated as they do not 
contain any data that is useful to ROB.

11.1.1.6.4 ODWA Preferences  While configuring ODWA, values for various preferences 
need to be inserted into the ODWA_PREFERENCES table manually, using SQL*Plus. 
ROB provides an easy-to-use web interface to manage all the preferences. Only the 
Repos owner can change the preferences and this can be done by navigating to the 
"Manage Preferences" page under "Management facility".

Table Name Description

ODWA_QUERY_LIBRARY Contains data for all the saved queries

ODWA_HOTSPOTS Contains information about all the Hotspots defined for 
ODWA graphics

ODWA_GRAPHICS Contains the information about all ODWA graphic items

ODWA_GRPH_CATEGORIES Contains information about the various graphic categories 
defined in ODWA

Note: ODWA contains more tables than the ones listed above, but 
they do not contain user data. 



General Issues and Workarounds

Oracle Designer 11-5

11.1.2 System Modeling and Design Tools
This section discusses issues and workarounds related to the Process Modeler, Entity 
Relationship Diagrammer, Function Hierarchy Diagrammer, Dataflow Diagrammer 
and Design Editor tools.

Copy, Move and Share

To copy a set of objects, keeping references between them, use Extended Copy.

Container Copy

If you copy a container using Edit > Copy, each object within the container is copied 
as a separate object. If two or more objects within the container refer to each other, the 
references are not updated to point to the new object in the new container, but still 
refer to the object in the original container, for example:

Application System ABC

Table DEPT 

Table EMP 

FK to DEPT

Copy ABC creating new application system XYZ

Application System XYZ 

Table DEPT 

Table EMP 

FK to ABC.DEPT ( not XYZ.DEPT )

If you want to maintain the links (such that in this example the foreign key points to 
XYZ.DEPT), select all the objects in the container and then choose Utilities > Extended 
Copy.

Known Issues and Workarounds

Matrix diagrammer raises "failed to update registry" error on Windows 2000 (bug 
1472195)
Cause:  If a Windows user that is not a member of the local "Power Users" group 
or the "Administrator" group attempts to invoke the Oracle Designer 
diagrammers, then an alert box will appear indicating "failed to update registry". 
The error is being raised because the user does not have permissions to allow 
Oracle Designer to write to the HKEY_CLASSES_ROOT registry key.

Action:  Select OK to dismiss the error message. Then, add the Windows users 
who wish to use Oracle Designer to the local "Power Users" or "Administrator" 
group. 

Note: By default ROB does not support CDM objects like business 
rules, or CDM style reports. To expose these reports in ROB, set the 
preference "Enable Custom Development Method (CDM) objects" 
in the preferences page.
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Syntax checker incorrectly reports error for application logic (bug 1366816)
Cause:  When the syntax checker is run on application logic it may spuriously 
report errors. Two examples when this can occur are:

■ when DECLARE appears before BEGIN. In this case you could remove the 
word DECLARE (leaving the variable declarations in place).

■ when the application logic uses Forms built-ins such as FORMS_MDI_
WINDOW or WINDOW_STATE. The syntax checker does not recognize these 
and states that they must be declared, however the Forms Developer 
environment does recognize them so the form will run correctly

Action:  None. In cases like these the best way to check that the application logic is 
working correctly is to generate the form and check that it works correctly.

Design Editor does not requery application logic (bug 1317918)
Cause:  Requerying application logic does not work. Thus for example, when 
editing a workarea to include an old version of a table, any application logic 
associated with the table is not requeried. If you edit the application logic, you 
may see a message to the effect that the logic is out of date.

Action:  Do any of the following:

■ Choose File > Change Connection and reconnect to the repository.

■ Choose File > Change Workarea and reselect the workarea.

■ Choose a different Navigator tab in the Design Editor, then reselect the 
original tab.

■ Restart the Design Editor.

Copy With New Language does not work for modules from the Repository Object 
Navigator (bug 1317853)
Cause:  In the Repository Object Navigator, if you select a module, choose Utilities 
> Designer > Copy with New Language, select a language and then select OK, 
the message "CDR-00114: Container context has not been set" is displayed.

Action:  Run the utility from the Design Editor (choose Utilities > Copy with New 
Language). 

Unable to commit captured queue and queue table (bug 1290408)
Cause:  Design capture of a persistent queue and corresponding queue table into a 
database user that has no queue table implementations may result in a CDA-02186 
error during validation.

A database user must have a queue table implementation if a persistent queue 
implementation references the database user with its "Queue Table Database User" 
property. Since these objects are put forward for validation in an undefined order 
following design capture, the database user may not have a queue table 
implementation when the persistent queue implementation is validated.

Action:  Design capture the queue table(s) first then invoke design capture again 
for the persistent queue(s). 
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OLE Problems (bugs 1114261, 951673, 837571, 781670, 755568, 636409, 625193, 595590, 
529856, 373015)
Cause:  There are many reported problems using OLE to embed objects in 
Designer diagrams, or to embed Designer diagrams in other applications.

Components affected:

■ CASEDE - Design Editor

■ CASEDFD - CASE Dataflow Diagrammer

■ CASEFHD - CASE Function Hierarchy Diagrammer

■ CASEERD - CASE Entity Relationship Diagrammer

■ CASEPM - CASE Process Modeler

Action:  Use OLE sparingly

Do not embed too many objects in Oracle Designer diagrams.

Use Edit > Paste, rather than Edit > Paste Special or Insert > Object if you wish to 
include a diagram in (for example) a Microsoft Word document.

Overlapping text in Process Modeler diagrams (bug 995298, 627818)
Cause:  Descriptions and labels may overlap when laid out by the Process 
Modeler.

Component Affected: CASEPM - CASE Process Modeler

Action:  Manually move the overlapping text, or use shorter text if possible.

Diagram graphics can become corrupt after invoking versioning utilities (bug 
897686)
Cause:  This can occur in the following scenario:

1. Invoke one of the Utilities under the Version menu.

2. Invoke a diagrammer if not already open.

3. Click on the Select Icon.

4. Drag a selection area over the diagram and you will notice that a horizontal 
and vertical line appears (as well as the dotted selection area rectangle) This is 
common across all of the tools.

Components Affected:

■ CASEDE - Design Editor

■ CASEDFD - CASE Dataflow Diagrammer

■ CASEFHD - CASE Function Hierarchy Diagrammer

■ CASEERD - CASE Entity Relationship Diagrammer

■ CASEPM - CASE Process Modeler

Action:  Restart the tool.

Note: Some extra exception handling has been added to the 
diagrammers to handle OLE errors during diagram open. This will 
enable some diagrams to be partially recovered, which would not 
have been possible in earlier releases.
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Print Scaling (bugs 896032, 674453, 481734)
Cause:  When you scale a diagram on the Print dialog box, the diagram does not 
always print correctly.

Components Affected:

■ CASEDFD - CASE Dataflow Diagrammer

■ CASEFHD - CASE Function Hierarchy Diagrammer

■ CASEERD - CASE Entity Relationship Diagrammer

Action:  No workaround is currently available.

Design Capture of Server Model results in error "CDI 22051 - TABLES 
OVERLAPPING ON DIAGRAM" (bug 749724)
Cause:  If you capture a large schema and display the results on a diagram, 
autolayout may be unable to resolve some overlaps.

Component Affected: CASEDE - Design Editor

Action:  Capture the design without enabling Show Results on new Server Model 
Diagram (on the Source tab of the Capture Server Model from Database dialog 
box), then include the server model definitions on the diagram a few at a time.

Batch Generation doesn't work for Menu Modules (bug 745824)
Cause:  You cannot generate Forms Menu Modules with the batch interface.

Component Affected: CASEDE - Design Editor

Action:  Use the generator from within Design Editor.

Using a plotter (bugs 660322, 344117)
Cause:  There are a number of reported problems using a plotter (i.e. a vector 
device) as opposed to raster device (most printers).

Components Affected:

■ CASEDE - Design Editor

■ CASEERD - CASE Entity Relationship Diagrammer

Action:  Make sure you have the most up to date driver for your plotter. If the 
plotter driver supports raster to vector conversion, the results will be better. Avoid 
using custom colors in your diagram.

Layout problems in Module Diagrammer for Components with two masters (bug 
463149)
Cause:  If a module component has two masters, layout can be poor.

Component Affected: CASEDE - Design Editor

Action:  No workaround is currently available.

Best Fit Selection (bug 326606)
Cause:  Edit > Select All, followed by Best Fit Selection may result in the diagram 
becoming very small in the center of the current window.

Component Affected: CASEFHD - CASE Function Hierarchy Diagrammer

Action:  Instead of Edit > Select All, choose Edit > Select and then Select All from 
within the dialog box. In this case the Best Fit works. 
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Undo Autolayout not enabled (bug 315136)
Cause:  The Undo layout option is not always enabled until autolayout has been 
performed a number of times.

Component Affected: CASEDFD - CASE Dataflow Diagrammer

Action:  No workaround is currently available.

11.1.3 Database Design Transformer
Entities mapped to views

If a selected application system contains entities that you have mapped to views, these 
will be removed when the Database Design Transformer starts. You will be asked to 
confirm each removal with a dialog box which states that a table entity mapping will 
be removed.

Running the Database Design Transformer from the Entity Relationship 
Diagrammer locks diagrams (bug 1662205)
Cause:  Entity relationship diagrams become inaccessible if the Database Design 
Transformer is opened from the Entity Relationship Diagrammer.

Action:  Do one of the following:

■ Close the Entity Relationship Diagrammer before opening the diagram.

■ Do not run the Database Transformer from the ERD. Run it from the front 
panel.

11.1.4 Form Generator
To run generated forms locally after an Oracle Developer Suite installation:

1. Ensure that JInitiator has been installed on the client.

2. Start the Oracle Containers for J2EE (OC4J) instance by running the file 
startinst.bat (oracle_home\j2ee\Oracle9iDS\startinst.bat).

3. Generate the Form module.

4. Run the Form.

The specified browser will display the form.

To run generated forms locally after an Oracle Application Server installation:

1. Ensure that JInitiator has been installed on the client.

2. Set the Form Generator preference WEBURL to appserver_host_
name:port/forms90/servlet.

3. Generate the Form module, noting the location of the generated .fmx file.

4. Create a sub-folder in the forms90 folder of the Oracle Application Server Oracle 
home (on the client where Oracle Application Server is installed).

5. Locate the generated .fmx file and move it into the sub-folder that you created in 
the previous step.

6. Open the file default.env (appserver_oracle_
home\forms90\server\default.env) in a text editor.

7. Uncomment the section "Forms90_Path" and add to it the path for the sub-folder 
where your .fmx file now resides.
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8. Save and close the default.env file.

9. Start your web browser (preferably Internet Explorer) and enter a URL in the 
following form:

app_hostname:port
/forms90/servlet/?form=form.fmx&userid=user/pwd@connect

The generated form will run in the web browser

OCX/OLE item types in Oracle Designer (bug 1978769)

It is possible to model an item of type OCX Control or OLE Container, but these types 
are now generated as a text item. Warning message 39 is issued when such generation 
is attempted.

Generating Form-level triggers at lower levels is no longer valid (bug 2037694)

For Oracle Forms, restrictions have been added for some triggers. The following are 
now only permissible at form or block level:

WHEN-CLEAR-BLOCK
WHEN-CREATE-RECORD
WHEN-DATABASE-RECORD
WHEN-NEW-RECORD-INSTANCE
WHEN-REMOVE-RECORD

The following is now only permissible at form-level:

WHEN-NEW-FORM-INSTANCE

Previously it was acceptable to create these triggers additionally at block or item level. 
Although Oracle Designer still supports this at the design stage, you should not use 
this facility.

Number of characters in names used in generation (bug 2061520)

Although the number of characters allowed for object names in Oracle Designer is 
nominally 30, eight of these are required for the prefix that is added during generation. 
This means that the practical maximum number of characters for an object name is 22.

Oracle Forms menu substitution parameters (bug 2067988)

Menu substitution parameters are not supported by Oracle Forms from version 9i 
(9.0.4) onwards. Because of this, Oracle Designer is unable to support generation of 
user-defined menu substitution parameters. From Oracle9i Designer onwards, any 
user-defined menu parameter (for instance, myparm) will simply appear in the menu's 
command line (that is, :myparm), with no run-time support. Oracle recommends that 
you replace the use of these parameters with other code/methods for achieving the 
same results.

Form generation with preserve layout option is not possible when there are 
sub-components (bug 1317873)

Generation preserving layout does not work with sub-components.

Names of tables, unique names

The Generator requires that the names of tables and their keys be unique within the 
first 21 characters. The table names are used to create names for program units, which 
are limited to 30 chars.



General Issues and Workarounds

Oracle Designer 11-11

The generator prepends the following example text when naming program units to 
support various areas of functionality:

CGRI$CHK_table_name or CGRI$DEL_table_name

Generate Preserve Layout does not support Blocks on Tabs layout functionality

It is not possible to preserve layout when modifications are made because the 
inclusion and dimensions of one block affect the sequence and dimensions of the 
others. If a form with Blocks on Tabs is generated in preserve layout mode, it may not 
run correctly. An alternative is to modify the form by hand, capture the design back to 
the repository and generate again.

Object Library Names

The standard object libraries shipped with the Oracle Forms generator have not 
changed names between releases 6i, 9i and 10g. A form generated with release 6i may 
not compile if compiled with the 9i or 10g object library (and vice versa). This may 
cause confusion if a user has .FMB files generated from both these releases in one area.

Preferences ITMMPW and ITMPPE

The preferences ITMMPW (minimum permitted width) and ITMPPE (permitted 
percentage expansion) are now applied to block titles, so if they are set at module or 
module component level they may add extra room to existing titles potentially 
changing the layout.

11.1.5 Web PL/SQL Generator
New "Concealed data" display type: the Web PL/SQL Generator library (WSGL) 
must be reinstalled

During generation, Web PL/SQL Generator makes use of the WSGL PL/SQL library 
package of procedures, functions and constants. This package has been reconstructed 
to incorporate the new "Concealed data" display type and must be reinstalled if you 
want to use this facility.

The package specification file is wsgl.pks and the package body is wsgl.pkb. Both 
files appear in the CGENW61\CVWETC directory of your Oracle Designer installation 
and they must be installed on the PL/SQL Toolkit schema. Instructions are contained 
in the help topic "Setting up the PL/SQL Toolkit schema".

DAD (database access descriptor) configuration for Web PL/SQL generated modules 
with Single Sign On (bug 2288798)

Even though the WSGSSO package provides SSO authentication to your WSG 
applications, the DAD used to access your generated applications should use "Basic 
Authentication" as its authentication mode.

This is because generated applications using the WSGSSO security package cooperate 
with the SSO server for authentication, but still use their own set of user and 
responsibility tables.

Note: For information on how to set up DADs, refer to the Oracle 
Application Server administration documentation.
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Port number required for setup of Portal Single Sign-On with Oracle Application 
Server

When setting up OracleAS Portal single sign-on (SSO) in an Oracle Application Server 
environment, you will need to specify a port number. This port number must be the 
one specified in the virtual hosts section of the HTTP server page of Oracle Enterprise 
Manager.

This port number will be required:

■ when adding partner application on the OracleAS Portal instance, for the home 
URL and the success URL

■ when editing REGAPP.SQL, for the value of p_listner_token (for example, 
devweb.uk.oracle.com:3340)

■ when specifying the Web PL/SQL Generator option "Web Agent URL" (for 
example, http://devweb.uk.oracle.com:3340/BASIC902_DAD/)

Additionally, the Portal administrator, after creating the appropriate DAD, has to give 
the Web Agent URL with the correct port number to the Portal user.

Error Message PLS-00593
Cause:  Error message PLS-00593 ("Default value of parameter P_REFRESH_URL 
in body must match that of specification") is displayed during the creation of WSG 
single sign-on packages.

Action:  Manually change the default value of P_REFRESH_URL in WSGSSO.PKB 
to WSGSSO_CONSTANTS.G_CANCEL_URL, then rerun WSGSSO.SQL.

11.1.6 Report Generator, Design Capture and Application Logic Capture
Report Generator restriction on module short name and implementation name

Currently there is a restriction imposed by the Report Generator on the module short 
name and implementation name which means they cannot contain any spaces. This 
causes generation to fail with the following error :

CGEN-03448 ERROR: Module: Name is not a valid Oracle name; try 
'module_name'

where module_name is the name of the module without spaces.

The workaround is to make sure that the module short name and implementation 
name do not contain spaces.

Unable to capture ORDER BY clause from RDF files

The design capture tool does not support capturing of ORDER BY sequences where 
the syntax is based on a number relating to the item order in the select statement, for 
example:

select empno, deptno, job from emp order by 2;

Here the ORDER BY sequence is based on deptno; however it will not be recovered.

If the select statement is in the following syntax the ORDER BY information will be 
recovered:

select empno, deptno, job from emp order by deptno;
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Do not modify generated tags prior to application logic recovery

Report Generator includes a tag in a generated program unit to identify the repository 
element for which the event or named routine was defined. When capturing 
application logic, Report Generator uses this tag to associate application logic with the 
correct repository element.

If you modify or remove the tag and attempt to capture the application logic, Report 
Generator is unable to identify the repository element associated with the captured 
application logic. Report Generator therefore associates the captured application logic 
with a repository window definition.

If you intend to capture a generated program unit, do not modify or remove the tag 
embedded in generated program units.

Hint: If you intend to add user application logic using Report Builder, Oracle 
recommends that you create a skeletal event code segment or named routine for the 
appropriate repository element. When you generate the report, Report Generator will 
generate the code and include a valid tag. You can then use Report Builder to modify 
the code. During design capture, Report Generator will capture the application logic 
and use the tag to assign it to the correct Repository element. If you do not define the 
application logic in the Repository to begin with, a valid tag will not exist and Report 
Generator will capture the application logic and associate it with the window 
definition.

Indication of modified generated application logic

You can modify generated application logic in Report Builder. To retain this modified 
application logic during subsequent generations, you must capture it into the 
repository. By default, Report Generator does not capture generated application logic 
unless you indicate that you have modified it.

To indicate that you have modified generated application logic, add one or more 
alpha-numeric characters (not a space) between the comment symbol (--) and the 
start of the generated tag.

For example, the line containing the generated tag might appear as follows:

--  CG$PV0001.5642752

To indicate that you have changed this application logic and that it is to be captured, 
you might change the tag as follows:

-- modified CG$PV0001.5642752

Report generation may fail when attempted from the batch generation tool (bug 
2106132)
Cause:  You cannot generate reports from the batch generation tool if forms are 
also generated in the same batch.

Action:  Generate Reports and Forms separately.

Header and footer sections in reports templates no longer available (bug 1386933)
Cause:  Up to Designer 2.1.2 you could apply header, body and trailer templates to 
Reports. However, because of the changed functionality of Oracle Reports 6.0 
onwards you can no longer use templates on report headers and trailers.

Action:  No workaround is currently available.
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11.1.7 Server Generator
Not all features are suitable for generating to all databases

Oracle Designer allows you to model many sophisticated database features. However, 
not all of these can be implemented in every database type. If you generate a feature 
that is not supported by your chosen database type, you will see an error message.

Default values for columns cannot be derived from user-defined functions (bug 
2030889)

Oracle Database does not allow the default value for a column to be derived from a 
user-defined function. In the Design Editor, if you create a table with such a column, 
the table is created without any apparent error, but while generating the design to the 
database, the generator fails, stating that user-defined functions are not allowed as 
default values.

ODBC drivers for Server Generator

To connect to Microsoft SQL Server 7.0, use the Microsoft SQL Server ODBC driver 
that is supplied with the SQL Server 7.0 client software. (Server Generator has been 
tested with SQLSVR32.DLL version 3.70.06.23).

When specifying the logon details for an IBM DB2/MVS v5 ODBC connection, the 
username must be entered in uppercase to be able to see any objects for a server model 
capture. (see bug 1314224)

When connecting to DB2/MVS v5, use the IBM DB2 ODBC driver to connect. (see bug 
1314307)

Server Generator provides connections to online databases using either ODBC or the 
Oracle Network layer.

During testing it has been found that using an old driver designed for an earlier 
version of an RDBMS can produce unpredictable behavior, such as a failure to 
recognize legitimate types or syntactic constructs introduced with the newer RDBMS.

Oracle recommends that you obtain ODBC drivers for non-Oracle databases from 
either the database provider or a specialist supplier.

Using Server Generator with a Sybase System 11 database

A patch from Sybase (ref. EBF 7704) must be applied to Sybase clients before 
attempting access to Sybase System 11 databases for generation or capture. If this 
patch is not applied, the Design Editor can terminate unexpectedly. 

Generate Distributed Capabilities Doesn't Work (bug 771052)
Cause:  Server Generator does not generate synonyms that reference objects across 
database links. Therefore the Generate Distributed Capability check box on the 
Database Generator Options dialog box has no effect.

Action:  No workaround is currently available.

Replication Group Generation From Design Editor Doesn't Generate Correct Files 
(bug 675058)
Cause:  Server Generator does not generate code for Master Replication Groups or 
Replicated Groups. Therefore the Generate Replication Statements check box in 
the Generate Database Administration Objects dialog box, and the Assign 
Objects to Replication Code check box in the Database Generator Options dialog 
box, have no effect.

Action:  No workaround is currently available.
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It is possible to open the same server model diagram twice (bug 641532)
Cause:  The same server diagram can be open any number of times in the server 
diagrammer in the Design Editor.

Action:  Open each diagram only once.

11.1.8 Repository Reports
Default date format

The following situations are all resolved by explicitly setting the default date format to 
"DD-MON-YYYY". To do so, choose Options > General Settings in the Design Editor 
or Repository Object Navigator and enter this value in the Date Format field.

■ On a newly installed repository, the factory default date setting is 
"DD-MON-YYYY". However, unless you explicitly set this date format manually, 
Repository Reports uses a default date format of "DD Month YYYY" (large gap 
between month and year).

■ If you enter a date in the format "DD-MON-YY" and either select another 
parameter with the mouse or immediately run the report, no validation warning is 
shown for the correct date format of "DD-MON-YYYY". The validation message is 
shown only if you press Tab on the date field or run the report subsequently. Even 
after the validation message, the report can be run with dates specified (for 
example) as "01-Jan-99" which is converted to "01 January 0099" (bug 1308455). 

■ No validation is performed if the parameter value for a Start Date is later than that 
for an End Date (bug 1308455).

■ If you change the date format in the Design Editor or Repository Object Navigator 
to "DD-MON-YY" and then invoke Repository Reports, the reports become 
non-Y2K compliant. No validation for date format is performed, and no output is 
produced even if you enter dates in the format "DD-MON-YYYY".

11.1.9 Matrix Diagrammer
Matrix Diagrammer: invoking the VHV from a matrix diagram

When you try to start the VHV from a matrix diagram the first time, the following 
error is displayed:

CDR-03103: Attempted Diff/Merge but ran out of memory.

The workaround is to invoke the VHV from elsewhere in Designer. 

Matrix Diagrammer: some element types cannot be created, updated, deleted or 
versioned

Using Matrix Diagrammer, you cannot create, update, delete or version containers, 
workareas or configurations. Also, you cannot create or delete configuration 
memberships between elements and configurations.

The workaround is to use the Repository Object Navigator to perform these 
operations. 

Matrix Diagrammer GPFs when the intersection if a foreign key (bug 1456480)

When the intersection is a foreign key, for example if you select Table Definition vs 
Relational Definition, the Matrix Diagrammer GPFs. It works correctly when the 
intersection is not a foreign key.
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11.1.10 Accessibility
General (bug 2023560)

In Microsoft Windows 2000, mnemonics (the underscores that indicate a shortcut) do 
not appear in a dialog or menu in Oracle Designer until the ALT key has been pressed. 
(See also bugs 1522303 and 1962540.)

Form Generator (bug 2055467)
Cause:  There is limited keyboard access to generated navigation action items.

Action:  Set the focus on action items by using the menu option Block > Next. 
Then use the Enter key to select an item.

Repository Reports (bug 1549890)
Cause:  When using the Repository Reports navigator, and when the focus is 
moved between different nodes, JAWS sometimes reads out inappropriate prose.

Action:  This problem will not occur if the navigator is not accessed using the 
mouse.

Design Editor (bug 1549933)
Cause:  When using the navigator in the Design Editor, pressing INSERT+UP 
ARROW sometimes causes JAWS to behave inappropriately.

Action:  This problem will not occur if the navigator is not accessed using the 
mouse.

11.1.11 Other problems and restrictions
Copyright

Please note that where you see Copyright 2002 this is also covered by Copyright 2003.

Export of repository data requires appropriate version of Import and Export utilities 
in different Oracle home

If you wish to export any repository data, you must install and use the appropriate 
version of the Oracle8i Import and Export utilities (IMP & EXP) against your 
repository. That is, you must use the 8.1.6 utilities for an 8.1.6 database and the 8.1.7 
utilities for an 8.1.7 database. These utilities must not be installed into the same Oracle 
home as Oracle Repository.

Limitations when using Oracle Designer/Oracle Developer Automation

In some circumstances, you may not be able to get an instance of Oracle Forms 
Developer running from the Design Editor. For example, if you click on the action item 
list, after generation of a form, and choose the option to run Form Builder, nothing 
happens, that is, Oracle Forms Developer does not open. In this case, you should 
change the following entry in the registry file from:

HKEY_CLASSES_ROOT
\CLSID\{4271DF00-B54A-11CF-864B-0020AF1D40D7}
\LocalServer32 
ifbld90.exe /AUTOMATION

to

HKEY_CLASSES_ROOT
\CLSID\{4271DF00-B54A-11CF-864B-0020AF1D40D7}\LocalServer32
oracle_home\ifbld90.exe /AUTOMATION
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Generating forms in non-English environments

After generating a form in a non-English Oracle Designer environment, you will need 
to compile and run the form externally using Oracle Forms Developer.

Screen resolution types

Oracle Designer can be run under SVGA (recommended) or VGA.

System font size

Oracle recommends that you set the system font size to Small Fonts (Control Panel > 
Display > Settings > Font Size).

SQL or PL/SQL reserved words

It is possible to create instances of elements with names that are SQL or PL/SQL 
reserved words. Users should beware of this where these element names are likely to 
be used in SQL or PL/SQL statements. Also, if a systems modeling element is created 
with a name that is a SQL or PL/SQL reserved word, it may not be possible to 
transform it into a systems design element.

ORA-12514 Message not found
In some circumstances message ORA-12514 is displayed without its intended text. The 
message should read ORA-12514 : TNS:listener could not resolve 
SERVICE_NAME given in connect descriptor

Cause:  The SERVICE_NAME in the CONNECT_DATA was not found in the 
listener's tables.

Action:  Check to make sure that the SERVICE_NAME specified is correct.

This error will be returned if the database instance has not registered with the 
listener; the instance may need to be started.

11.2 Platform-specific Issues and Workarounds
There are currently no platform-specific issues

11.3 Configuration Issues and Workarounds
There are currently no configuration issues.

11.4 Administration Issues and Workarounds
There are currently no administration issues.

11.5 Documentation Errata
There are currently no known problems with the documentation.
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12
Oracle Software Configuration Manager

This chapter discusses the following Oracle Software Configuration Manager (SCM) 
topics:

■ Section 12.1, "General Issues and Workarounds"

■ Section 12.2, "Known Problems and Restrictions"

■ Section 12.3, "Known Restrictions to Keyboard Controls"

■ Section 12.4, "Platform-specific Issues and Workarounds"

■ Section 12.5, "Configuration Issues and Workarounds"

■ Section 12.6, "Administration Issues and Workarounds"

■ Section 12.7, "Documentation Errata"

12.1 General Issues and Workarounds

12.1.1 Patchsets
The Oracle Software Configuration Manager development team are committed to 
producing regular patchsets following the release of Oracle Developer Suite 10g (9.0.4). 
The latest SCM patch sets are made available on OracleMetaLink 
(http://metalink.oracle.com). Go to patches, then enter the patch ID (if known) 
or alternatively search Product or Family "Oracle Designer - Repository Family". For 
additional information about availability and compatibility of the latest releases, see 
Support note:60705.1.

Oracle Designer/SCM Patchset 9.0.4.3: immediate installation may be required

Important: If your repository has been installed or upgraded via the repository 
administration utility (RAU) that came with Oracle Designer/SCM release 9.0.2.7, you 
must immediately patch all Oracle Designer 9.0.4.2 clients by applying the Oracle 
Designer/SCM patchset 9.0.4.3.

Oracle Designer/SCM 9.0.4.2 works against an earlier version of the repository that 
came with Oracle Designer/SCM 9.0.2.6 and will not work against a later repository 
from Oracle Designer/SCM release 9.0.2.7. Oracle Designer/SCM patchset 9.0.4.3 (a 
maintenance release) patches your 9.0.4.2 installation allowing it to connect to the 
9.0.2.7 compatible repository.
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If your repository is still at a version compatible with Oracle Designer/SCM 9.0.2.6, 
Oracle Designer/SCM 9.0.4.2 will work with that repository. However, we strongly 
recommend that you install the Oracle Designer/SCM 9.0.4.3 patchset on your 9.0.4.2 
clients and upgrade your repository as soon as possible.

If you wish to create a new repository, then, before doing so, we strongly recommend 
that you install the Oracle Designer/SCM 9.0.4.3 patchset on your 9.0.4.2 installation. 
This will prevent you subsequently having to upgrade it via the RAU when you later 
apply the Oracle Designer/SCM 9.0.4.3 patchset.

12.1.2 Oracle Forms Developer and Oracle Reports Developer Users
There may be product dependencies requiring Oracle Forms Developer and Oracle 
Reports Developer patch sets. Follow Support Notes for any future updates.

12.1.3 Certification against Oracle RDBMS
Current certification details can be checked on OracleMetaLink ( 
http://metalink.oracle.com) by choosing the Certify & Availability option. 

Also, see the "Compatibility of Oracle SCM 9.0.4 and Oracle Repository 6i 
Repositories" section below.

12.1.4 Upgrading from Oracle Designer Release 1.3.2
The earliest previous release from which Oracle SCM provides upgrade is Oracle 
Repository 6.0. Users of the older Oracle Designer Release 1.3.2 wishing to upgrade to 
Oracle SCM will therefore need to upgrade to Oracle Designer 6.0 first. The following 
alternatives exist for locating the upgrade to Oracle Designer 6.0:

■ If Oracle Designer 6.0 is installed, the upgrade from Oracle Designer 1.3.2 can be 
invoked from the Oracle Designer 6.0 Repository Administration Utility.

■ The upgrade CD in the iDS 1.0.2.4 pack contains Oracle Designer Release 1.3.2 to 
6.0 upgrade.

■ The Oracle Designer 1.3.2 to 6.0 upgrade can be obtained from OracleMetaLink.

12.1.5 Multi-Language Environment
When you install Oracle SCM, you can select a combination of different product 
languages to install on the same computer. If you select Japanese as one of these 
languages (for example, a selection of Japanese, Korean and English), you should be 
aware that the user interface (translations) will be in Japanese, and this cannot be 
altered by changing the NLS language on the client computer. If you do not select 
Japanese (for example, if you select Chinese, Korean and English), the user interface 
will be in English. Therefore, if you do not require the user interface to be in Japanese, 
then you should not select Japanese as one of the product languages.

If you select Japanese as one of the product languages, you should verify that a 
Japanese font has been installed.
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12.1.6 Compatibility of Oracle SCM and Oracle Repository 6i Repositories
Details of compatibility of Oracle Repository 6i and Oracle SCM repositories can be 
found in support note 60705.1, available on OracleMetaLink.

To read the support note:

1. Log in to OracleMetaLink (http://metalink.oracle.com)

2. Enter the note number in the Search field and select Advanced.

3. Select the DocID option and select Search.

4. Select the document title.

12.1.7 Changes from the Previous Release (iDS 9.0.2 maintenance release 9.0.2.5)
New feature: Instrumentation Report

Navigation:

RAU->HELP MENU->Instrumentation Report

Intended use by:

Designer/Repository Administrators, other DBAs and Oracle Support 

Prerequisites:

Repository Administration Privileges, connection to the Designer schema instance 
(established via the RAU). An HTML Browser is required to view the output.

Feature Summary

This report is intended to assist with the diagnosis and resolution of common 
problems. The HTML output produced is mainly server and repository related 
although some of the client registry settings are also reported.

Typically you may be experiencing a problem as a result of one or more of the 
following:

■ Designer schema installation, upgrade or migration setup 

■ Designer schema invalid, missing or disabled schema objects

■ Tablespace storage issues

■ Missing system privileges or grants

■ Invoking import/export or SQL*Plus utilities

If you are experiencing problems in these areas the report may help you to quickly 
identify and resolve the problem. An Oracle Support representative may also ask you 
to run the report and supply the output for further analysis.

The RAU will attempt to display the report in an appropriate HTML browser, 
provided your client is set up to use one. Otherwise the output files can be found in 
the respective oracle_home\REPADM61\LOGS directory.

You may also want to run this report after an installation, upgrade, or as part of your 
standard maintenance tasks, just to provide a general "health check" status of the 
schema.
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Further Information

Please refer to the online help for further information on this feature.

Other changes from the previous release of Oracle Repository 6i are bug fixes.

The registration feature (transfer of an existing Oracle schema into the repository) is 
still available, but has been de-supported.

12.1.8 Fixed Bugs
A list of the bugs that have been fixed in this release of Oracle SCM is available on 
OracleMetaLink. To see the fixed bugs:

1. Log in to OracleMetaLink (http://metalink.oracle.com).

2. Click the Bugs button on the left of the screen.

3. In the Bug Database Search dialog:

a. From the Product list, select Oracle Repository (the bug database uses the old 
product name).

b. From the Status list, select one of the "Closed" options (e.g. "Closed, verified 
by filer").

c. In the Fixed in Version field, enter a product version number to search (e.g. 
"9.0.2%").

d. Enter values in any other fields to restrict the search as required.

e. Click the Search Bugs button.

12.1.9 API and Model Reference Guide
The API and Model Reference Guide is available on the Oracle Technology Network 
(http://otn.oracle.com). From the navigator frame on the left of the screen, 
choose Documentation > Oracle SCM (Repository) > Repository API and Model 
Reference Guide.

12.2 Known Problems and Restrictions
This section documents known problems and restrictions for:

■ Section 12.2.1, "Migration"

■ Section 12.2.2, "SCM Java Tools"

■ Section 12.2.3, "Repository Administration Utility (RAU)"

■ Section 12.2.4, "Repository Object Navigator"

■ Section 12.2.5, "Compare Utility"

■ Section 12.2.6, "Merge"

■ Section 12.2.7, "Version History Viewer"

■ Section 12.2.8, "Version Event Viewer"

■ Section 12.2.9, "Importing and Exporting"
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■ Section 12.2.10, "Dependency Manager"

■ Section 12.2.11, "Command Line Tool"

■ Section 12.2.12, "Other Known Problems and Restrictions"

12.2.1 Migration

ERROR: 'ORA-02063: preceding 2 lines from R212', encountered during 
migration from Designer 6.0 to 6i/9i (bug 2758364)
Cause:  The following error has been reported during the migration process, 
during the stage CK_UPGRADE_MOD:

ORA-02063: preceding 2 lines from R212

..

RME-02124 Failed to execute SQL statement: begin ck_upgrade_
mod.init(:b1, b2);

end;

Note, It is also possible that other similar errors may also occur at different stages 
of the migration process.

Sometimes the problem can be resolved by clicking on the retry button on the 
RAU control panel, or restarting the migration at the point of failure after shutting 
down and restarting the instance, but if this is a persistent problem then it could 
be related to the fact that the source or target instances may not be setup correctly 
(see below).

Action:  If such an error occurs it may be as a result of insufficient open cursors 
setting on the source Designer 6.0 instance.

You can verify this by looking in the init.ora parameter file to see the settings 
for open_cursors, if one does not exist then the default which is 50 will be used.

Try running the following SQL command from SYS to verify this (8.0.x):

SQL> select NAME, VALUE
2 from V$PARAMETER
3 where upper(NAME) like 'OPEN_CURSORS' 
/

Name Value
----------
open_cursors 50

Note: it is recommended that you run this SQL as the value in the init.ora file 
may differ to that that has been applied to the instance. On 8i or above you need to 
use the following command:

SQL> show parameter open_cursors

NAME TYPE VALUE
---------------
open_cursors integer 50
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Action:  Please refer to the install guide for your Designer 6.0 instance (chapter 2). 
Depending on your hardware environment you must at least be using the 
minimum recommended settings for open_cursors. For example on a PC, open_
cursors=400 is recommended as a minimum. To apply the change you must 
shutdown and restart the instance. If this does not resolve the problem please 
contact Oracle support.

It is worth checking all the init.ora parameters match or exceed the minimum 
recommended values in the documentation that came with your product. This is 
true for both Designer 6.0 (migration source instance) and the SCM (migration 
target instance).

User-extended element name conflicts with 9i element name (bug 1386747)
Cause:  When migrating to a Release 9.0.2 or 9.0.4 repository, an attempt to 
migrate a user-extended element with a name that is reserved in 9i (for instance 
"Project") results in the following warning message:

Skipping insert of Element element_ID because ..... Duplicate 
Plural Name

Action:  A workaround is available but please contact your Oracle Support 
representative for assistance with this.

PL/SQL definitions not migrated correctly on multibyte database (bug 2247066)
Cause:  When migrating Designer 6.0 data to a later Designer repository on a 
multibyte database, the text property 'PL/SQL Block' is not migrated correctly for 
PL/SQL definitions of type PACKAGE. No error message will be displayed but, 
after migration, any text in the 'PL/SQL Block' property will have been moved into 
its 'Private Declaration' property.

This bug is a duplicate of bug 2641774, which is in the process of being fixed.

Action:  No workaround is currently available.

12.2.2 SCM Java Tools

SCM Java tools fail to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  Unable to invoke a SCM Java tool when connected to a repository on an 
Oracle9i server. This problem can be encountered when trying to invoke any of the 
SCM Java tools, which are:

■ Command Line Tool

■ Dependency Manager

■ Version History Viewer (VHV)

■ Version Event Viewer (VEV)

■ Compare Utility

■ Merge Utility
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The failure to invoke a Java tool may occur in the following ways:

1. Problem: Java application does not invoke

This occurs when invoking the Command Line Tool from a short cut or from 
the Repository Object Navigator.

2. Problem: [JDK2] No message error at 
...RepositoryConnection.setConnection(RepositoryConnection.java:608) 

This occurs when trying to use the 'connect' command from the Command 
Line Tool.

3. Problem: java.lang.IllegalArgumentException : ErrorDialog: null message 
vector 

This occurs when running the Dependency Manager (ckdm61) from the DOS 
command prompt.

4. Problem: CDR-03120 : Internal Error - Problem making a Repository 
Connection 

This occurs when invoking the VHV, VEV or Compare Utility from the 
Repository Object Navigator.

5. Problem: Connect dialog keeps appearing 

This occurs when invoking the Dependency Manager from the Repository 
Object Navigator or the Oracle Designer Front Panel.

All of these problems stem from the same cause. There is a bug with the thin JDBC 
driver (bug 2346116) such that connections will fail if the length of the connect 
string is in the range 184 - 192 characters. See bugs 2181931 and 2346116 for more 
details.

Note: This happens only when connecting to an Oracle9i server. If connecting to 
an Oracle 8.1.7 server, all possible variations of TNSNAMES.ORA entries that work 
for SQL*Plus and the repository C++ tools will work and allow the Java tools to be 
invoked.

Action:  Ensure that the connect string passed to the JDBC driver is not in the 
range 184 - 192 characters. There are many environmental factors that affect the 
length of this string, for example:

■ database instance name

■ database host name

■ database host domain

■ client computer network name

■ client computer username

■ name of Oracle home directory for Oracle SCM
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Thus there is no simple workaround that will work for all situations. If you 
encounter this problem with a particular TNS alias, the workaround is to change 
the length of the alias entry in the TNSNAMES.ORA file. Increase or decrease the 
length of the entry, preferably by a minimum of 9 characters. The simplest way to 
do this when using Oracle Net configuration tools is to add the domain to, or 
remove the domain from, the hostname, for example:

■ Use host.domain instead of host if you have not previously specified the 
domain.

■ Use host instead of host.domain if you have previously specified the domain.

12.2.3 Repository Administration Utility (RAU)

End of communication channel error in stage CKREPINI during upgrade (bug 
1889920)
Cause:  On Oracle 8.1.7 computers during upgrade, the stage CKREPINI may fail 
with the following error:

end-of-file-communication channel
ORA-24323: value not allowed
Error accessing package DBMS_APPLICATION_INFO
ORA-03114: not connect to ORACLE

Action:  Apply server patch 1408453, taking care to download the patch specific to 
your database version. Once the server has been patched, run 'Full Reconcile' from 
the Repository Administration Utility. This will rerun the stage CKREPINI, which 
will now succeed.

Subordinate users must be explicitly enabled to do migration
Cause:  In previous releases of the Repository Administration Utility, subordinate 
users were able to perform migration as well as the repository owner. This has 
now been changed so that, by default, only the repository owner can run the 
Migration utility. However, some sites may still wish to allow subordinate users to 
perform migration.

Action:  In the Repository Administration Utility, the repository owner can 
explicitly grant a subordinate user access to the Migration utility by enabling the 
"Migration Utility (RAU)" checkbox on the Repository User Properties dialog for 
that user.

Need to do a reconcile after a UE remap, but not told to do so (bug 1304800)
Cause:  In the Repository Administration Utility, no reminder is displayed about 
performing a full reconcile after remapping an existing user-extended element 
type.

Action:  Always perform a full reconcile after remapping a user-extended element 
type.
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12.2.4 Repository Object Navigator
Files and Folders

If using only files and folders, you might want to turn off the heading "Files" in the 
Navigator window. To do so, choose Navigator > Show Hide, select Objects in the 
Show Type Headings field and select the Never option button.

Check In Contents

To check in the contents of a workarea or container, choose Version > List Checkouts, 
select the sub-context and click OK. In the List Checkouts dialog box, click Select All, 
then click Check In.

Purge

Note that if you purge versions from a workarea, prior versions, or other versions 
depending on the appropriate workarea compilation rule, will not appear until the 
workarea is refreshed.

Memory usage when running Java utilities from the Repository Object Navigator

The Compare and Merge utilities, and the Version History Viewer and Version Event 
Viewer are written in Java. The first time one of these tools is invoked, a Java Virtual 
Machine (JVM) is started within the Repository Object Navigator process. It will then 
appear that the Navigator is using a great deal more memory. The JVM is not shut 
down until the process ends, so this memory usage will not decrease until the 
Repository Object Navigator is shut down, even though the tool window may have 
been closed.

The memory parameters used by the JVM at startup can be controlled by registry 
settings. Memory allocations may need to be increased or adjusted depending on 
usage and the host environment. You can do this by changing the values of the 
following Windows registry variables, all of which are shown in bytes under the 
following registry keys:

■ Key HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEn\REPADM61

■ JVM_NATIVE_STACK_SIZE

■ JVM_JAVA_STACK_SIZE

■ Key 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEn\REPADM61\
DEFAULT_JVM_PARAMS_THIN_JDBC

■ JVM_MIN_HEAP_SIZE

■ JVM_MAX_HEAP_SIZE

(where HOMEn is home number of the home installed into for a multiple Oracle home 
environment, but is not present where the default Oracle home is being used).

There is also a problem in that the memory used by each invocation of one of these 
Java tools is not completely freed up. This may result in out-of-memory conditions 
arising after many invocations. If this happens, shut down and restart the Repository 
Object Navigator, or invoke the utilities from the Command Line Tool, which runs in 
its own JVM.
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Edit File Registry: default for %.DOC and %.doc (MS Word) should be binary (bug 
1321896)
Cause:  In the Repository Object Navigator, the default rule in the file registry is 
Text File for files with .DOC or .doc extensions, but on Win32 computers these 
extensions are most likely to be used for MS Word files, which are binary.

Action:  From the Utilities menu, choose Edit File Registry and use the Edit Rule 
option to change the rule to Binary File for files with these extensions.

Unable to connect to VHV, VEV, Dependency Manager and Compare utilities when 
client and repository are on same computer (bug 2028385)
Cause:  If you are using the Repository Object Navigator and are connected to a 
repository on the default database of the local computer (i.e. connected as 
repos/manager with no connect identifier specified), you will not be able to 
invoke the VHV, VEV, Dependency Manager and Compare utilities.  The following 
error will be displayed:

CDR-03120  :  Internal Error - Problem making a repository 
connection.

The Command Line Tool will  invoke and immediately close down. If you invoke 
the Command Line Tool directly and try to connect to a repository on the default 
database of the local computer you will get a Java error.

Action:  Connect to the repository on the default database of the local computer by 
specifying a Net8 alias e.g. repos/manager@local, where local has been set 
up as an alias or Net8 connect identifier for the local database by Net8 
Configuration.

Import fails due to conflicts in user extensions between source and target 
repositories (bug 2088494)
Cause:  In the Repository Object Navigator, the import of an application system 
may fail with an error indicating that conflicts have been detected between user 
extensions exported from the source repository and the target repository, and that 
these must be resolved before import can proceed.

Action:  Using the Repository Administration Utility, extract the user extension 
definitions from the source repository and load them into the target repository. 
The import of the application system in the Repository Object Navigator should 
now work.

Repository Object Navigator may hang when invoking VHV for configuration (bug 
2187553)
Cause:  When invoking the VHV for a configuration in the Repository Object 
Navigator, the dialog 'Set Context Workarea' may be displayed and the Repository 
Object Navigator hangs.

Action:  Before invoking the VHV for a configuration, invoke the VHV for any 
other object and then close it. Now, invoking the VHV for a configuration will 
work.

An alternative workaround is to use the Command Line Tool instead of the 
Repository Object Navigator to invoke the VHV for the configuration. The 
Command Line Tool will prompt the user to set the workarea context but, once 
this has been done, the VHV for the configuration will be successfully invoked.
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Copy of ORACLE_DATABASE element fails (bug 960764)
Cause:  If using a repository on an Oracle9i server, attempting to copy an 
ORACLE_DATABASE Designer element can result in the following error:

PLS-00123: program too large

Action:  There is currently no workaround for a repository on an Oracle9i server.

12.2.5 Compare Utility

SCM Java tool fails to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  If the Compare Utility fails to invoke, this may be as a result of a common 
problem shared by other SCM Java tools.

Action:  The full problem description and workaround can be found in 
Section 12.2.2, "SCM Java Tools".

Compare utility may hang after compare of Oracle Forms files (bug 2209993)
Cause:  If the Compare utility has been invoked from the Command Line Tool, it 
may hang after a compare of Oracle Forms files.

Action:  Invoke the Compare utility from the Repository Object Navigator instead 
of from the Command Line Tool and this problem will not occur.

GPF on closing Compare window when invoked from the RON (bug 2019369)
Cause:  When the Compare utility is invoked from the Repository Object 
Navigator, a program failure can occur if the Compare window is maximized, the 
window divide bar is moved and then the close button (x) at the top right is 
pressed.

Action:  Invoke the Compare utility from the Version History Viewer or the 
Command Line Tool and this problem does not occur. Alternatively, if invoked 
from the Repository Object Navigator, do not maximize the Compare window.

Cannot compare or merge .FMB file that was previously merged (bug 1319068)
Cause:  In the Repository Object Navigator or Version History Viewer, an attempt 
to compare or merge a generated .FMB file that has already been merged may fail. 
Messages from the Repository Object Navigator are:

CDR-03100: Diff/Merge internal error: 
java.lang.IllegalStateException (compare)

CDR-03126: Internal Error - Object Delta retrieval (merge)

The message from the Version History Viewer for either compare or merge is:

java.lang.IllegalStateException

Action:  No workaround is currently available.
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Unable to compare versions of a subclassed form that are in the same workarea or 
configuration (bug 1502828)
Cause:  The Compare utility cannot compare versions of a subclassed form that 
are in the same workarea or configuration. In addition, rather than reporting an 
error, the utility sometimes appears to have successfully compared the versions of 
the subclassed form.

A warning dialog box (currently undocumented in the online help) is displayed to 
inform you that that it is not possible to compare in these circumstances. You 
should ignore this warning when not comparing versions of a subclassed form in 
the same workarea or configuration.

Action:  This warning can be turned off by adding a string value to the registry 
key:

HKEY_CURRENT_USER\SOFTWARE\ORACLE\REPOS61\FORMSDM

Create a string value "SUBCLASS_WARNING" with value "FALSE". Any other 
value (or the string not existing) results in the warning being displayed.

Any compare of a subclassed form must be carried out on versions that are in 
different workareas or configurations.

Comparing Oracle Forms

The Compare utility enables you to compare different versions of the same Oracle 
Form file, but not two different Forms files. When comparing files other than Oracle 
Forms, two different files can be compared.

12.2.6 Merge

SCM Java tool fails to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  If Merge fails to invoke, this may be as a result of a common problem 
shared by other SCM Java tools.

Action:  The full problem description and workaround can be found in 
Section 12.2.2, "SCM Java Tools".

Merge window may hang after merge of Oracle Forms files (bug 2209987)
Cause:  If the Merge window has been invoked from the Command Line Tool, it 
may hang after a merge of Oracle Forms files.

Action:  Invoke the Merge window from the Repository Object Navigator instead 
of from the Command Line Tool and this problem will not occur.

Merge Window, clarification on saving changes

After making changes, use File > Save to save your changes. Earlier versions had a 
Save button' which did this.
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12.2.7 Version History Viewer

SCM Java tool fails to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  If the Version History Viewer fails to invoke, this may be as a result of a 
common problem shared by other SCM Java tools.

Action:  The full problem description and workaround can be found in 
Section 12.2.2, "SCM Java Tools".

12.2.8 Version Event Viewer

Date format in Version Event Viewer is incorrect in Japanese
Cause:  Date appears as DD-MON-YY, where DD and YY are both corrupted. 
Occurs only when the Version Event Viewer is called from either the Command 
Line Tool, or the Design Editor, in a Japanese environment, before the RON has 
been invoked.

This also occurs for any client configured to use a NLS language other than the 
default "US".

Action:  

1. Invoke the RON.

2. Navigate to the General Settings panel (Options > General Settings).

3. Type in the default date format that you want to use.

NOTE: You will need to perform this procedure for each client where you intend 
to use the VEV.

SCM Java tool fails to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  If the Version Event Viewer fails to invoke, this may be as a result of a 
common problem shared by other SCM Java tools.

Action:  The full problem description and workaround can be found in 
Section 12.2.2, "SCM Java Tools".

With start date year 99 or older, does not give any data in VEV (bug 1476771)
Cause:  Running the Version Event Viewer with a start date in which the year is set 
to 99 or earlier causes no event data to be displayed in the viewer window.

Action:  No workaround is currently available.

12.2.9 Importing and Exporting

Import/Export in database format - Import or refresh of workarea fails due to 
orphaned object (bug 2166873)
Cause:  Importing into a workarea or refreshing a workarea can fail with the 
following error:

CDR-01062: Compilation leaves file filename orphaned. Need to 
include container
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This may have been caused by deletion of a previously imported folder that 
contained a share of an object, where the original object was not imported and 
does not exist in the workarea. In this situation, it is the share of the object that is 
causing this error.

Action:  Restore the deleted folder from the Wastebasket. Invoke the Command 
Line Tool and reattach the shared object from the Lost+Found container. The 
shared object will now be seen as an original object and can be deleted causing no 
further problems.

Identifier 'SYS.LT_EXPORT_PKG' must be declared when exporting from an 
Oracle9i database (bug 2143951)
Cause:  This occurs when exporting from an Oracle9i 9.0.1 database and the user 
has insufficient privileges. Users with DBA privilege or any of those shown in the 
given workaround will not encounter this problem. (This is fixed in Oracle9i 9.2.)

Action:  Grant any of the following:

GRANT EXECUTE ON sys.lt_export_pkg TO exp_full_database;

GRANT EXECUTE ON sys.lt_export_pkg TO PUBLIC;

GRANT EXECUTE ON sys.lt_export_pkg TO user;

Unable to create a new workarea from the Import Wizard when importing a 
workarea containing a versioned object (bug 1429821)
Cause:  When importing a workarea containing versioned objects into the same 
repository using the option 'Create new version where objects exist in the 
destination repository, otherwise create new objects', the import will fail if you try 
and create a new workarea by specifying a new workarea name in the wizard.

Action:  Create a new workarea with the relevant name before you run the Import 
Wizard.

Import/Export in database format - exported objects may contain dangling 
references

The repository utilities Export and Import in database format are designed to take 
advantage of the universal uniqueness property of the Repository Object Internal 
Identifier. For example an object can be copied from one repository to another using 
Export and Import without having to change its internal identifier.

This feature is used by the Export and Import utilities to allow new versions of objects 
to be copied to other repositories even though the logical identifier or user's identifier 
(e.g. NAME) has changed. It also means that object versions can be exported which 
have references to other objects not included with the export, i.e. an object version may 
contain dangling references. This is not a problem so long as a) a subsequent export or 
import copies in the missing referenced objects, or b) the dangling references are 
resolved, either by deleting that part of the dangling object's structure which includes 
the reference, or by nullifying the reference property.

You should always precede an export operation with a check for external references 
within the set of candidate export objects. For example, a workarea or container may 
include the definition of a module object which references a language object not 
included in the workarea or container.

To resolve dangling references automatically at the target repository, select the 
"Remove dangling references" option on the Advanced Options dialog box in the 
Import Wizard. This option is highly recommended if the Import is creating 'brand 
new objects' as it will not be possible to copy new versions or related versions later on.
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Import/Export in database format - Import utility may require specific repository 
privileges or access rights

For a versioned repository, depending on the kind of export performed, the Import 
utility will execute operations on your behalf which may require certain privileges, for 
instance:

■ Manage Workareas - allows user to create a workarea

■ Compile - allows user to compile or refresh a workarea

■ Version - allows user to create new versions of objects within a workarea

If an error is returned by any of these operations, check that you have the appropriate 
repository privileges (assigned via the Repository Administration Utility) and 
workarea and container access rights (assigned via the Repository Object Navigator).

For a non-versioned repository, none of the above operations apply. The Import 
Wizard will normally detect this case.

12.2.10 Dependency Manager
Dependency Analyzer must be run against Pro*C files not the C files generated by 
the Pro*C compiler

The dependency analyzer should be run on a Pro*C (.pc) file to extract the 
dependencies from the SQL embedded in the file. The analyzer will look at both the C 
and SQL dependencies in the Pro*C file.

If the dependency analyzer is run on a C file generated by the Pro*C compiler, then it 
is likely that the analyzer will fail. This is because the dialect of C generated by the 
Pro*C compiler will trigger one or more underlying bugs in the dependency analyzer 
C parser (e.g. bug 2744718 - DA FAILS TO PARSE SELECT STATEMENT WHEN IT'S 
CONCATENATED WITH '\'). Analyzing the C file generated by the Pro*C compiler 
will also fail to extract the SQL dependencies, as there is no special handling for the 
generated OCI API. If the SQL dependencies are desired, then the Pro*C file itself must 
be analyzed.

C Parser fails to parse if certain preprocessor definitions are used (bug 1411270)
Cause:  If any token used within a PRO*C SQL statement has been #typedeffed 
with the C code or referenced header files, then the parsing of that SQL statement 
will fail.

Action:  Remove the #typedef.

C Parser fails to parse if Pro*C declarations are between function def and body (bug 
1411271)
Cause:  If Pro*C declarations are between a function’s definition and body, the C 
parser will fail.

Action:  Move the declarations.

SCM Java tool fails to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  If the Dependency Manager fails to invoke, this may be as a result of a 
common problem shared by other SCM Java tools.

Action:  The full problem description and workaround can be found in 
Section 12.2.2, "SCM Java Tools".
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Cannot purge dependencies without running out of extents (bug 1317468)
Cause:  Running a purge from the Dependency Manager fails because of lack of 
extents for rollback segment.

Action:  Force dependency purge to use suitably sized rollback segment; only one 
rollback segment (of sufficient size) needs to be available. You can achieve this by 
making all rollback segments offline except for one large rollback segment. See the 
Oracle SCM Repository Installation Guide for instructions to do this.

12.2.11 Command Line Tool
Switching off case matching for object names

The MATCH_CASE session variable can be used to switch on and off the matching of 
case for names of objects. Switching the MATCH_CASE session variable off, using the 
command

set match_case off

command, may degrade performance in larger repositories.

SCM Java tool fails to invoke for some configurations of TNSNAMES.ORA (bug 
2181931)
Cause:  If the Command Line Tool fails to invoke, this may be as a result of a 
common problem shared by other SCM Java tools.

Action:  The full problem description and workaround can be found in 
Section 12.2.2, "SCM Java Tools".

Command Line Tool exits on CTRL-C (bug 976364)
Cause:  When attempting to exit from a long running command, CTRL-C not only 
terminates the command that is running but also the Command Line Tool. All 
outstanding uncommitted changes will be lost.

Action:  Do not use CTRL-C unless you want to terminate the command line 
session completely and you are not concerned about any changes that have not 
been committed.

12.2.12 Other Known Problems and Restrictions
Operating System Authentication (bug 2683221)

The SCM Java based tools, which include:

■ Version History Viewer

■ Version Event Viewer

■ Dependency Manager

■ Command Line Utility

all use JDBC thin client as the mechanism to connect to Repository. As a result these 
tool do not support OS authenticated connections.

Use of public and private synonym access

Public synonym access is recommended only if you have a single Oracle SCM 
repository on the Oracle instance. If you have more than one such repository, we 
recommend that you use only private synonym access for each of them. Avoid the case 
where one repository is using public synonym access and the others are using private 
synonym access since this may lead to unpredictable behavior.
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ORA-12514 Message not found
Cause:  In some circumstances message ORA-12514 is displayed without its 
intended text.

The message should read

ORA-12514 : TNS:listener could not resolve SERVICE_NAME given 
in connect descriptor

The error occurs because the SERVICE_NAME in the CONNECT_DATA was not 
found in the listener's tables.

Action:  Check to make sure that the SERVICE_NAME specified is correct.

This error will be returned if the database instance has not registered with the 
listener; the instance may need to be started.

Configurations based on workareas include elements that do not exist in the 
workarea (bug 1312715)
Cause:  If you create a configuration based on the current contents of a workarea, 
the configuration will consist of the entire contents of the workarea, possibly 
including objects to which you do not have access.

Action:  Either manually remove the inaccessible objects from the configuration 
(e.g. Remove Members in the Configuration Wizard) or create the configuration 
based on the workarea specification rather than the workarea contents (e.g. use 
"from specification" in the Configuration Wizard rather than "from current 
contents").

Modifying workarea fails when workarea rules are more than 30k bytes (bug 
2888993)
Cause:  Creating or updating a workarea will fail if a workarea specification is 
used, whose text exceeds 30K.

You will see one of the following two failures:

■ You will see the following error messages:

ORA-01403: no data found

RME-02124: Failed to execute SQL statement: begin jr_
workarea.define_spec(:wa,:spec); :iserror := 0;   :sqlcode 
:= 0;  exception when others then  :iserror := 1;  
:sqlcode := sqlcode;  end;

■ The workarea update simply does not add the new rule, because if the file is 
bigger than 30000 bytes, only the first 30000 bytes are read, terminating the 
later portion.

Action:  Create a configuration and use it to identify the member versions and 
then base a workarea on this configuration.

Workarea based only on a configuration does not refresh correctly (bug 1152274)
Cause:  This applies when building a workarea based only on a configuration and 
with no check-in branch specified. If you use the workarea to check out and check 
in an object, the object now exists at the revised version. If you attempt to revert to 
the original object version by refreshing the workarea, the object disappears from 
the workarea completely rather than existing at its original version.

Action:  No workaround is currently available.
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Container and workarea uniqueness enforcement (bug 954545)
Cause:  It is possible to create multiple identical objects in the same container 
without raising a uniqueness violation. An object can be created in a container in 
the context of one workarea and an identical object (e.g. with the same name in the 
same container) in the context of another workarea. If a workarea is created (or 
recompiled) which includes both objects (for example by including all objects 
within the container), the name uniqueness rules are violated without an error 
being raised.

Action:  Manually perform name uniqueness check after workarea compilation. 

.RVI files visible on file system

When creating a folder mapping, extra files called .RVI files are created. The 
repository uses .RVI files to store information about which file and folder objects have 
been updated. Do not delete these .RVI files.

Repository restore is unsuccessful in certain circumstances

If a repository containing tables with LOB columns is backed up, the tables with LOB 
columns must be restored to a tablespace with the same name as the original, 
otherwise the restore fails with the message:

ORA-00959: tablespace tablespace_name does not exist

If a repository is restored from a backup that contains tables with columns based on 
types (e.g. SDW_USERS and SDW_ACCESS_RIGHTS) and a type name with the same 
object identifier (OID) as one being imported already exists anywhere in the target 
database, neither the types nor the tables are restored. The following error messages 
are displayed:

IMP-00015: following statement failed because the object already exist: "CREATE 
TYPE ... "
IMP-00061: Warning: Object type "..." already exists with a different identifier
IMP-00063: Warning: Skipping table "..." because object type "..." cannot be 
created or has different identifier

However, if the same type name exists but with a different OID and the IGNORE 
parameter is set to Y, the types are imported followed by the tables.

Everyone has full access to the global wastebasket (bug 1208420)

This unexpected behavior is not known to cause any problems.

Migration issue with different multi-byte character sets
Cause:  If the database that is hosting the new instance is created with a multi-byte 
character set and this is different to that of the database hosting the existing 6.0 
instance, it is possible that during migration errors will occur because character 
data has become too big. For example, if the 6.0 repository used a character set of 
WE8ISO8859P1 but the target database uses UTF8, characters in the range 128-255 
will go from requiring 1 byte to 2 bytes to hold them. This would include all the 
none ASCII characters. If an object in the repository had a name that included such 
a character, and the name was already the maximum length for the column 
definition in which it was stored, the migrated data becomes too large and raises 
an error during migration when it is attempted to be inserted into the new 
repository.

Action:  Follow Oracle's recommendations for changing the character set of the 6.0 
repository database before attempting to migrate.
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Naming convention for user-defined version labels

If checking in to a default checkin branch using user-defined labelling, the version 
label becomes user label.

For information about automatic version labelling, refer to the online documentation.

Screen resolution types

Oracle SCM can be run under SVGA (recommended) or VGA.

System font size

Oracle recommends that you set the system font size to Small Fonts (Control Panel > 
Display > Settings > Font Size).

Copyright

Please note that where you see Copyright 2002 this is also covered by Copyright 2003.

12.3 Known Restrictions to Keyboard Controls
This section documents known restrictions to keyboard controls, and is organized in 
the following sections:

■ Section 12.3.1, "General Keyboard Control Restrictions"

■ Section 12.3.2, "Non-Standard Keyboard Controls"

■ Section 12.3.3, "Known Problems and Workarounds"

■ Section 12.3.4, "Command Line Tool Accessibility"

12.3.1 General Keyboard Control Restrictions
This section documents general keyboard control restrictions.

Dependency Manager

When the Dependency Manager is started from the Repository Object Navigator, 
keyboard focus may be unreliable. Therefore, the Dependency Manager must always 
be started from the Command Line Tool to make full use of the keyboard controls.

Version Event Viewer

When the Version Event Viewer is started from the Repository Object Navigator, 
keyboard focus may be unreliable. Therefore, the Version Event Viewer must always 
be started from the Command Line Tool to make full use of the keyboard controls.

Version History Viewer

When the Version History Viewer is started from the Repository Object Navigator, 
keyboard focus may be unreliable. Therefore, the Version History Viewer must always 
be started from the Command Line Tool to make full use of the keyboard controls.

12.3.2 Non-Standard Keyboard Controls
This section documents areas of the user interface for which standard keyboard 
controls are not implemented and contains the following sections:

■ Section 12.3.2.1, "Dependency Manager"

■ Section 12.3.2.2, "Repository Administration Utility"
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■ Section 12.3.2.3, "Repository Object Navigator"

■ Section 12.3.2.4, "General Restrictions for Java Tools"

12.3.2.1 Dependency Manager
This section documents the parts of the Dependency Manager for which non-standard 
keyboard controls exist, but for which alternative keyboard controls are available.

Build Dependencies Dialog Box

The Build Dependencies dialog box contains a table and a number of controls. To 
navigate between the cells in the table, use the Tab key. To navigate from the table to 
the other controls in the dialog box, first navigate to the last cell in the table, then use 
Ctrl+Tab. To navigate between controls outside of the table, use the Tab key.

Change Workarea Dialog Box

To choose OK from the Change Workarea dialog box, focus must be on the OK button 
before activating the Enter key. If focus is on the list of workareas field when the Enter 
key is pressed, the dialog box is canceled without changing the workarea.

Search for Out of Workarea Objects Dialog Box

To navigate between the cells of the Configurations table, use the Tab key. To move 
focus out of the Configurations table, press Ctrl+Tab.

Selection Drop-Down Lists

A number of selection drop-down lists exist within the Dependency Manager. When 
using selection drop-down lists, use the following keyboard controls:

■ Press F4 to open the drop-down list, and navigate to the required entry using the 
Up and Down arrow keys.

■ If the selection drop-down list is a column in a table, press F2 first (to select the cell 
for edit), then F4 to open the drop-down list, and use the Up and Down arrows to 
navigate to the required entry.

Toolbar

To change focus from the Toolbar to the Navigator, press Shift+Tab, then use the Up 
and Down arrows to move within the Navigator tree.

12.3.2.2 Repository Administration Utility
This section documents the parts of the Repository Administration Utility for which 
non-standard keyboard controls exist.

Main RAU Panel

The Repository Administration Utility (RAU) panel comprises a number of buttons 
that provide access to administration features. To use the keyboard controls to access a 
feature from its associated RAU button, first navigate to the appropriate button (using 
the Tab key) and then press the spacebar.

User Maintenance Screen

On the User Maintenance screen, the options are Add Users, Delete Users, Expand 
Nodes, Collapse Nodes and View Properties. To use the keyboard to perform these 
tasks, use the Windows Menu key to display the context menu, then use the Up and 
Down arrow keys to choose the required option from the menu.
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12.3.2.3 Repository Object Navigator
This section documents the parts of the Repository Object Navigator for which 
non-standard keyboard controls exist.

Navigator Window

Each time the Repository Object Navigator is started a Navigator window and a 
Property Palette are displayed by default. To use keyboard controls to navigate 
through the Navigator window immediately after the Repository Object Navigator has 
been started, press F4 to switch context to the Property Palette, then press F3 to return 
to the Navigator window.

Color Dialog Box

Color can be used to distinguish text items in the Repository Object Navigator, the 
Property Palette and the TextPad. To use the keyboard to change the color of text, 
invoke the Color dialog box (as described in the online help system) and use the Up, 
Down, Left and Right arrow keys to pick the required color.

Property Palette

For some repository elements it is possible to specify reference properties, that is, 
references to repository elements that already exist. A reference property can be 
chosen from the Select Objects dialog box. To display the Select Objects dialog box 
from a Property Palette, position the cursor in the appropriate reference property field 
and press the Enter key.

Configuration Wizard

To invoke any button in the Configuration Wizard dialogs, first navigate to the button 
using the Tab key and then use the spacebar to choose that button.

Dialog Boxes with Grid Controls

A number of dialog boxes in the Repository Object Navigator contain grid controls, for 
example, the Customize Navigator Groups dialog box. When using dialog boxes with 
grid controls, use the following keyboard controls:

■ To navigate around a grid, use the Up, Down, Left and Right arrow keys.

■ To navigate out of a grid to the next control, use Ctrl+Tab. Note that pressing Tab 
in the last cell of a grid navigates to the next window in the dialog box, if one 
exists.

Dialog Boxes with Query Windows

A number of dialog boxes in the Repository Object Navigator (for example, the 
Customize Navigator Views dialog box) contain query windows that contain buttons 
for actions, such as grouping conditions.

When using dialog boxes with query windows, use the following keyboard controls:

■ To move a row up the list for sorting purposes, use Ctrl+Up Arrow.

■ To move a row down the list for sorting purposes, use Ctrl+Down Arrow.

■ To group selected cells together, use Alt+G.

■ To undo a grouping for selected cells, use Alt+U.

■ To duplicate cells, use Alt+D.
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■ To clear a condition, use Alt+C.

■ To toggle between AND and OR settings, use the spacebar.

■ To toggle check boxes, use the spacebar.

12.3.2.4 General Restrictions for Java Tools
This section documents general keyboard controls required to use the Version History 
Viewer, Version Event Viewer and Dependency Manager.

■  To navigate to a field with a mnemonic, use Alt + the mnemonic.

■  If the focus is on a tree, the Enter key opens or closes a branch instead of 
activating the default button (e.g., closing the dialog box).

■  If the focus is on a table, the Enter key navigates to the next row instead of 
activating the default button.

■  If the focus is in a multi-line text field, the Tab key navigates through the text. Use 
Ctrl+Tab to navigate to the next field.

■  If mnemonics are used to navigate to an editable drop-down list field, the field 
will not be in focus until the Tab key is pressed.

12.3.3 Known Problems and Workarounds
This section documents known problems and workarounds for keyboard controls:

■ Section 12.3.3.1, "Merge Window"

■ Section 12.3.3.2, "Repository Object Navigator"

■ Section 12.3.3.3, "Other Known Problems and Restrictions"

12.3.3.1 Merge Window

JAWS does not read Merge window
Cause:  This is an issue for users of the JAWS screen reader.

 When the Merge window has been invoked from the Command Line Tool, JAWS 
reads either blank, unavailable or nothing at all when the user navigates through 
the merge document. However, this problem will not occur if the Merge window 
is invoked from the Version History Viewer.

Action:   The following workarounds are available:

■ Use Alt+Tab to go to another window, then Alt+Tab to return to the Merge 
window.

■ Iconify the Merge window, and then de-iconify it.

■ Open and close any of the menus in the menu bar without selecting a menu 
item.

One of these workarounds will also need to be applied when the user navigates 
from the merge document to the toolbar and then back to the merge document.
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12.3.3.2 Repository Object Navigator

JAWS repeats last visible entry with each entry in 'View Copied Properties' dialog 
(bug 1930763)
Cause:  This is an issue for users of the JAWS screen reader.

 This problem occurs when properties copied via 'Copy Properties' are being 
viewed via 'View Copied Properties', and the down arrow key is being used to 
trigger JAWS to read out the visible information for each property.  When more 
than five properties have been copied, the reading for each property is preceded 
by a reading of the last property visible in the 'View Copied Properties' dialog.

Action:   If five or fewer properties can be copied, this problem will not occur.  
However, if it is necessary to copy more than five properties, the audible 
duplication in the reading for each entry should be ignored.

12.3.3.3 Other Known Problems and Restrictions
Issue for JAWS users invoking VEV, VHV or Compare utilities.

When invoking the Version Event Viewer, Version History Viewer or Compare utility 
from the Repository Object Navigator JAWS will read the name of the dialog window 
as it is created, but it will then read the text of the Repository Object Navigator main 
window once the dialog has been established. This may suggest incorrectly that the 
invoked dialog has failed (and disappeared).

To verify that the dialog has been correctly created: Press the TAB key. This will 
highlight (focus on) the first control/menu item in the dialog, which JAWS will read.

Disabled tabs

It may be possible for a user to navigate via the keyboard to disabled tabs that would 
not be accessible to a user navigating with a mouse.

12.3.4 Command Line Tool Accessibility
In order for JAWS to read output from the Command Line Tool correctly, users should 
download a set of scripts from the Oracle Technology Network 
(http://otn.oracle.com).

12.4 Platform-specific Issues and Workarounds

12.4.1 Windows Platform Issues and Workarounds
Windows issues are documented as part of Section 12.1, "General Issues and 
Workarounds" and Section 12.2, "Known Problems and Restrictions".

12.4.2 Linux, Solaris, and HP-UX Platform Issues and Workarounds

12.4.2.1 General Linux, Solaris, and HP-UX Platform Issues and Workarounds
There are currently no general Linux, Solaris, and HP-UX platform issues.
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12.4.2.2 Solaris Issues and Workarounds
Broadcast Server - Solaris computers

The broadcast server does not work on Solaris computers (bug 1325598).

12.4.2.3 Linux Issues and Workarounds
There are currently no Linux platform issues.

12.4.2.4 HP-UX Issues and Workarounds
There are currently no HP-UX platform issues.

12.5 Configuration Issues and Workarounds
There are currently no configuration issues.

12.6 Administration Issues and Workarounds
There are currently no administration issues.

12.7 Documentation Errata
There are currently no documentation errata.



Part III
Other Release Notes

Part III of the release notes contains information for server components that are 
installed with Oracle Developer Suite. Each feature has its own chapter.

Part III contains the following chapters:

■ Chapter 13, "Oracle Application Server Containers for J2EE (OC4J)"
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13
Oracle Application Server Containers for

J2EE (OC4J)

This chapter describes issues and workarounds for Oracle Application Server 
Containers for J2EE (OC4J). This chapter discusses the following topics:

■ Section 13.1, "Configuration Issues and Workarounds"

■ Section 13.2, "Release Notes for JSP, Tag Libraries, and Related Demos"

■ Section 13.3, "Release Notes for Servlets"

■ Section 13.4, "Release Notes for EJB"

■ Section 13.5, "Release Notes for OC4J Services"

■ Section 13.6, "Release Notes for DataDirect Connect for JDBC"

■ Section 13.7, "Documentation Errata"

You can access Oracle manuals mentioned in this document at the Oracle Technology 
Network (http://otn.oracle.com/).

13.1 Configuration Issues and Workarounds
This section describes configuration issues and their workarounds for OC4J. It features 
the following topics:

■ Section 13.1.1, "OPMN Does Not Properly Assign CORBA SSL Client Ports for 
Default"

■ Section 13.1.2, "Sharing and Using Libraries"

■ Section 13.1.3, "Invalid or Unneeded Library Elements Degrade Performance"

■ Section 13.1.4, "Custom User Managers Deployed Within EJB JAR Files"

■ Section 13.1.5, "Considerations for Startup and Shutdown"

■ Section 13.1.6, "Supported JDK Versions"

■ Section 13.1.7, "Migrating Source Code from JDK 1.4 to JDK 1.3"

■ Section 13.1.8, "Migrating Source Code from JDK 1.3 to JDK 1.4"

■ Section 13.1.9, "OC4J Demo Downloads"

For useful information on configuring OC4J, see the Configuration Guide for OC4J 
which is available from Oracle Technology Network (http://otn.oracle.com).
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13.1.1 OPMN Does Not Properly Assign CORBA SSL Client Ports for Default
In the Oracle Application Server environment, you must explicitly specify the port 
ranges for iiops1 and iiops2 in the opmn.xml file.

13.1.2 Sharing and Using Libraries
In Oracle Application Server 10g (9.0.4), Oracle recommends creating specific 
<library> elements in the global application.xml file to load any libraries 
required by your application. Oracle recommends this as a way to ensure efficient 
loading and desired loading order. (Libraries are loaded in the order in which the 
<library> elements are encountered.)

Note that in previous releases, you could put libraries into the j2ee/home/lib 
directory, which by default had a <library> element in application.xml. This 
directory is now reserved for OC4J system libraries, and the <library> element that 
points to it is no longer present in application.xml by default. If you want to use a 
general library location, use j2ee/home/applib. By default, there is now a 
<library> element pointing to that location in application.xml.

For general information about sharing libraries, refer to the Oracle Application Server 
Containers for J2EE User’s Guide.

13.1.3 Invalid or Unneeded Library Elements Degrade Performance
Out of Memory During Execution

If the OC4J process memory is growing consistently during program execution, then 
you may have references to invalid symbolic links in your global application.xml 
file. This problem is usually characterized by a growth in the C heap and not a growth 
in Java object memory, as one would see with a more traditional Java object memory 
leak. OC4J loads all resources using the links in the application.xml file. If these 
links are invalid, then the C heap continues to grow, causing OC4J to run out of 
memory. Ensure that all symbolic links are valid, and restart OC4J. 

In addition, keep to a minimum the number of JAR files OC4J is configured to load. 
Eliminate all unused JAR files from the configuration and from the directories OC4J is 
configured to search. OC4J searches all JAR files for classes and resources, thereby 
causing the file cache to use extra memory and processor time.

You can control the loading more precisely if your <library> elements in the 
application.xml file point to the individual JAR and ZIP files that are needed, 
instead of to the directories where they reside.

13.1.4 Custom User Managers Deployed Within EJB JAR Files
Custom user manager classes deployed within Enterprise Java Beans (EJB) JAR files 
cannot be loaded by OC4J unless an explicit <library> element exists in the 
orion-application.xml file for the application. The <library> element must 
point to the JAR file containing the custom user manager classes. To allow the custom 
user manager to be resolved and instantiated, create the necessary <library> 
element, such as in the following example: 

<orion-application ....>
   ... 
   <library path="d:\oc4j904\j2ee\home\applications\XmlnewsEar\XmlnewsEjb.jar"/>
   ... 
</orion-application>
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13.1.5 Considerations for Startup and Shutdown
■ You must use the JNDI context that is passed in as an argument to your startup 

and shutdown methods. You cannot create your own.

■ You should separate your shutdown class from any archive files (WAR and EAR) 
that will be undeployed before shutdown.

■ OC4J creates an instance of your startup class and an instance of your shutdown 
class. These are separate instances. If you implement the startup and shutdown 
interfaces in the same class, OC4J creates two instances of that class. In this case, 
you cannot share non static fields between your startup class and your shutdown 
class.

13.1.6 Supported JDK Versions
You must have only one Java Developer’s Kit (JDK) installed on your computer. Make 
sure that it is a version that OC4J supports:

■ JDK 1.3.1

■ JDK 1.4.1

OC4J Standalone does not include a JDK. If you are using OC4J Standalone, then you 
must provide your own JDK installation.

Some suppliers bundle a JDK with their products. If necessary, remove any old 
version(s), replace them with a supported version, and update the appropriate 
environment variables. Make sure that your PATH, CLASSPATH, and LD_LIBRARY_
PATH (or LIB on Windows) variables are all set to the officially supported version of 
JDK.

13.1.7 Migrating Source Code from JDK 1.4 to JDK 1.3
Java does not support compiling Java code under JDK 1.4 and running it under JDK 
1.3 (bug 2811379). If you try anyway, Java may throw one of the following error 
messages at runtime:

■ Unsupported major.minor version 48.0.

■ The major.minor version '48.0' is too recent for this tool to 
understand.

However, if you must generate class files using JDK 1.4 and run them using JDK 1.3, 
then you can use the following command to force a JDK 1.4 compiler to generate a 
class file that is compatible with JDK 1.3:

% javac -target 1.3 hello.java

Note: On Solaris computers, Sun Microsystems supplies an old 
JDK under /usr/bin. 
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13.1.8 Migrating Source Code from JDK 1.3 to JDK 1.4
When you upgrade from JDK 1.3 to JDK 1.4, put all classes into packages.

The JDK 1.4 specification explicitly prohibits a class within a package from invoking a 
class not within a package. For this reason, some Java source code that compiles in 
JDK 1.3 will not compile in JDK 1.4. This error is identified by the following compiler 
message:

 '.' expected import myClass

This message means that the Java compiler expects to find a package and class name 
and cannot parse a line that contains only a class name.

For details, see the Sun Microsystems compatibility document supplied with the JDK.

13.1.9 OC4J Demo Downloads
Oracle Application Server 10g (9.0.4) includes one demo per component. Additional 
demos are available for download from OTN at the following URL:

http://otn.oracle.com/tech/java/oc4j/demos/

Navigate down from this index page to the component areas that contain the 
additional demos that you need.

13.2 Release Notes for JSP, Tag Libraries, and Related Demos
This section describes issues for Java Server Pages (JSP), tag libraries, and related 
demos. It features the following topics:

■ Section 13.2.1, "Cannot Invoke Classes That Are Not in Packages"

■ Section 13.2.2, "Set the SAX Driver When Starting OC4J"

■ Section 13.2.3, "JSP ojspc Issues"

■ Section 13.2.4, "JESI Tag Release Notes"

■ Section 13.1.5, "Considerations for Startup and Shutdown"

■ Section 13.1.6, "Supported JDK Versions"

■ Section 13.2.7, "Search Local Classes First"

■ Section 13.2.8, "java.lang.ClassFormatError: (Truncated Class File)"

13.2.1 Cannot Invoke Classes That Are Not in Packages
Among the considerations in migrating to a Sun Microsystems JDK 1.4 environment, 
one is particularly important to servlet and JSP developers.

Sun Microsystems states, "The compiler now rejects import statements that import a 
type from the unnamed namespace." This change addresses security concerns and 
ambiguities with previous JDK versions. This means that you cannot invoke a class (a 
method of a class) that is not within a package. Any attempt to do so results in a fatal 
error at compilation time.
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This issue especially affects JSP developers who invoke JavaBeans from their JSP 
pages, because such beans are often outside any package (although the JSP 2.0 
specification now requires beans to be within packages, to satisfy the new compiler 
requirements). When JavaBeans outside of packages are invoked, JSP applications that 
were built and executed in an OC4J 9.0.3 / JDK 1.3.1 environment no longer work in 
an OC4J 9.0.4 / JDK 1.4 environment.

Until you update your application so that all JavaBeans and other invoked classes are 
within packages, you can revert to a JDK 1.3.1 environment to avoid this issue.

This issue is also discussed in Section 13.1.8, "Migrating Source Code from JDK 1.3 to 
JDK 1.4". For more information about the "classes not in packages" issue and other JDK 
1.4 compatibility issues, refer to the following Web site:

http://java.sun.com/j2se/1.4/compatibility.html

Click the link "Incompatibilities Between Java 2 Platform, Standard Edition, v1.4.0 and 
v1.3".

13.2.2 Set the SAX Driver When Starting OC4J
For the filter functionality of Java Server Pages Standard Tag Library (JSTL) XML tags 
to work in OC4J, you must set the SAX driver when starting OC4J.

When starting OC4J standalone, use the following option in the command line:

-Dorg.xml.sax.driver=oracle.xml.parser.v2.SAXParser 

When starting the Oracle Application Server, you can specify this setting through the 
system properties. See the Oracle Application Server documentation for details on 
where and how to make this specification. 

If you do not set the property, then the JSTL demo Filter.jsp gives the following 
exception:

javax.servlet.jsp.JspException: System property org.xml.sax.driver not specified

Notes:

■ The javac -source compiler option allows JDK 1.3.1 code to 
be processed seamlessly by the JDK 1.4 compiler, but classes 
must still be in packages in order to be invoked. 

■ Only the JDK 1.3.1 and JDK 1.4 compilers are supported and 
certified by OC4J. It is possible to specify an alternative 
compiler by adding a <java-compiler> element to the 
server.xml file. This might provide a workaround for the 
"classes not in packages" issue, but other compilers are not 
certified or supported by Oracle for use with OC4J. 
Furthermore, do not update the server.xml file directly in an 
Oracle Application Server environment. Use the Oracle 
Enterprise Manager.
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13.2.3 JSP ojspc Issues
This section features the following topics:

■ Section 13.2.3.1, "Debug Option Has No Effect on ojspc Output"

■ Section 13.2.3.2, "The /WEB-INF/lib or /WEB-INF/classes Directories Should Not 
Contain .java Files"

13.2.3.1 Debug Option Has No Effect on ojspc Output
The ojspc -debug option has no effect on ojspc output in Oracle Application Server 
10g (9.0.4). If you specify -debug, the option is accepted but ignored.

13.2.3.2 The /WEB-INF/lib or /WEB-INF/classes Directories Should Not Contain 
.java Files 
When using ojspc, do not put any .java files in or under the /WEB-INF/lib 
directory or the /WEB-INF/classes directory.

If the /WEB-INF/lib or /WEB-INF/classes directories contain any .java files, 
then ojspc occasionally creates one or more duplicate .class files at the top level of the 
archive during batch pretranslation.

13.2.4 JESI Tag Release Notes
This section describes changes and enhancements in the behavior of Java Edge Side 
Includes (JESI) tags in Oracle Application Server 10g (9.0.4). It features the following 
topics:

■ Section 13.2.4.1, "JESI Tags No Longer Require Conditional Treatment"

■ Section 13.2.4.2, "JESI personalize Tag Now Adds Single Quotes"

■ Section 13.2.4.3, "A fragment Tag Can Be Inside an Included Page"

■ Section 13.2.4.4, "Multiple control or template Tags Can Be Used"

■ Section 13.2.4.5, "No Response Output Outside the Tags of a template Tag"

■ Section 13.2.4.6, "Do Not Use Explicit ESI Markup With JESI Tags"

13.2.4.1 JESI Tags No Longer Require Conditional Treatment
In prior versions of the JESI tag library, JESI tags always generated the same output 
regardless of whether the request was coming directly from a client, such as a browser, 
or from Oracle Web Cache. Therefore, in prior versions of the tag library, JESI tags 
required special conditional treatment if there was a possibility that the Oracle Web 
Cache might be down or unavailable at any time, because then the included pages and 
fragments would not have been inserted into the response.

In the OC4J 9.0.4 implementation, JESI tags correctly generate a full response, even 
without the presence of Oracle Web Cache, by falling back to the standard JSP 
"include" functionality for inclusion of fragments. For more information, see the Oracle 
Application Server Containers for J2EE JSP Tag Libraries and Utilities Reference.
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13.2.4.2 JESI personalize Tag Now Adds Single Quotes
In the OC4J 9.0.4 implementation, the JESI personalize tag now puts single quotes 
around the string value of the default attribute (or, for backward compatibility, the 
value attribute). This behavior is more compliant with the ESI syntax. In versions prior 
to Oracle Application Server 10g (9.0.4), the user had to add single quotes as part of the 
attribute string value. You must edit pages containing personalize tags that used to 
work prior to the 9.0.4 implementation to remove extra single quotes.

13.2.4.3 A fragment Tag Can Be Inside an Included Page
You can now place a fragment tag inside a page included through a jsp:include 
standard action, if it is properly enclosed in a template tag (which can be in the 
including page).

13.2.4.4 Multiple control or template Tags Can Be Used
When OC4J encounters multiple control tags, instead of throwing an exception, it 
ignores additional control or template tags. OC4J executes only the first tag that it 
encounters. This feature allows placing control tags into JSP-included pages. If a 
page is included in another page with control or template tags of its own, then the 
second tag is ignored. At the same time, the included page can be executed 
independently.

The four permutations and their behavior are as follows:

■ A control tag followed by a control tag is acceptable. The second control 
tag is ignored. 

■ A control tag followed by a template tag is acceptable. The attributes of the 
template tag are ignored.

■ A template tag followed by a control tag is acceptable. The control tag is 
ignored.

■ A template tag followed by a template tag produces an error. 

13.2.4.5 No Response Output Outside the Tags of a template Tag
In the OC4J 9.0.4 and the OC4J 9.0.3 implementations, there must be no response 
output outside the start and end tags of a template tag. Additionally, you can now 
place template tags in an included page, if there is no content output into the 
response outside the start and end tags. 

13.2.4.6 Do Not Use Explicit ESI Markup With JESI Tags
The JESI tag library is not guaranteed to work correctly when explicit ESI markup is 
used together with JESI tags to generate an HTTP response.

13.2.5 Tag Library Descriptors Must Be Under WEB-INF
You should carefully observe the JSP specification with respect to tag library 
descriptors, despite leniency in previous OC4J implementations.

The existing specification allows tag library descriptors only under
application_root/WEB-INF/ for a given application.
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In practice, in the OC4J 9.0.4 implementation (and previous implementations), tag 
library descriptors have been accepted anywhere under application_root , despite 
the requirements of the specification.

In implementations under development, the specification is strictly enforced. Tag 
library descriptors are allowed only under WEB-INF. 

13.2.6 Adding Tag Library JAR Files to /WEB-INF/lib While OC4J Is Running
If you are adding tag library JAR files to the /WEB-INF/lib directory while OC4J is 
running, then set tags_reuse_default to "none" or "compiletime" to avoid a 
ClassCastException. 

13.2.7 Search Local Classes First
If you are using tag library JAR files at the application level that are intended to 
supersede JAR files in the well-known tag library location (global level), then you 
must set the application loader to search local classes first. You can do this through the 
following setting in your application’s orion-web.xml file:

<web-app-class-loader search-local-classes-first="true" />

13.2.8 java.lang.ClassFormatError: (Truncated Class File)
A JSP error message such as the example shown below indicates a truncated class file.

Some conditions in which this can occur include the following:

■ You are using JSP in a portal environment.

■ The computer is heavily loaded.

Use one of the following techniques to repair the error:

■ Use touch on the JSP file to cause the JSP to be recompiled.

■ Remove the corrupted class file, as indicated by the 
"/modules/location/bizdir/jsp/bizdir.jsp" listing in the error message 
example.

Truncated Class File Error Message Example

500 Internal Server Error
    OracleJSP:
    JSP Error:
-------------------------------------------------------------------------------
    Request URI:/modules/location/bizdir/jsp/bizdir.jsp
    Exception:
    java.lang.ClassFormatError: _location/_bizdir/_jsp/_bizdir (Truncated class 
file)
    at java.lang.ClassLoader.defineClass0(Native Method)
    at java.lang.ClassLoader.defineClass(ClassLoader.java:493)
    at java.security.SecureClassLoader.defineClass(SecureClassLoader.java:111)
    at oracle.jsp.app.JspClassLoader.loadClass(JspClassLoader.java:682)
    at java.lang.ClassLoader.loadClass(ClassLoader.java:255)
...



Release Notes for EJB

Oracle Application Server Containers for J2EE (OC4J) 13-9

13.3 Release Notes for Servlets
This section describes release notes for servlets. It features the following topics:

■ Section 13.3.1, "Cannot Invoke Classes Not in Packages"

■ Section 13.3.2, "Servlet Invocation by Class Name Is Available During 
Development"

■ Section 13.3.3, "Do Not Use Certain <orion-web-app> Attributes"

13.3.1 Cannot Invoke Classes Not in Packages
With JDK 1.4, you are not allowed to invoke a class if it is not in a package if you are 
calling it from a class that is not in a package. The JSP release notes, Section 13.2.1, 
"Cannot Invoke Classes That Are Not in Packages" describes this issue in detail. 

13.3.2 Servlet Invocation by Class Name Is Available During Development
In OC4J, servlet invocation by class name is available as a convenience feature during 
development.

This feature is controlled through the http.webdir.enable system property or the 
servlet-webdir attribute of the <orion-web-app> element in either the 
global-web-application.xml file or the orion-web.xml file.

This feature is documented in the Oracle Application Server Containers for J2EE Servlet 
Developer’s Guide.

In the OC4J 9.0.4 implementation, invocation by class name is enabled by default, 
through the default settings http.webdir.enable=true and 
servlet-webdir="/servlet/".

In a production environment, you must disable this feature by setting either 
http.webdir.enable=false or servlet-webdir="" (empty quotes).

13.3.3 Do Not Use Certain <orion-web-app> Attributes
In the OC4J 9.0.4 implementation, the <orion-web-app> attributes 
internationalize-resources and default-mime-type appear in the 
orion-web.dtd file. However, these attributes are not documented and are not 
recommended for use.

13.4 Release Notes for EJB
This section describes release notes for EJBs. It features the following topics:

■ Section 13.4.1, "Client Requests Must Include a Port Number"

■ Section 13.4.2, "MDB Transaction Timeout"

■ Section 13.4.3, "Create and Release JMS Connections for JMS in the MDB 
onMessage() Method"

■ Section 13.4.4, "Considerations When Modifying Your orion-ejb-jar.xml File"

■ Section 13.4.5, "Static Block in an EJB"

■ Section 13.4.6, "OC4J Instances Terminating Due To ping Timeout"

■ Section 13.4.7, "Miscellaneous EJB Release Notes"
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13.4.1 Client Requests Must Include a Port Number
When you provide your URL on the client to access an EJB in the following form, you 
must always provide the port number. For example, 

opmn:ormi://host:port:oc4j_inst/application

If you do not, then the oc4j_inst always defaults to the home instance. (bug 
3234351).

13.4.2 MDB Transaction Timeout
The message-driven bean (MDB) transaction timeout, as defined in the 
transaction-timeout attribute in the orion-ejb-jar.xml file, is an optional 
parameter. This attribute controls the transaction timeout interval (in seconds) for any 
container-managed transactional MDB that uses Oracle JMS. The default is one day 
(86,400 seconds). The MDB transaction-timeout attribute applies only to CMT 
MDBs that use Oracle JMS as the JMS provider. This attribute setting has no effect on 
BMT MDBs or any MDBs that use OC4J JMS. (bug 3079322) 

■ JMS behavior with Oracle Application Server — If the transaction has not 
completed in this time frame, then the transaction is rolled back and the message 
is redelivered to the Destination object. After Oracle JMS attempts to redeliver 
the message (the default is five attempts), the message is moved to the exception 
queue. For more information, refer to the Oracle9i Application Developer's 
Guide—Advanced Queuing for Release 2 (9.2).

■ JMS behavior with OC4J — The transaction-timeout setting does not work for 
CMT MDBs that use OC4J JMS. The timeout is always one day and cannot be 
modified. When the timeout occurs, OC4J JMS redelivers the message indefinitely, 
until the delivery is successful. You cannot set a retry limit.

In addition, the global transaction-timeout attribute defined in the server.xml 
file does not have any effect on MDBs.

13.4.3 Create and Release JMS Connections for JMS in the MDB onMessage() Method
You must create and release the JMS connections for Oracle JMS in the MDB 
onMessage() method, and not in the ejbCreate() method. (bug 2967949).

13.4.4 Considerations When Modifying Your orion-ejb-jar.xml File
If you modify your orion-ejb-jar.xml file using the Oracle Enterprise Manager, 
then you must restart OC4J. Otherwise, if you are operating in the standalone 
environment and you modify your orion-ejb-jar.xml file using an editor, then 
you must repackage the application and redeploy it to OC4J without restarting. (bug 
3001543)

13.4.5 Static Block in an EJB
During EJB deployment in OC4J, you load the bean class to find out its methods so 
that you can generate EJB wrappers. Because the code in the static block is executed as 
the class is being loaded, the JNDI environment context is not yet set up. Even during 
runtime, the bean is in the "does not exist" stage. In this stage of the life cycle, the JNDI 
environment context is undefined, and the bean provider cannot rely on it to be 
available.
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To work around this problem, set up and cache the context either during the 
construction of the bean, in the ejbCreate() method, or in the 
setSessionContext() method.

13.4.6 OC4J Instances Terminating Due To ping Timeout
Under some conditions, the OPMN process monitoring software in Oracle Application 
Server may lose contact with an OC4J process. This can occur because of unexpected 
delays in the hearbeat protocol used by OPMN and OC4J to verify the proper 
functioning of the OC4J instance.

If this problem occurs sporadically, you can try increasing the ping timeout parameters 
as described in the following instructions.

However, if this occurs regularly, due to a consistent resource shortage, then you must 
increase the available hardware resources to solve the problem.

The following conditions can cause this problem:

■ An overloaded host processor.

■ One or more computation-intensive applications running in the OC4J instance. 

■ Deployment of applications with large numbers (hundreds) of EJBs. Full garbage 
collections of large heaps can cause the OC4J process to become less responsive 
during the garbage collection phase. Although this should not occur during 
normal usage, deployment of large applications with many EJBs in a 
memory-constrained environment can trigger this behavior.

You can configure the behavior of the "ping protocol" between OPMN and OC4J in the 
opmn.xml configuration file.

When OC4J exceeds the timeout intervals specified for the ping protocol, the process 
monitoring software decides that the OC4J process has stopped responding and, 
therefore, terminates the OC4J process.

If you suspect this behavior in an Oracle Application Server installation, then use the 
following steps to troubleshoot and work around: 

1. When OC4J instances are "mysteriously" terminating, first increase diagnostic 
logging to determine if ping failures are triggering the termination:

a. Increase the OPMN logging level to 5 so that you can see the pings.

In opmn/conf/opmn.xml, edit the following line:

log-file path="$ORACLE_HOME/opmn/logs/ipm.log" level="5" ...

b. Reload the daemon.

opmn/bin/opmnctl reload

2. Look in opmn/logs/ipm.log for the following line:

Process Ping Failed:OC4J~<instance name>~default_island~1 (opmnid)
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3. The line above indicates that the memory and CPU resources of the current host 
are probably not sufficient to perform the operation within the currently specified 
ping timeout interval (used by OPMN to determine OC4J "responsiveness").

Change the settings as follows:

a. Increase the timeout and interval.

Example:

<ping timeout="60" interval="60"/>"
<data id="reverseping-failed-ping-limit" value="5" />

b. Reload the daemon.

opmn/bin/opmnctl reload

c. Restart the appropriate OC4J instance.

4. Repeat the top-level operation that caused the timeout failure.

13.4.7 Miscellaneous EJB Release Notes
■ You cannot mark a Container-Managed Persistence (CMP) entity bean as 

read-only if it has a Container-Managed Relationships (CMR) relationship to 
another entity bean that is not read-only.

■ If you invoke any EJB from an application client outside the EJB container, then 
Java Authentication and Authorization Service (JAAS) is not supported for the 
EJB. However, if you call the EJB from a servlet within the OC4J instance, then 
JAAS is supported.

■ The container may call the EJBActivate() method multiple times when the 
bean is associated with several wrappers. (bug 3107168)

■ If you access an EJB in an application from an EJB in a different application, then 
you cannot use the RMIInitialContextFactory object. In this scenario, you must use 
a parent-child relationship between these applications, and you must use the 
default initial context factory object. (bug 2812150)

■ The JTA two-phase commit (2pc) function does not work with Oracle Database 
version 9.2. Instead, use Oracle Database version 9.2.0.4 or higher to enable the 2pc 
functionality. (bug 2668460)

■ Currently, inline SQL queries are not supported within the finder query string 
defined in the orion-ejb-jar.xml file. When modifying these queries, avoid inline 
SQL queries, such as:

 SELECT * FROM
      (SELECT * FROM TEST1) A,
        (SELECT * FROM TEST2) B WHERE A.ID =B.ID

13.5 Release Notes for OC4J Services
This section contains release notes for OC4J Services. It features the following topic:

■ Section 13.5.1, "Release Notes for Java Object Cache (JOC)"
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13.5.1 Release Notes for Java Object Cache (JOC)
This section describes release notes for the Java Object Cache (JOC). It describes the 
following topic:

■ Section 13.5.1.1, "Use javacache.xml for JOC Configuration"

13.5.1.1 Use javacache.xml for JOC Configuration
The OC4J 9.0.4 implementation uses the file javacache.xml for JOC configuration. 
In previous versions of JOC, configuration was done through the file 
javacache.properties.

13.6 Release Notes for DataDirect Connect for JDBC
This section contains release notes for DataDirect Connect for JDBC.

For additional information, refer to the following manuals:

■ Oracle Application Server Containers for J2EE Services Guide

■ DataDirect Connect for JDBC User’s Guide and Reference

13.6.1 Considerations When Using DataDirect Connect for JDBC
A customized version of DataDirect Connect for JDBC is shipped with Oracle 
Application Server to provide connectivity to non-Oracle databases. Do not use the 
DataDirect Connect for JDBC driver outside of Oracle Application Server.

This section describes important differences between the customized DataDirect 
Connect for JDBC driver and the standard version.

■ The customized DataDirect driver JAR file names use the YM prefix. The following 
DataDirect JAR files are distributed with Oracle Application Server:

YMbase.jar
YMinformix.jar
YMsqlserver.jar
YMutil.jar
YMdb2.jar
YMsybase.jar

■ The URL subprotocol prefix is oracle. When you connect, use the correct 
subprotocol. For example:

jdbc:oracle:db2://server1:1433

■ The vendor message prefix is [oias].

■ The customized DataDirect driver is configured to run within Oracle Application 
Server. Attempting to use the customized DataDirect JDBC driver outside Oracle 
Application Server yields the following exception:

java.sql.SQLException: [oias][... JDBC Driver]

Note: f you install both a 9.0.4 release and a pre-9.0.4 release on 
the same host, you must ensure that the javacache.xml 
discovery-port attribute and the javacache.properties 
discoveryAddress attribute are not configured to the same port. 
If they are, you must manually change the value of one or the other 
to a different port number, in the range of 7000 - 7099.
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13.6.2 Installing DataDirect Connect for JDBC
This section provides information for installing DataDirect Connect for JDBC.

Refer to the Oracle Application Server Containers for J2EE Services Guide for additional 
detail on setting up DataDirect with Oracle Application Server or OC4J.

Install

The DataDirect driver is a ZIP file available at: http://otn.oracle.com/ under 
the Oracle Application Server download area.

Unzip the DataDirect package as follows:

■ On Linux, Solaris, and HP-UX, run the following command:

unzip Data-Direct-Installation-Zip-File

■ On Windows, use WinZip or a similar tool to unzip the DataDirect package.

Set up DataDirect according to the following instructions:

1. Unzip the contents of the DataDirect JDBC drivers to the directory ddjd_
install.

2. If it does not already exist, create the directory
oc4j_install/j2ee/instance_name/applib.

3. Copy the DataDirect JDBC drivers in ddjd_install/lib to the following 
directory: oc4j_install/j2ee/instance_name/applib .

4. Verify that the file application.xml contains a library entry that references the 
j2ee/home/applib location, as follows

<library path="../../instance_name/applib" />

5. Add data sources to the file data-source.xml as described in the following 
examples, taken from the Oracle Application Server Containers for J2EE Services 
Guide.

Note: n the following instructions, note these definitions:

■ n a standalone OC4J environment, unzip the file 
oc4j_extended.zip into the oc4j_install directory. 

■ In an Oracle Application Server installation, oc4j_install is 
your Oracle home directory.

■ In both a standalone OC4J and an Oracle Application Server 
environment, unzip the DataDirect JDBC drivers into the 
ddjd_install directory.

■ In a standalone installation, instance_name is home. In an 
Oracle Application Server installation, instance_name is the 
OC4J instance into which you wish to install the DataDirect 
JDBC drivers.
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Example DataDirect Data Source Entries

This section shows an example data source entry for each of the following non-Oracle 
databases:

■ SQLServer

■ DB2

■ Sybase

You can also use vendor-specific data sources in the class attribute directly. That is, it is 
not necessary to use an OC4J-specific data source in the class attribute.

SQLServer

Here is a data source configuration example for a SQLServer database.

<data-source
class="com.evermind.sql.DriverManagerDataSource"
name="MerantDS"
location="jdbc/MerantCoreSSDS"
xa-location="jdbc/xa/MerantSSXADS"
ejb-location="jdbc/MerantSSDS"
connection-driver="com.oracle.ias.jdbc.sqlserver.SQLServerDriver"
username="test"
password="secret"
url="jdbc:sqlserver//hostname:port;User=test;Password=secret"
inactivity-timeout="30"
/>

DB2

Here is a data source configuration example for a DB2 database:

<data-source
class="com.evermind.sql.DriverManagerDataSource"
name="MerantDS"
location="jdbc/MerantDB2DS"
xa-location="jdbc/xa/MerantDB2XADS"
ejb-location="jdbc/MerantDB2DS"
connection-driver="com.oracle.ias.jdbc.db2.DB2Driver"
username="test"
password="secret"
url="jdbc:db2://hostname:port;LocationName=jdbc;CollectionId=default;"
inactivity-timeout="30"
/>

Note: The OC4J 9.0.4 implementation does not work with 
non-Oracle data sources in the nonemulated case. That is, you 
cannot use a non-Oracle data source in a two-phase commit 
transaction. 
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Sybase

Here is a data source configuration sample for a Sybase database:

<data-source
class="com.evermind.sql.DriverManagerDataSource"
name="MerantDS"
location="jdbc/MerantCoreSybaseDS"
xa-location="jdbc/xa/MerantSybaseXADS"
ejb-location="jdbc/MerantSybaseDS"
connection-driver="com.oracle.ias.jdbc.sybase.SybaseDriver"
username="test"
password="secret"
url="jdbc:sybase://hostname:port;User=test;Password=secret"
inactivity-timeout="30"
/>

13.7 Documentation Errata
This section describes known errors in the OC4J documentation in Oracle Application 
Server 10g (9.0.4). It features the following topics:

■ Section 13.7.1, "Servlet Developer's Guide Errata"

■ Section 13.7.2, "Support for JavaServer Pages Developer’s Guide Errata"

■ Section 13.7.3, "OC4J User’s Guide Errata"

13.7.1 Servlet Developer's Guide Errata
This section describes errata in the Oracle Application Server Containers for J2EE Servlet 
Developer’s Guide.

13.7.1.1 The OC4J 9.0.4 JSP Container Supports the persistence-path Flag
The following note, which appears on page 6-6 of the 9.0.4 version of the Oracle 
Application Server Containers for J2EE Servlet Developer’s Guide, is incorrect:

"Note: The OC4J JSP container does not currently support the persistence-path flag. It 
is for servlets only."

This flag actually is supported by the JSP container in the Oracle Application Server 
10g (9.0.4) release.

13.7.2 Support for JavaServer Pages Developer’s Guide Errata
This section describes errata in the JavaServer Pages Developer’s Guide. It features the 
following topic:

■ Section 13.7.2.1, "mod_oc4j Does Not Restart OC4J Processes"

13.7.2.1 mod_oc4j Does Not Restart OC4J Processes
The following item, which appears in the "Oracle HTTP Server and mod_oc4j" section 
in Chapter 2 of the Oracle Application Server Containers for J2EE Support for JavaServer 
Pages Developer’s Guide, is incorrect: 

"A mod_oc4j module can restart an OC4J instance automatically, if necessary." 

In fact, OPMN, not mod_oc4j, restarts OC4J processes automatically when it detects 
that they are unavailable (for several reasons). 
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13.7.3 OC4J User’s Guide Errata
This section describes known errors in the Oracle Application Server Containers for J2EE 
User’s Guide. It features the following topic:

■ Section 13.7.3.1, "End to End Test Results for Metrics Load Balancing"

13.7.3.1 End to End Test Results for Metrics Load Balancing
Add the following information to the Oracle Application Server Containers for J2EE 
User’s Guide, Appendix A, "Additional Information". In the section "Elements 
Contained Within <application-server> of the server.xml file", add the following text 
describing the <metric-collector> element.

<metric-collector>

The <metric-collector> element specifies that OC4J sends a metric between 0 and 
100, inclusive, to mod_oc4j so that mod_oc4j can make routing decisions to 
load-balance incoming requests to a list of available OC4J instances. The metric sent 
has a relative value only, where 0 means that the OC4J instance is very busy and 100 
means that the OC4J instance is available (not busy). When configured for metric load 
balancing, mod_oc4j routes first to the OC4J instance with the greater value. 

The metric sent from OC4J to mod_oc4j is used only when metric-based load 
balancing is specified for mod_oc4j and when OC4J runs in an Oracle Application 
Server environment.

If you specify metric-based load balancing in mod_oc4j and do not specify the 
<metric-collector> element in server.xml, then mod_oc4j expects OC4J to 
send metrics, but OC4J does not send metrics. In this case, mod_oc4j reports the 
following warning message:

No run time metrics for oc4j(opmnid=%s) in notification 
Oc4jSelectMethod is configured to use run time metrics, please 
make sure OC4J side is configured accordingly. Default to 50.

In this case, mod_oc4j uses the value 50 for each of the OC4J processes and continues. 

Likewise, if you specify the <metric-collector> element in server.xml, but do 
not specify metric-based load balancing in mod_oc4j, then OC4J sends metrics but 
mod_oc4j is not configured to receive metrics. In this case, mod_oc4j ignores the 
metrics and uses whatever the configured method is for load balancing. You specify 
the load balancing method with Oc4jSelectMethod. If no Oc4jSelectMethod is 
specified, then mod_oc4j uses the default, which is roundrobin. 

The <metric-collector> element takes the following attribute: classname. 

The classname attribute defines an interface for gathering and calculating a 
server-wide metric. Use oracle.oc4j.server.DMSMetricCollector for the 
classname attribute when using a DMS-noun-based metric collector. A 
DMSMetricCollector instance takes several parameters. Details for the values for 
these parameters are available in the Oracle Application Server 10g Performance Guide.
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For example:

<metric-collector classname="oracle.oc4j.server.DMSMetricCollector">
   <init-param>
     <param-name>
       dms-noun
     </param-name>
     <param-value>
       /oc4j/default/WEBs/processRequest.time
    </param-value>
   </init-param>
   <init-param>
     <param-name>
       history-proportion
     </param-name>
     <param-value>
       0.2
     </param-value>
   </init-param>
   <init-param>
     <param-name>
       debug
     </param-name>
     <param-value>
       false
     </param-value>
   </init-param>
</metric-collector>

For details on using the <metric-collector> element and using metric-based load 
balancing with mod_oc4j, see the Oracle Application Server 10g Performance Guide.
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